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User Guide Course Description

Course Description

This course is an introduction to Autodesk AutoCAD intended to assist those who have historically utilized
Bentley products to perform drafting and design tasks. The course is designed for those who have limited,
or no Autodesk AutoCAD experience and is intended for all users from all sections of MDT that are
transitioning from Bentley MicroStation to AutoCAD/Civil 3D.

This course focuses on the user interface and necessary functionality within the AutoCAD product. It will
set the foundation for Autodesk Civil 3D use since Civil 3D is built upon an AutoCAD software solution.

Course Length
16 hours

User Guide Notification Icons

This User Guide contains icons to help alert and assist the user with specific tasks and content. Each icon
is identified and described in the table below.

ICON DESCRIPTION

@?ﬁ The EXERCISE icon identifies tasks where users are guided through a hands-on review of
the instructional topic using the software.

" The TIP icon identifies software best practices and useful tips.

% The NOTE icon is used for identifying general information such as:

e To provide additional information that is not considered to be a warning or critical.
e To provide additional/alternative steps to workflow.

e To provide reminders of important information previously covered that may affect
specific tasks throughout the workflow process.

The CAUTION icon is used to help identify and warn users of information and or workflow
steps that should be followed or executed correctly.

MDT Internal Use Only 3
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Course Objectives

e Understand AutoCAD workspace and interface

e Utilize basic drafting, editing, and viewing tools

e Organize drawing objects and layers

e Insert objects and reference other files (xrefs (XR), xlist, nested copy NC)
e Preparing a layout

e Adding annotation, hatching, and dimensioning

e Leveraging GIS Data and .shp files

e Migrating .dgn files to .dwg format

Topics Covered

e User Interface and Workspaces

¢ Commands and the command line
e Drawing lines, polylines, and curves
e Object snapping and tracking

e Editing objects and files

e Organizing the drawing using layers
e Annotation and dimensions

e Blocks and intro to dynamic blocks
e Plotting and page layout settings

e Hatching

e Importing and exporting .shp files

e Importing and exporting GIS data

e Migrating .dgn file to .dwg format

Pre-requisites
e A basic understanding of design/drafting procedures and terminology

e A working knowledge of your operating system
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Chapter 1 | User Interface and Workspaces

It's important to understand the different parts of the User Interface so that you know how to access the
functionality within Civil 3D. With Civil 3D open, in the upper left corner is the Application menu. In this
pull-down menu, like many other standard Windows programs, are the basic commands such
as New, Open, Save, and Save As. The Export command allows you to export your Civil 3D drawings to
older versions of AutoCAD, as well as other programs. There are also commands
for Publishing, Printing and Drawing Utilities, such as Purge and Audit.

Section 1 | User Interface (Ul)

Workspaces are sets of menus, toolbars, palettes, and ribbon control panels that are grouped and
organized so that you can work in a custom, task-oriented drawing environment.

When you use a workspace, only the menus, toolbars, and palettes that are relevant to a task are
displayed. In addition, a workspace may automatically display the ribbon, a special palette with task-
specific control panels.

You can easily switch between workspaces using drop-down menus within the interface.

When Civil 3D is launched, users will see Drawing Tabs toward the top of the screen just below the
Ribbon command interface. The Start tab is always shown here, and it provides a number of shortcuts to
help users get started.

1.1.1 Start Tab

The Civil 3D start tab is a launch point for opening existing files or sheet sets, creating new drawings from
a template, or creating a new sheet set. The Start tab appears when Civil 3D is opened, users do not need
to do anything other than select it to activate the Start tab. Once files have been open and closed, they can
be accessed via the recent link. The Autodesk Docs link allows access to cloud-based projects and files
located on BIM 360. The learning link includes tips and videos for Civil 3D topics.

AUTODESK
CIVIL3D 2022

Recent

Autodesk Docs

Learning

0200-YRD-D213 0200-YRD-D212 0200-YRD-D203 0200-YRD-D202
Friday, May 13, 2022 1:55:50 PM Friday, May 13, 2022 1:41:51 PM Friday, May 13, 2022 1:41:28 PM Friday, May 13, 2022 1:40:53 PM

0200-YRD-D201 07996001 Table example ‘Working_HDOT Template working
Friday, May 13, 2022 1:38:45 PM Friday, May 6, 2022 10:43:54 AM Thursday, April 16, 2022 3:51:15 PM Thursday, April 16, 2022 123153 PM

Figure 1 - Civil 3D Start Tab
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@ File Access

The Open and New dropdown menus access files in different ways. When utilizing the Open
drop-down, you will be directed to drawing (.dwg) files. The New drop-down will direct the user to
template (.dwt) files. These drop-down menus can be selected without using the drop-down arrow
to access the Open or New command.

When the Open drop-down is expanded, users have
Open... access to the Open files..., Open a sheet set..., and
Explore sample drawings... links. Open files... is the

Open files same command as Open...
Open a sheet set... Tip: Menus and commands with ellipsis points (...)
at the end denotes that selecting this command
Explore sample drawings... or menu will open a corresponding dialog box.
Figure 2 - Civil 3D Start Tab Open Menu ‘ SE‘MELM_ . . I B
E NamDiVG - Previen
Selecting Open... will launch the Select File i miﬁiﬁ’““
dialog box using the last used location a file = Fommomonmes
was opened from as the Look in: folder. -
By default, the Select File dialog box sets - i Vi
Drawing (*.dwg) as the Files of type: (0] [SE b
Selecting Open files... produces the same —
Select File dialog box. — o= -
Files of tyoe:  Drawing (" dwg) ~ | Cancel

Open a sheet set... will direct the Select File
dialog box to the default sheet set location
and sets Sheet Set (*dst) as the Files of type:

Figure 3 - Civil 3D Select File dialog box

Explore sample drawings... will direct the Select File dialog box to the Civil 3D Sample directory
that is installed with Civil 3D and sets Drawing (*.dwg) as the Files of type:

8 MDT Internal Use Only
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When the New drop-down is expanded users will
have access to frequently used Civil 3D

Templates. Selecting a template from the list will
launch a new drawing file based on the selected

template.

Civil 3D (Impenal) Profile only.dwt

When users select the New command, a drawing will be
created based on the default template. This automates
the process of browsing to and selecting the template to
open.

_Autodesk Civil 3D (Impenal) NCS.dwt
Browse templates...

Get more templates online...

The Browse templates... link will launch the Select
Template dialog box and sets the Drawing Template

EsiEEET cE L (.dwt) as the Files of type:

The Get more templates online... link will launch a browser window and direct users to the Autodesk Civil
3D Country Kits website and once a country is selected the Country Kit will be downloaded. The kit must
be installed once downloaded.

File & Learning Links

Recent The Recent link will display the Recent
page in the main window as denoted
as section D in Figure 1 — Civil 3D Start

Autodesk Docs Tab.

Learning =5 : o The Recent page displays recently
‘ opened files, with a maximum display
: of 9 files. When displayed for the first
time, the Recent page is in Tile display mode and will show a preview of the last saved view of the
file, the file name, and the last saved date. An icon in the lower right
corner of each tile will indicate if the file is local or a cloud file
located in Autodesk Docs. «&

The [ vertical ellipsis dots provide a menu when clicked that will
allow users to open the file or open it in read-only mode.

The pin icon =171 can be clicked to pin the drawing to the Recent listand R
bring it to the front of the list. 5 e s

When a file is pinned, it will remain in the front of the list. Drawings that Figure 4 - Civil 3D Recent
are not pinned will cycle out of the list if they aren’'t opened frequently. File Tile
Civil 3D will allow for up to 9 files to be pinned to the Recent list.

Users can change the view using the Tile . or List . view icons.
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In List View, small file icons are shown before the file name, and other drawing information is shown

in a table format.

Name

B Civil Sample Sheet Set

[

i Site Utility Plan

DS-Test

Site Layout Plan

Site Grading Plan

Sewer Profiles

Road Profile

PB-TITLE

PB-EX61

File Type

a a4 W & @ W b «

Last Opened Time

saturday, May 14, 2022 2:35:17 AM
Saturday, May 14, 2022 2:35:16 AM
Saturday, May 14, 2022 2:41:52 AM
Saturday, May 14, 2022 2:35:08 AM "'
Saturday, May 14, 2022 2:35.08Rw
Saturday, May 14, 2022 2:34:53 AM
saturday, May 14, 2022 2:34:46 AM
Saturday, May 14, 2022 2:34:40 AM

Saturday, May 14, 2022 2:34:34 AM

Hovering a drawing name will reveal the pin icon. Clicking the icon will pin the drawing to the list.

Help us improve our products

Send feedback

Recent

Autodesk Docs

Learning

While the Recent link is active, users will see the Connect

icon &2l in the upper right side of the file window. Selecting
this icon will expand the Connect menu and display a link
to allow users to submit feedback to Autodesk regarding
their experience with Civil 3D.

When selecting the Autodesk Docs link in the
links section the Start tab window will update to
display the latest directory accessed in
Autodesk Docs. You can enter folders and
select drawings to open in the same way as
local files.

10
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U.S. CAD » BIM 360 Design_AP @

8 Project Files M 012345 @ Design

Sort 4 Name

_Data Shortcuts Consumed Rehab Corridor VFG_REHAB

Within the Autodesk Docs window, users
» # Project Files > & 012345 > & Design can navigate through Project Directories
by selecting links, or folder tiles.

— Additionally, users can navigate and
- search projects or change accounts using
the drop-down in the upper left corner.
U.S. CAD > BIM 360 Design_AP

_Data Shortcuts Consumed

On the right, users can search within the existing folder.
Additionally, the Refresh icon 2 will update the folder
with any changes found in the corresponding Autodesk
Docs folder.

Sort 4 Name

When selecting the Autodesk Learning link in the
links section the Start tab window will update to
display the latest Tips and Videos available to

help users learn more about workflows and using
Autodesk Docs Civil 3D

Recent

Learning

MDT Internal Use Only 11
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External Links

Online help

Community forum

Customer support

Each link in the External Links section will open the system default browser and navigate to:
o What’s New: Autodesk website for product features.
e Online help: Autodesk Knowledge Network, product specific help section.
e Community Forum: Autodesk Knowledge Network, product specific community homepage.

e Customer support: Autodesk support website, options for support directly from Autodesk.

12 MDT Internal Use Only
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1.1.2 Application & Drawing Window

To the right of the Start tab are the drawing tabs. If a drawing is open the user will see the tab in the list.
When a drawing tab is active, the application window changes to display the current workspace.

&l Parcel -

¥ Featureline -

&t Grading - ° : DlScale B2 Amy - &=

RO
Active Drawing View
- Drawing2
<& Points
[ Point Groups
& Surfaces
> Alignments
- ) Feature Lines
B sites
{4 Catchments
T8 Pipe Networks
H Pressure Networks
-#2 Bridges
-\ Comidors
&3 Assemblies
#E Intersections
BT survey
[©] View Frame Groups
- Data Shortcuts []
-3 Surfaces
"5 Alignments
I8 Pipe Networks
Pressure Metworks
By Comridors

+[/@ View Frame Groups

MODEL #E

Application Menu: Access to file and program related tools and commands. The
Application Menu is covered in more detail later in this chapter.

®

Quick Access Toolbar: Collection of often used commands detailed in sub-section 1.1.4.

© @

Share: Upload current file and all dependencies to the AutoCAD web service to share
with others inside or outside of your organization.

MDT Internal Use Only 13
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From the upper right corner of the application window, users will find the following interface elements.

» Type a keyword or phrase O, A user@emaiicom - = A - | @ -

® ©® ®

Search Box: Search Civil 3D help.

Autodesk Account Profile: Access software license and account benefits.
Shopping Cart: Link to Autodesk App Store.

Social Icon: Links to Civil 3D social media sites.

Help: Access Civil 3D online help and the Autodesk Knowledge Network.

QNONONOND)

At the bottom of the application window, users will find more tools and commands. The left side contains
the Model tab and layout tabs stored in the file.

Model  Layout] Layout? +

Users can pick the plus tab £F (0 add a new layout. Model and Layouts will be explained in further detail
in later in this chapter.

On the bottom right side of the application window, users will find the Status Bar. The status bar displays
the cursor location, drawing tools, and tools that affect your drawing environment.

MODEL 3 (i - b GF - k- < [ - BK A -0~ -+ D @ 3500 3 =

The status bar provides quick access to some of the most used drawing tools. You can toggle settings such
as grid, snap, polar tracking, and object snap. You can also access additional settings for some of these
tools by clicking their drop-down arrows.

Note: Not all tools are displayed by default; you can choose what tools to display from the
= Customization menu, the right-most button on the status bar B. The tools displayed on the status
= | bar might change depending on the current workspace and whether the Model tab or a layout tab
is currently displayed.

You can also toggle some of these settings with the function keys on your keyboard (F1 - F12).
When a setting is turned on, it has a blue highlight ( E ). When a setting is turned off, there is no highlight.

Tools contained on the Status Bar will be explained in further detail throughout this manual.

14 MDT Internal Use Only
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The Ribbon is Civil 3D’s main command interface. The Ribbon is made up of Tabs. Ribbon Tabs contain
relevant Panels that contain commands. For instance, Civil 3D’s Home Tab contains the Create Ground
Data Panel that contains the Surfaces command.

i Parcel -

*
b,

Clipboard

— . am For instance, Civil 3D's Home Tab contains the
7 Feature Line - - B Create Ground Data Panel that contains the Surfaces
command.

The Ribbon will be covered in more detail later in this chapter.

Finally, users will find the drawing window. Some of the elements of the drawing window will depend upon
the active workspace, and the window displayed will change when a layout tab is active.

© o

WA Y- Typ: o command -

Model Window: Civil 3D’s model space drawing window is infinite.
Command Line: Access all Civil 3D commands through the command line.
User Coordinate System (UCS) Icon: The UCS Icon represents drawing orientation.

Docked Pallet: Palettes containing tools, like Civil 3D’s Toolspace Palette, can be
docked or floating inside of the drawing window.

Viewport Control: Add additional viewports, change the view direction, change the visual
style of the model space.

ViewCube: This box represents the drawing orientation. Users can select corners or
sides of the box to rotate the view of the drawing to match the selection.

Navigation Bar: A collection of tools for navigating the drawing window.

@0 @ © ©0e®0O

Docked Toolbars: Toolbars can be docked or floating inside of the drawing window.

MDT Internal Use Only 15
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1.1.3 Workspaces

Workspaces are sets of user interface components, such as ribbon tabs and panels, toolbars, palettes, and
menu bars, that are grouped and organized so that you can work in a custom, task-oriented drawing
environment. When you select a workspace, only the user interface components specified in that workspace
are displayed. You can still access other commands by entering their command names at the command
line.

Civil 3D comes with a default workspace for working with Civil 3D commands. You can use this workspace
as-is or modify it according to your requirements.

Workspaces in Civil 3D include:
e Civil 3D: This workspace displays user interface components related to civil engineering design

and survey features available in Autodesk Civil 3D.

e Drafting & Annotation: This workspace displays user interface components related to AutoCAD
drafting and annotation features available in Autodesk Civil 3D.

e 3D Modeling: This workspace displays user interface components related to AutoCAD 3D
modeling features available in Autodesk Civil 3D.

e Planning and Analysis: This workspace displays user interface components related to AutoCAD
Map 3D features available in Autodesk Civil 3D.

One location a user can access workspaces and workspace commands is the Quick Access Toolbar. Users
can pick the workspace to switch to, and access commands to customize and save workspaces.

W = - &% Civil 30 v 5 - Share
Civil 3D

Drafting & Annotation

.

v

30 Modeling
Planning and Analysis

Save Current As...

Workspace Settings...

Custormnize...

+ Civil 3D

Drafting & Annotation

Additionally, the workspace menu can be accessed by picking the arrow next to

3D Modeling .
the gear icon located on the Status Bar.

Planning and Analysis

Save Current As...
Workspace Settings...
Customize...

Display Workspace Label

16 MDT Internal Use Only
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& 35000 [ =

How To Change the Current Workspace

You can switch to another workspace by using the Workspace drop-down menu in the Quick Access
Toolbar or by using the Workspace Switching button , Which is in the application status bar.
How To Save the Current Ul Configuration to a New Workspace

1. Configure your workspace. For example, you can close the Tool Palette if you do not want it
to come up every time you start Civil 3D.

=/ | Note: You can also use the CUI command to edit the Workspace using a dialog box interface.

2. Click the Workspace drop-down menu in the Quick Access Toolbar and click Save Current
As.

3. Inthe Save Workspace dialog box, enter a name for the new workspace. You can also select
the name of an existing workspace to overwrite it with your modified configuration.

4. Click Save.

MDT Internal Use Only 17
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1.1.3 Application Menu

The Civil 3D Application Menu, located in the upper left-hand corner of Civil 3D , contains file related
commands and tools along with drawing utilities. A search tool, drawing options, close and exit tools are
also located in the Application Menu.

Command Search Box

Recent File List of Recent Documents
By Ordered List v = =

New File Menu
t Drawing2.dwg

Open File Menu
Save Command

Save As Menu

Export Menu

=

mb Publish

Publish Menu ”H )
Print

Print Menu Drawing
Utilities

Drawing Utilities Menu e G

Close Menu Options Exit Autodesk Civil 3D

GHONCONCONONORUNUNCONORCOND

Options Menu / Exit

1.1.4 Quick Access Toolbar

The Civil 3D Quick Access Toolbar comprises of commonly used commands. It can be customized by
adding and removing commands based on user preference. The default commands are New, Open, Save,
Open from Web or Mobile, Save to Web or Mobile, Plot and Undo/Redo.

1.1.6 Introduction to Model and Paper Space

Civil 3D has two working environments. Model space and paper space. Model space is used for drawing
and creating objects at a 1:1 scale.
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M

i Parcel -

*J Feature Line

&% Grading -

N
Active Drawing View
[ [CLOUD]Drawing2 W n E
= Paints
[#] Paint Groups
&5 Surfaces S

[Unnamed ]
) Feature Lines

B sites
] Catchments
&8 Pipe Networks
T8 Pressure Networks
4 Bridges
B Corridors
“Ely Assemblies
#E Intersections
#F survey
[E] View Frame Groups
(3 Data Shortcuts []
& Surfaces

8 Pipe Networks
-5 Pressure Networks
B Corridors
[52) View Frame Groups

Pl = 70 o command

Model  Layout] 2 MODEL #f i v | & v v o« - & A v-a0- % - + To

Layout | LayoutTools  ww -

Drawing2*

)
Active Drawing View
[ [CLOUD]Drawing2
& Points
~[#] Point Groups
(% Surfaces

) Feature Lines
-l Sites

4 catchments

T8 Pipe Networks
T Pressure Networks
-9 Bridges

T Corridors

£ Assernblies

4 Intersections

- RF Survey

[E] View Frame Groups y Layout1
[ Data Shortcuts ]
€ Surfaces

5 Pipe Networks

T8 Pressure Networks
Ty Corridors
[ View Frame Groups

PR [, &~ hov 2 [~

When a Layout tab is active, the user is active in Paper Space. By default, Civil 3D shows the default print
layout and paper size, and a viewport is also created by default.

Objects like titleblocks, general notes, north arrows and/or bar scales are generally inserted into Paper
Space
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Paper Space UCS Icon

Paper Space Background

Paper Background

Viewport Outline

©O@®

When in Paper Space, the crosshairs
will float across the Paper Space, and
over the paper background. Any
drafting or data inserts in this space will
not appear in Model.

When a user double-clicks inside the viewport outline, Model is activated, and the screen layout changes.

Users will notice the Model elements
inside of the thicker viewport outline.
When the crosshairs travel outside of
[+][Top](2D Wireframe] ' the viewport outline, they turn into a
cursor, and no drawing tools are
available until the user double-clicks
outside of the viewport outline.

While the viewport is active, users can
access all the drafting commands
available in Model space and anything
drawn or inserted inside of the viewport
outline is placed in Model space.

The viewport provides a window into
Model Space, so when there are
drawing objects in model space, they

will be displayed within an aligned viewport in Paper Space.
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Semle to it Objects in Model Space are drawn
rer to a 1:1 scale and the paper
i background in Paper Space is the
T actual paper size. To fit objects
drawn in model space to fit within
the viewport boundaries, a scale is

applied.

5 8 8§ &

-
e

=~
w

L L T T TR TR
o
=]

o
=

While Paper Space is active, the
0 user can select the viewport
1= 200 outline to display and change the
i viewport scale from the Status Bar.

1" =100

1" = 500"
1" =1000"

& & =2 Additionally, when the viewport is
1" = 5000 . ; A
st activated, the scale selection is
Xref scales shown in the Status Bar.

LWl -~ Type a command . e

PAPER | G ~ b~ ~ [ ~ AR A o r=w00~ ] 4

If the viewport is not active/
selected, the scale is not shown.

o

SHREEE CEINIFR There are two icons shown on either side of the scale. On the left, the icon

represents the viewport scale. On the right, the IE icon indicates the viewport scale
is equal to the annotation scale. Annotation scale applies to annotative objects such as text and dimensions.
When these objects are annotative, the scale will determine the size of annotative objects. Annotation and
Annotative objects is explained in more detail later in this manual.

1.1.7 Ribbons

The Autodesk Civil 3D ribbon is the primary user interface for accessing commands and features.

Commands available from the ribbon are organized into tabs. Each tab is organized into a series of panels.

The ribbon is typically turned on (displayed) by default and can be displayed or turned off by using the
Ribbon and RibbonClose commands.

There are two basic types of ribbon tabs: static and contextual.

Static Ribbon Tabs
Static ribbon tabs are always displayed when the ribbon is turned on.

Home Insert  Annotate

Palettes « Explore Optimize  Create Ground Data ~ Create Design ~

Contextual Ribbon Tabs

Contextual ribbon tabs are displayed automatically when you select an object or invoke an object-specific
command.
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Contextual tabs contain commands that are related to the currently selected object. Most contextual tabs
can be closed simply by deselecting the object.

Featured Apps | Assembly: Primary Road Full Section

Multiple Object Select Ribbon Tabs

When multiple types of objects are selected simultaneously, the Multiple contextual tab is displayed in the
ribbon. For example, if you select both a pipe network object and an alignment object, the Multiple
contextual tab is displayed.

Multiple
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Launch Pad Panel

Autodesk Civil 3D contextual ribbons include a Launch Pad panel that provides access to commands that
you might use next in your workflow.

For example, when you select an alignment object, the Alignment contextual tab is displayed. The Launch
Pad panel on the Alignment contextual tab provides a variety of commands that you may want to use next.
For example, you may want to create a corridor, intersection, or data shortcut from the alignment.

Geolocation Ribbon Tab

After you assign a coordinate system to a drawing, the Geolocation ribbon tab is displayed in the ribbon.

Ribbon Components

When working with the Ribbon, it is broken into three main parts. There are Tabs which are laid out across
the top of the ribbon. Inside of Tabs, there are individual Panels. Panel labels are shown at the bottom of
the Ribbon. Inside of each Panel are commands that correspond with the panel.

Tab Commands

In some cases, a Panel label will have an arrowhead
icon (~) to the right of it. Users can select these Panel
¥ Points ~ Titles to expand the Panel and access more
commands.

Home Insert g Annotate  Meodify  Analyze

A% Surfaces -

L Project

iig Explorer T Traverse = When a Panel is expanded it will remain expanded
while the cursor is positioned over the panel. Once the
cursor moves away, the expanded panel will close.

Explore Create Ground Data =

FPanel
The pushpin B icon shown on the left side of the title
area of the expanded panel can be clicked to pin the

<* Points - panel. This will allow the user to move the cursor away

i P from the panel and it will remain expanded.
Project el

g Explorer 3B Traverse - Additionally, some commands are shown with the
same arrowhead icon as specific panels. These are
_ flyout commands and picking those commands will
=’é [ | Til | [M expose a drop-down menu from which commands can be selected.

RSB

Home Insert  Annctate  Modify  Analyze

Explore Create Ground Data =

A user can select a panel title and drag it into the drawing window, causing
the panel to float in the drawing window space. This will ensure commands
from the floating panel are available when the user changes Tabs, exposing a new set of Panels.

Palettes

While floating, Panels show control bars on either side when the cursor is

positioned over the floating panel. £ E
- . ;

On the left side, users can select the location control to drag the floating Toolspace B
panel to a new location or drag and drop it back onto the Ribbon.

Palettes

On the right side there are two icons. The top icon will return the panel to its original location on the Ribbon.
The bottom icon will change the orientation of the floating panel.
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1.1.8 Command Line

Commands are the instructions that tell the program what to do.
There are many ways to initiate a command:

e Make a selection on a ribbon, toolbar, or menu.

e Enter a command in a dynamic input tooltip.

e Enter a command in the command window.

e Drag a custom command from a tool palette.

The dockable, resizable command window accepts commands and system variables and displays prompts
that help you complete a command sequence (including commands that were initiated at another location
such as the ribbon).

LA (LAYER)
/2 LABEL (MLEADER)
o LAYOUTLINE (XLINE)

£, LAYISO

“% LAYFRZ

22 | AYMCUR

=% LAYUNISO
(=] LAYEREVAL
Layer: 0

Respond to Command Prompts

After you enter a command, you may see a series of prompts displayed at the command line. For example,
after you enter PLINE and specify the first prompt, the following prompt is displayed:

PLINE Specify next point or [Arc Halfwidth Length Undo Width]:
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displays recently

used commands to respond to prompt,

click option or enter
highlighted letter

~ PLINE Specify next point or [.ﬂ.r:c Halfwidth Length
Undo Width]:

accesses command
window display options

opens extended
command history

In this case, the default is to specify the next point. You can either enter X,Y coordinate values or click a
location in the drawing area.

To choose a different option, click the option. If you prefer to use the keyboard, specify the option by entering
the capitalized, colored letter. You can enter uppercase or lowercase letters. For example, to choose the
Width option, type w and press Enter.

Sometimes the default option (including the current value) is displayed after the angle-bracketed options:
POLYGON Enter number of sides <4>:

In this case, you can press Enter to retain the current setting (4). If you want to change the setting, type
another number and press Enter.

Note: When you click a ribbon option to start commands that change property settings such as
S| | color, layer, lineweight, dimension style, and multileader style, the command line prompts are
hidden. This reduces the display of unnecessary text.

Display Suggested Commands and System Variables

By default, the name of a command or system variable is automatically completed as you type it. A
suggestion list of commands and system variables that use the same letters is also displayed. You can
control the settings for these features in the Input Search Options dialog box.

If the automatic completion features are turned off, type a letter on the command line and press the Tab
key to cycle through all the commands and system variables that begin with that letter. Press Enter or
Spacebar to start the command or system variable.

Enter Command Aliases

Some commands have abbreviated names, or command aliases, that you can enter at the command line.
For example, instead of entering circle to start the CIRCLE command, you can type ¢ and press Enter. The
command Suggestion List (if displayed) indicates the alias in front of the command name: C (CIRCLE)
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Interrupt a Command with Another Command or System Variable

Many commands can be used transparently. That is, they can be entered on the command line while you
use another command. Commands that do not select objects, create new objects, or end the drawing
session usually can be used in this way.

To use a command transparently, enter an apostrophe () before entering the command at any prompt. On
the command line, double angle brackets (>>) precede prompts that are displayed for transparent
commands. After you complete the transparent command, the original command resumes. In the following
example, you turn on the grid and set it to one-unit intervals in the middle of the LINE command.

Command: line

Specify first point: 'grid

>>Specify grid spacing (X) or [ON/OFF/Snap/Major/aDaptive/Limits/Follow/Aspect] <0.5000>: 1
Resuming LINE command

Specify first point:

Changes made in dialog boxes that you have opened transparently cannot take effect until the interrupted
command has been completed. Similarly, if you reset a system variable transparently, the new value cannot
take effect until you start the next command.

Aids for Entering Commands

The program offers several ways to remember which commands to use:
e Automatic completion. Completes name of a command or system variable as you type it.

e Command line suggestion list. Displays a list of commands or system variables that match or
contain the letters you have typed. The order of this list changes as you use the program, so that
the commands you use most frequently are displayed at the top of the list. The program also offers
suggestions for misspelled entries.

e Automatic correction. Commands that you frequently misspell. The program automatically adds
words that you misspell and correct a specified number of times to the AutoCorrectUserDB.pgp file.
You can also update this text file manually.

e Command cycling. Cycles through commands you have already used in the current session when
you press the Arrow keys. An arrow button on the left end of the command line also displays this
list.
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ix Bk

OSAVE
ERASE
PLINE
OPTIOMS
SPLIME
Z00M

You can change the settings for these options from the command line Customization button or shortcut
menu.

How To Enter Commands

Enter a Command on the Command Line
1. Enter the command using one of the following options:

e In the Command prompt text box, type the full command name and press Enter or
Spacebar.

e |f automatic command completion is turned on, start typing the command. Press Enter
when the correct command is highlighted in the command text area.

e Enter the command alias (a shorter, alternate name that is stored in the .pgp file) and
press Enter.

2. Respond to any additional prompts and options using one of the following methods:

e To select the default option, displayed in brackets, press Enter.
e Torespond to a prompt, enter a value or click a location in the drawing.

e To specify a prompt option, type the capitalized, highlighted letters in the prompt list
and press Enter.

e To select a prompt option, click the prompt.

How To Reuse a Recently Used Command
1. Do one of the following:

e Click within the command line and press the Up or Down Arrow key to cycle through
commands you have entered.

¢ Click the Recent Commands button to the left of the command text box.
¢ Right-click the command line and select Recent Commands.
e Right-click the drawing area and select a command from the Recent Input list.

2. Click the command that you want to use.

The command is reinitiated.
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Repeat a Command

Use one of these methods:

e With the cursor in the Command prompt text box, press Enter or the Spacebar after the
command is complete.

e Enter multiple in front of the command.
e For example, enter multiplecircle to be prompted for additional circles.

¢ Right-click anywhere. (This behavior is set on the User Preferences tab of the Options
dialog box.)

Complete a Command Entry

To accept an entered value or complete a command, do one of the following:

e Press Enter.

e Press the Spacebar.

e Right-click and select Enter or just right-click (depending on right-click behavior settings).
Note: The instructions in Help assume this step and do not specifically instruct you to complete each entry.
Cancel a Command

e Press Esc.

About Positioning the Command Window

Change the position and display of the command window to suit the way you work.

Docking the Command Window

A docked command window is the same width as the application window. It is displayed in a fixed location
above or below the drawing area.
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Current line-width is @.@888
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:

¥ PLINE Specify next point or [Arc Close Halfwidth Length Undo Width]:

Drag the command window to dock or undock.

i)

B~ TP

The command window is docked by default for certain operating systems and Windows themes.

Anchoring the Command Window

An anchored command window adheres to the top or bottom of the drawing area.

If you move or resize the application window, the anchored command window retains its relative position.
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Floating the Command Window

If the command window is not docked or anchored, it is floating.

You can move a floating command window anywhere on the screen, resize its width and height, and
increase its transparency.

Resizing the Command Window

You can resize the command window vertically by dragging the splitter bar, which is located on the top or
the bottom edge of the window. Resize the window horizontally by dragging the right or left edge.

Hiding the Command Window

Hide and redisplay the command window by pressing Ctrl+9 or from the ribbon (View tab > Palettes
panel > Command Line ==). When you hide the command window, you can still enter commands in the
dynamic input tooltip. However, some commands and system variables return values in the command
window, so you may want to redisplay it in those instances.

1.1.9 Windows and Palettes

Dock a Window or Palette

1. Right-click the title bar and select Allow Docking.

2. Click and drag the window or palette to a docking location on the right or left edge of the drawing
area.

3.  When the outline of the window is displayed in the docking area, release the button.

Note: To place a window or palette in a docking region without docking it, hold down the Ctrl key
as you drag.
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Undock a Window or Palette

Use one of the following methods:
¢ Right-click the title bar and clear the Allow Docking checkmark.
e Double-click the double bars in the title bar.
e Position the cursor in the title bar and drag the window or palette away from its docked location.

Anchor a Dockable Window

1. Right-click the title bar and select Allow Docking.

2. Right-click the title bar and select Anchor Right or Anchor Left.

Float an Anchored Window
Do one of the following:

¢ Right-click the title bar and clear the Allow Docking checkmark.
e When the anchored window is open, drag the title bar away from the edge of the drawing area.
e Double-click the anchor tab.

Toggle Auto-hide for a Floating Window or Palette
Use this procedure for the Tool palette, Design Center, the Properties palette, and several other palettes.

e On the title bar, click the Auto-hide button.

If Auto-hide is selected, floating windows roll open and closed as the cursor moves across
them. When this option is cleared, the full window stays open continuously.

1.1.10 Navigating the Drawing

About Panning and Zooming in the Current View

You can pan to reposition a view and zoom to change the magnification of a view.

Typically, you pan and zoom the current view with a wheel mouse or similar device. Rolling the wheel
zooms the view, while pressing and dragging the wheel pans the view.

The Model Tab

In the Model tab example below on the left, the current view is the entire drawing area. The example on the
right displays two model space viewports, one of which is highlighted as the current viewport. You can click
within a viewport to make it the current one, and you can then pan and zoom the view displayed in it.
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+ +

A\ O & O

A Layout Tab

In the layout tab example below on the left, the current layout viewport is highlighted, in which you can pan
and zoom an area of model space. In the example on the right, double-clicking outside the layout viewports
puts you in paper space, where you can pan and zoom the entire layout. This is how you would magnify
the area of the title block.

1 | 4|

- S . - - s o .. =T ¥ 3 T o 1 | I

= | Note: Ina layout, the view displayed in a layout viewport can be locked to prevent unintentional
changes to the scale and position of the view.

Common Zoom Options

In addition to zooming with the mouse wheel, commonly used options of the ZOOM command include the
following:

e ZOOM Previous restores the previous view in the drawing area or viewport.

e ZOOM Extents displays a view with the largest possible magnification that includes all
objects in the drawing, including objects on layers that are temporarily turned off. The extents
does not include objects on frozen layers.
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Zoom

Increases or decreases the magnification of the view in the current viewport.

+

—
L
"~

You can change the magnification of a view by zooming in and out, which is similar to zooming in and out
with a camera. Using ZOOM does not change the absolute size of objects in the drawing. It changes only
the magnification of the view.

In a perspective view, ZOOM displays the 3DZOOM prompts.
The following prompts are displayed.

Corner of window

Specify one corner of the area to be zoomed into.

e Opposite corner. Specify the opposite corner of the zoom area.
All

Zooms to display all visible objects and visual aids.

Adjusts the magnification of the drawing area to accommodate the extents of all visible objects in
the drawing, or visual aids such as the grid limits (the LIMITS command), whichever is larger.

'\k\%} _% Y

before ZOOM All after ZOOM Al

In the illustration on the right, the grid limits are set to a larger area than the extents of the drawing.
Because it always regenerates the drawing, you cannot use ZOOM All transparently.

Center

Zooms to display a view defined by a center point and a magnification value or a height. A smaller
value for the height increases the magnification. A larger value decreases the magnification. Not
available in perspective projection.

0_0O

00
{:OO O O
\o~0 O 0

before ZO0M center after ZO0M center,
magnification increased

Dynamic
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Pans and zooms using a rectangular view box. The view box represents your view, which you can
shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms
to fill the viewport with the view inside the view box. Not available in perspective projection.

-
E%E* e
Slm
T nys
wiew box —— MIEW View

e To change the size of the view box, click, resize it, and click again to accept the new
size of the view box.

e To pan with the view box, drag it to the location you want and press Enter.
Extents

Zooms to display the maximum extents of all objects.

The extents of each object in the model are calculated and used to determine how the model should
fill the window.

®ch @<l

before ZOOM Extents after ZO0M Extents
Previous

Zooms to display the previous view. You can restore up to 10 previous views.

-:. —t e T [ 4:'.
i 3 S
; b
{]_} TTovoToooT ::l 11_
o mogr_n L L o
original view current view after ZOOM Previous

Scale / Scale factor

Zooms to change the magnification of a view using a scale factor.

e Enter a value followed by x to specify the scale relative to the current view.
o Enter a value followed by xp to specify the scale relative to paper space units.

For example, entering .5x causes each object to be displayed at half its current size on the screen.
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| i

ZO0OM Sx

Entering .5xp displays model space at half the scale of paper space units. You can create a layout
with each viewport displaying objects at a different scale.

Enter a value to specify the scale relative to the grid limits of the drawing. (This option is rarely
used.) For example, entering 2 displays objects at twice the size they would appear if you were
zoomed to the limits of the drawing.

@ &

ZO0M 2

Window

Zooms to display an area specified by a rectangular window.

With the cursor, you can define an area of the model to fill the entire window.

@ ‘]

*~ O

© —

before ZOOM Window after ZOOM Window
Object

Zooms to display one or more selected objects as large as possible and in the center of the view.
You can select objects before or after you start the ZOOM command.

Real Time

Zooms interactively to change the magnification of the view.

The cursor changes to a magnifying glass with plus (+) and minus (-) signs. See Zoom Shortcut
Menu for a description of the options that are available while zooming in real time.

Qr Q-
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Holding down the pick button at the midpoint of the window and moving vertically to the top of the window
zooms in to 100%. Conversely, holding the pick button down at the midpoint of the window and moving
vertically to the bottom of the window zooms out by 100%.

When you reach the zoom-in limit, the plus sign in the cursor disappears, indicating that you can no longer
zoom in. When you reach the zoom-out limit, the minus sign in the cursor disappears, indicating that you
can no longer zoom out.

When you release the pick button, zooming stops. You can release the pick button, move the cursor to
another location in the drawing, and then press the pick button again and continue to zoom the display from
that location.

To exit zooming, press Enter or Esc.
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Exercise | Navigate the User Interface

In this exercise you will explore the components of the AutoCAD interface.

You do the following:

Start AutoCAD.

Examine tabs and ribbons.
Examine the status bar.
Set status bar options.

In this exercise, you start AutoCAD for the first time. You familiarize yourself with the AutoCAD interface.
You then set options that make AutoCAD behave in a more efficient manner.

In the first step, you start AutoCAD, and begin a new drawing.

1. Start AutoCAD.
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2. Select Application Menu: New. A~

A4l

DEHEL = <=-

~ 5 7 Share
Create a new drawing

Fm.  Drawing
[ Start a new drawing with a selected
OWET  drawing template file,

Sheet Set
—{\\ Create a sheet set data file that

%) manages drawing layouts, file paths,
and project data.

The Select template dialog box appears.

A Select ternplate

Look in: Template v L X &
o Name - Preview
= PTWTemnplates
SheetSets
A5 Bacad -Named Plot Styles.dwt
j [l acad -Named Plot Styles3D.dwt
E:I_wﬁacad.dwt
[ acad3D.dwt
[ [l acadISO -Named Plot Styles.dwt
BacadlSO -Named Plot Styles3D.dwt
E-Hacadiso.dwt

Bacadisom.dw‘c

[ Tutorial-iArch.dwt
[ Tutarial-iMfg.dwt
BTutorial-mArch.dwt
E-HTutorial-meg.dwt

X

Views ~ Tools

< >
File name: acad dwt v| QOpen %B
Files of type: | Drawing Template (*.dwt) ~ Cancel

3. Select the acad.dwt template, then click <<Open>>.
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4. Examine the tabs in the AutoCAD Home  Inset  Annotate  Parametric  View  Manage Cutput  Add-ins
Ribbon A %% Standard v "_" Standard
A o] F=1 5
Multiline _|B —* Dimension 4 DU_&Currr:nt
Text A v {1 Linear - l'_'l d
Text = u Dimensi
5. Select the Home tab and review Home  Insert  Annotate  Parametric  View  Manage COutput  Add-ins
the commands. The r_najo_rity of / - A\ T - 4 Move () Rotate W Tim -
the commands used in this book |- NS ©% Copy /A Mimor {7 Fillet -

are found on the Home tab.

Line Polyline Circle  Arc

Draw «

- D_:_ Stretch ESEEIE

Modify ~

og s
oo Array -

M G

Exercises in this book will use the following format to access Ribbon commands:

Select Ribbon: Home = Draw = Line.

Next you will adjust some settings to prepare AutoCAD for the exercises in this book.

On the far-right side of the status bar, select the

Customization button.

In the fly-out menu, select Coordinates and Dynamic

Input.

Click in the drawing window to close the menu.

Coordinate values now display on the status bar. This will help you as

you learn to draw with several different coordinate methods in a later

lesson

B~ 4+ °BE=

+ Coordinates

¥ Model Space

' Grid
¥ 5Snap Mode

Infer Constraints

v Dynamic Input

)

v Ortho Mode

3.4795, 41921, 0.0000

9. Select each of the following buttons in the status bar to turn them off.

9.1027, 43176, 0.0000 MDDEL|

Hiiivﬁ.g_-::}?v*viﬂvf):A)=I-ﬂ-v+'10='EEIE

The icons appear blue if they are enabled, and gray if they are disabled. Each of these buttons represent
an option that can be turned on to help you draw in AutoCAD. You will start by turning them all off, and
then you will turn them on one-by-one as you learn to work with each option.
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Exercise | Working with AutoCAD Files

In this exercise you will perform some basic tasks related to working with AutoCAD
drawings.

You do the following:

e Create a new drawing.

e Save a drawing.

e Open existing drawings.

e Save a drawing in a different format.
e Work with multiple drawings.

e Close drawings.

In this exercise, you create a new drawing file and save it. You will also open an
existing drawing file and save it in a different format. You will simultaneously work
with multiple AutoCAD drawings. Finally, you will close any open drawing files.

NOTE: Instructions for downloading and installing the datasets can be found on page v.

First you will create a new drawing file and save it to the dataset folder.

1. Select Application Menu: New. A- DEFHEBEL g &< -5 4 Shae

l—j I—j Create a new drawing

DNEW R L3 P Drawing

BN Start a new drawing with a selected
OWET  drawing template file,

Sheet Set
— Create a sheet set data file that

E Save \‘:j manages drawing layouts, file paths,

and project data.

The Select template dialog box opens.
2. Select the acad.dwt template.

3. Click <<Open>> to continue.

4. Select Quick Access Toolbar: Save.

DHHELdES- = -~

The Save Drawing As dialog box opens.
5. Browse to C:\A Practical Guide\AutoCAD 2022\
6. Enter the File name: 1.2.1 Sample Project.

7. Click <<Save>> to continue.
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Next, you will open an existing file from the datasets folder. Then, you will save the

drawing in a different format so that it could be shared with someone who is using an

older version of AutoCAD.

8. Select Quick Access Toolbar:

Open.

The Select File dialog box opens.

BL

HLligs-~-+7

9. Browse to C:\A Practical Guide\AutoCAD 2022\

10. Select the file 1.2.1 Open a Drawing.dwg.

11. Click <<Open>> to continue.

Next, you will save the drawing in a different format so that it could be shared with
someone who is using an older version of AutoCAD.

12. Select Quick Access Toolbar: Save

as.

The Save Drawing As dialog box opens.
13.

14. Click the drop-down arrow
next to Files of type:
15. Select AutoCAD
2007/LT2007 Drawing

(*.dwg).

16. Click <<Save>> to continue.

Edit the File name to read 1.2.1 2007 Drawing.

File name:

Files of type:

[1.2.1 2007 Drawing

AutoCAD 2018 Drawing (" dwa)

AutoCAD 2018 Drawing (*.dwa)

AutoCAD 2013/LT2013 Drawing (*.dwg)
AutoCAD 2010/LT2010 Drawing (".dw
AutoCAD 200 007 Dra g (*.dwg
AutoCAD 2004/LT2004 Drawing (*.dwa)
AutoCAD 2000/LT2000 Drawing (*.dwg)
AutoCAD R14/LTS8/LTS7 Drawing (" dwa)
AutoCAD Drawing Standards (.dws)
AutoCAD Drawing Template {* dwt)

Save

Cancel

The file has been saved in the AutoCAD 2007 drawing file format. This means that it can

now be opened with any version of AutoCAD from 2007 to the most recent version.

You should now have two drawing files open (1.2.1 Sample Project and 1.2.1 2007

Drawing). You will arrange the two drawings on-screen at the same time.

17. Select Ribbon: View = Interface = Tile Horizontally.

Both drawings appear on-screen, arranged horizontally. The Start tab may also be

showing.

o

Switch

Windews

il
File
Tabs

-

Layout
Tabs

Interface

% Tile Herizontally

Tl Vertically k

[l__l':l Cascade
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18. Minimize the Start tab window (if necessary).

19. Select Ribbon: View = Interface = Tile Horizontally.

i

Switch

Windows

]

File

d % Tile Horizentally
e

Ti|eufertica||\,rk
Layout

Tabs

Tabs ll_"l'j Cascade

nterface 3

The Start tab no longer appears on-screen, allowing you to work in the two open

drawings.

20. Select Ribbon: View = Interface = Tile Vertically.

T

Switch

Windows

"]
File
Tabs

Tabs

% Tile Horizentally
s

[ Tile Vertically
Layo

II"D Cascade k

Interface 3

The two drawings are now arranged vertically. You will find that the best method of tiling
is dependent upon several factors, including the types of drawings you are working with

and the size of your computer monitor.

21. Select the [Z] icon in the drawing tab labeled 1.2.1 Sample Project.

22. If prompted to save changes, click <<Yes>>.

The drawing closes.

23. Select the B icon in the upper right corner of the remaining drawing window.

24. If prompted to save changes, click <<Yes>>.
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Chapter 2 | Drawing and Editing Tools

Section 1 | Creating Geometry

2.1.1 About the Drawing Environment

You can use absolute or relative Cartesian (rectangular) coordinates to locate points when creating objects.

To use Cartesian coordinates to specify a point, enter an X value and a Y value separated by a comma.
The X value is the positive or negative distance, in units, along the horizontal axis. The Y value is the
positive or negative distance, in units, along the vertical axis.

Absolute Coordinates

Absolute coordinates are based on the UCS origin (0,0), which is the intersection of the X and Y axes. Use
absolute coordinates when you know the precise X and Y values of the point.

With dynamic input, you specify absolute coordinates with the # prefix. If you enter coordinates on the
command line instead of in the tooltip, the # prefix is not used. For example, entering #3,4 specifies a point
3 units along the X axis and 4 units along the Y axis from the UCS origin.

The following example draws a line beginning at an X value of -2, a Y value of 1, and an endpoint at 3,4.
Enter the following in the tooltip:

Command: line
From point: #-2,1
To point: #3,4

The line is located as follows:

Y
4
Pat]
-2,1
WX X
+2 3
'

Relative Coordinates

Relative coordinates are based on the last point entered. Use relative coordinates when you know the
location of a point in relation to the previous point.

To specify relative coordinates, precede the coordinate values with an @ sign. For example,
entering @3,4 specifies a point 3 units along the X axis and 4 units along the Y axis from the last point
specified.
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The following example draws the sides of a triangle. The first side is a line starting at the absolute
coordinates -2,1 and ending at a point 5 units in the X direction and 0 units in the Y direction. The second
side is a line starting at the endpoint of the first line and ending at a point O units in the X direction and 3
units in the Y direction. The final line segment uses relative coordinates to return to the starting point.

Command: line
From point: #-2,1
To point: @5,0
To point: @0,3

To point: @-5,-3

3]
5
' 3.4
3
2
1

..

=o-d=3=2=1 12|33 45678 9

2.1.2 About Coordinate Entry

When a command prompts you for a point, you can use the pointing device to specify the point, or you
can enter its coordinates. When dynamic input is turned on, you can enter the coordinate values in a
tooltip near the cursor.

Cartesian and Polar Coordinates

A Cartesian coordinate system has three axes, X, Y, and Z. When you enter coordinate values, you indicate
a point's distance and its direction (+ or -) along the X, Y, and Z axes relative to the coordinate system origin
(0,0,0).

In 2D, you specify points on the XY plane, also called the work plane. The work plane is similar to a flat
sheet of grid paper. The X value of a Cartesian coordinate specifies horizontal distance, and the Y value
specifies vertical distance. The origin point (0,0) indicates where the two axes intersect.

Polar coordinates use a distance and an angle to locate a point. With both Cartesian and polar coordinates,
you can enter absolute coordinates based on the origin (0,0) or relative coordinates based on the last point
specified.

Another method of specifying a point is by moving the cursor to indicate a direction, and then entering a
distance. This method is called direct distance entry.

You can enter coordinates in scientific, decimal, engineering, architectural, or fractional notation. You can
enter angles in grads, radians, surveyor's units, or degrees, minutes, and seconds. The UNITS command
controls the unit format.
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Note:

e Coordinates and distances are always measured in units, which do not represent any
specific type of units such as millimeters or inches. Before you start, you decide what
= distance one unit will represent in the drawing.

e Coordinates normally reference a moveable user coordinate system (UCS) rather than
the fixed World Coordinate System (WCS). By default, the UCS and WCS are
coincident.

Enter Coordinates Using Dynamic Input Tooltips

You can also enter coordinates in dynamic input tooltips. After you type a coordinate value in an input field
and press Tab, the field displays a lock icon, and the cursor is constrained by the value that you entered.
You can then enter a value for the second input field. Alternately, if you type a value and press Enter, the
second input field is ignored, and the value is interpreted as direct distance entry.

Display Coordinates on the Status Bar

The current cursor location is displayed as a coordinate on the status bar.

31.5262, 9.1136, 0.0000

Note: Coordinates are not displayed on the status bar by default. Click Customize on the status bar and
select Coordinates to display it.

There are three types of coordinate display: static, dynamic, and distance and angle.

e Static display. Updates only when you specify a point.
e Dynamic display. Updates as you move the cursor.

e Distance and angle display. Updates the relative distance (distance<angle) as you move
the cursor. This option is available only when you draw lines or other objects that prompt you
for more than one point.

About Entering Polar Coordinates

You can use absolute or relative polar coordinates (distance and angle) to locate points when creating
objects.

To use polar coordinates to specify a point, enter a distance and an angle separated by an angle bracket

(<)

By default, angles increase in the counterclockwise direction and decrease in the clockwise direction. To
specify a clockwise direction, enter a negative value for the angle. For example, entering 1<315 locates the
same point as entering 1<-45. You can change the angle conventions for the current drawing with the
UNITS command.
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afr
135 45

iac o

225 g
27

Absolute Polar Coordinates

Absolute polar coordinates are measured from the UCS origin (0,0), which is the intersection of
the X and Y axes. Use absolute polar coordinates when you know the precise distance and angle
coordinates of the point.

With dynamic input, you can specify absolute coordinates with the # prefix. If you enter coordinates on the
command line instead of in the tooltip, the # prefix is not used. For example, entering #3<45 specifies a
point 3 units from the origin at an angle of 45 degrees from the X axis.

The following example shows two lines drawn with absolute polar coordinates using the default angle
direction setting. Enter the following in the tooltip:

Command: line
From point: #0,0
To point: #4<120

To point: #5<30

-
k-t 5
4
LT 0.0 45

46 MDT Internal Use Only



User Guide Chapter 2 | Drawing and Editing Tools

Relative Polar Coordinates

Relative coordinates are based on the last point entered. Use relative coordinates when you know the
location of a point in relation to the previous point.

To specify relative coordinates, precede the coordinate values with an @ sign. For example,
entering @1<45 specifies a point at a distance of 1 unit from the last point specified at an angle of 45
degrees from the X axis.

The following example shows two lines drawn with relative polar coordinates. In each illustration, the line
begins at the location labeled as the previous point.

Command: line
From point: @3<45

To point: @5<285

ahcan previous peint —,
| I-l
previous point 3 | \
=1
k]
0.0 =3 oa o @5<285

! @

o
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2.1.3 Drawing Lines

The line object is the most basic and common object in AutoCAD drawings of any discipline.

—
N
{ s
y
13

|

414 . 5 LR 2

498 . iF

Each segment is a line object that can be edited separately, assigning properties such as layer, linetype,
and lineweight. The simplest method to draw a line is to click two locations in the drawing area, however
you will want your drawing to be much more precise.

Precision in Specifying Point Locations

Use object snaps, Osnaps, to snap to locations on objects

Use object snap tracking to combine object snap locations

Use Grid Snap (F9) to restrict point selection to intervals that you define

Enter coordinates for one or both ends of the line
Precision in Specifying Angle Directions

e Use Orthogonal locking, Ortho Mode (F8), to constrain cursor movement to the horizontal
and vertical directions

e Use polar tracking (F10) to guide cursor movement to specified angles
e Use angle overrides to lock the cursor to a specified angle

You can use these tools along with direct distance entry to draw objects quickly and with precision.

How To: Draw a Line
1. Click Home tab > Draw panel > Line.

2. Specify the start point and end point of the line segment by left clicking in the drawing
area.

3. Continue specifying additional line segments.

To undo the previous line segment, enter u at the prompt. Click Undo on the Quick Access
toolbar to cancel the entire series of line segments:

4. Press Enter or Esc when done or enter c to close a series of line segments.
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How To: Draw a Line using Specific Coordinates
1. Click Home tab > Draw panel > Line.

2. Type the coordinate value for the first point by typing the X value, a comma, then the Y value,
for example 1.65,4.25.

Press the Spacebar or Enter.
4. Do one of the following:

o If dynamic input is on: Type the pound sign (#) followed by the X-value, a comma,
then the Y-value, for example #4.0,6.75.

o If dynamic input is off: Type the X value, a comma, then the Y value, for example
4.0,6.75.

5. Press the Spacebar or Enter.

.= | Note: When dynamic input is on, relative coordinates are the default. When dynamic input is off,
= absolute coordinates are the default. Press F12 to turn dynamic input on or off.

How To: Draw a Line using a Relative Coordinate
1. Click Home tab > Draw panel > Line.

Draw -

2. Specify the first point.
3. To specify the second point relative to the first point, do one of the following:

o If dynamic input is on: Type the X-value, a comma, then the Y-value, for example
4.0,6.75.

o If dynamic input is off: Type the at sign (@) followed by the X-value, a comma,
then the Y-value, for example @4.0,6.75.

4. Press the Spacebar or Enter.
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How To: Draw a Line using a Specific Length
1. Click Home tab > Draw panel > Line.

2. Specify the start point.
3. Do one of the following to specify the length:

o Move the cursor to indicate the direction and angle, and enter the length, for
example 6.5.

o Enter the at symbol (@) and the length, followed by the left angle bracket (<) and
the angle, for example @6.5<45.

4. Press the Spacebar or Enter.

How To: Draw a Line using a Specific Angle
1. Click Home tab > Draw panel > Line.

Draw -

2. Specify the start point.
3. Do one of the following to specify the angle:

o Enter the left angle bracket (<) and the angle, for example <45, and move the
cursor to indicate the direction.

o Enter polar coordinates, for example 2.5<45.

o Press F8to turn on Ortho to lock the angle to horizontal and vertical directions.
You can also press Shift when specifying the next point for a horizontal or vertical
direction.

o Press F10 to turn on polar tracking. You might need to use the DSETTINGS
command, Polar Tracking tab to specify additional polar angles and choose the
option to track all polar angle settings.

o Move the cursor to indicate an approximate angle.
4. Do one of the following to specify the length:

o Click a point to specify the endpoint with or without using object snaps. Trim or
extend the resulting line as needed.

o Enter the length of the line, for example 2.5.
5. Press the Spacebar or Enter.

How To: Draw a Line using a Specific Angle to Another Line

Temporarily aligning the UCS icon with an existing line makes it easy to draw a line at a specific angle to
another line.
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1. Atthe command prompt, enter UCS.
2. Enter ob for Object and select the existing line.
The UCS origin (0,0,0) is redefined.

3. Click Home tab > Draw panel > Line.

Draw =

4. Specify the start point.
5. Do one of the following to specify the angle:

o Enter the left angle bracket (<) and the angle, for example <45, and move the
cursor to indicate the direction.

o Move the cursor to indicate the approximate angle.
Specify the second point.
Press the Spacebar or Enter.

At the command prompt, enter UCS.

© ® N o

Enter p for Previous to reset the UCS origin.
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Exercise | Drawing Lines

In this exercise you will use the Line command to draw objects while familiarizing yourself
with Command line options of the Line command.

You do the following:

e Draw lines.
e Use the Close option to create a closed shape.
e Use the Undo option to remove the last line segment created.

Drawing Lines

1. Open drawing 2.1.1 Drawing Lines.dwg.

This is an empty drawing.

2. Select Ribbon: Home = Draw = Line.

) |/:;\| _,"'.--. 0 -
— "
olyline  Circle  Arc

Draw ~

You will begin by drawing a triangle. For now, only concern yourself with creating the
basic shape. In later lessons you will make more precise shapes.

3. Click three points on-screen to create two sides of a triangle.
4. At the Command line select the [Close] option.

The triangle is closed and AutoCAD exits the Line command.

5. Select Ribbon: Home = Draw = Line.

) |/:;\| _,"'.--. (R
— "
olyline  Circle  Arc

Draw ~
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Next you will draw a rectangular shape. Once again, do not be concerned with precision,
only the basic shape.

6. Click four points on-screen to create three sides of a rectangle.
7. Atthe Command line select the [Close] option.
The rectangle is closed and AutoCAD exits the Line command.
Next you will compare the Undo commands that are available.

8. Select Ribbon: Home = Draw = Line.

{ |'/:}\| .J'J..--. (R
— \J !

(O
olyline Circle  Arc
" .

Draw =

9. Click several points on-screen to make a shape similar to the one below.

10. At the Command line select the [Undo] option.

The last segment is deleted.

11. Select Quick Access Toolbar: Undo.

DEHELDR #

All segments are deleted as the Undo is applied to the entire Line command.

12. Save the drawing.
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Exercise | Drawing Lines with Coordinates

In these exercises you will draw lines using the absolute, relative, and polar coordinate
entry methods.

You do the following:

e Draw lines with the Absolute Coordinate entry method.
e Draw lines with the Relative Coordinate entry method.
e Draw lines with the Polar Coordinate entry method.

In this exercise you will create a rectangle by inputting absolute coordinate values.

25 7,5

2.2 7,2

\(
L X
1. Open drawing 2.2.1 Absolute Coordinates 1.dwg.

This is an empty drawing.

2. Select Ribbon: Home = Draw = Line.

i |/ :‘;\l
—

olyline  Circle
-

Draw -

Arc
-

3. Atthe Command line type 2,2 then press [Enter] at the keyboard to locate the first point of

the rectangle.

4. At the Command line type 7,2 then press [Enter] at the keyboard to locate the next point of

the rectangle.

5. At the Command line type 7,5 then press [Enter] at the keyboard to locate the next point of

the rectangle.

6. Atthe Command line type 2,5 then press [Enter] at the keyboard to locate the next point of

the rectangle.

7. At the Command line type 2,2 then press [Enter] at the keyboard to locate the last point of

the rectangle.
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Alternatively, you could use the [Close] option in the Line command.
8. Press [Esc] at the keyboard to end the Line command.
9. Save the drawing.

In this exercise you will create a more complex drawing by inputting absolute
coordinate values.

25 8,5
5,4 /
2,4 74
33
22 7,2

Y 2,1
L X
1. Open drawing 2.2.2 Absolute Coordinates 2.dwg.

This is an empty drawing.

2. Select Ribbon: Home = Draw = Line. —
v Y [

—

olyline Circle  Arc
- -

] -

Draw -

3. Atthe Command line type 2,1 then press [Enter] at the keyboard to locate the first point of
the shape.

4. Atthe Command line type 8,1 then press [Enter] at the keyboard to locate the next point.
5. Atthe Command line type 7,2 then press [Enter] at the keyboard to locate the next point.
6. Atthe Command line type 5,2 then press [Enter] at the keyboard to locate the next point.
7. Atthe Command line type 5,4 then press [Enter] at the keyboard to locate the next point.
8. At the Command line type 7,4 then press [Enter] at the keyboard to locate the next point.
9. At the Command line type 8,5 then press [Enter] at the keyboard to locate the next point.
10. At the Command line type 2,5 then press [Enter] at the keyboard to locate the next point.

11. At the Command line type 2,4 then press [Enter] at the keyboard to locate the next point.
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12. At the Command line type 3,3 then press [Enter] at the keyboard to locate the next point.
13. At the Command line type 2,2 then press [Enter] at the keyboard to locate the next point.

14. At the Command line type 2,1 then press [Enter] at the keyboard to locate the last point of
the shape.

Alternatively, you could use the [Close] option in the Line command.
15. Press [Esc] at the keyboard to end the Line command.
16. Save the drawing.

In this exercise you will create a rectangle by inputting relative coordinate values.

@-4,0 @0.,5
@0,-5
v 31 @4.,0

-

1. Open drawing 2.2.3 Relative Coordinates 1.dwg.

This is an empty drawing.

2. Select Ribbon: Home = Draw = Line.

] I/:}\I .-’.‘..--. .I__|' T
— \J

olyline  Circle  Arc

Draw «

3. Atthe Command line type 3,1 then press [Enter] at the keyboard to locate the first point of
the rectangle.

It is necessary to start with an absolute coordinate because there are no previous points to reference.

4. At the Command line type @4,0 then press [Enter] at the keyboard to locate the next point of
the rectangle.

This creates a line that moves 4 to the right, and 0 vertically.

56 MDT Internal Use Only



User Guide Chapter 2 | Drawing and Editing Tools

5. At the Command line type @0,5 then press [Enter] at the keyboard to locate the next point of
the rectangle.

This creates a line that moves 0 horizontally, and 5 up.

6. Atthe Command line type @-4,0 then press [Enter] at the keyboard to locate the next point
of the rectangle.

This creates a line that moves 4 to the left, and 0 vertically.

7. Atthe Command line type @0,-5 then press [Enter] at the keyboard to locate the last point of
the rectangle.

This creates a line that moves 0 horizontally, and 5 down. Alternatively, you could use the
[Close] option in the Line command.

8. Press [Esc] at the keyboard to end the Line command.
9. Save the drawing.

In this exercise you will create a more complex drawing by inputting relative
coordinate values.

@-7.0 @0,1

@1,-1 @1,1
@2.0

@-1,1

@0,1

@0,-2 @-2.0

@-1,-1

v 2.1 @7.0

1. Open drawing 2.2.4 Relative Coordinates 2.dwg.

This is an empty drawing.

2. Select Ribbon: Home = Draw = Line.

| |/:}\| _,"'.--. Bl =

— NS

olyline  Circle  Arc
- - 7 -

Draw «

3. At the Command line type 2,1 then press [Enter] at the keyboard to locate the first point of
the shape.
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It is necessary to start with an absolute coordinate because there are no previous points
to reference.

4. At the Command line type @7,0 then press [Enter] at the keyboard to locate the next point.
Note that you are drawing counterclockwise from the original point.
5. Atthe Command line type @0,1 then press [Enter] at the keyboard to locate the next point.
6. Atthe Command line type @-2,0 then press [Enter] at the keyboard to locate the next point.
7. Atthe Command line type @-1,1 then press [Enter] at the keyboard to locate the next point.
8. Atthe Command line type @1,1 then press [Enter] at the keyboard to locate the next point.
9. Atthe Command line type @2,0 then press [Enter] at the keyboard to locate the next point.
10. At the Command line type @0,1 then press [Enter] at the keyboard to locate the next point.
11. At the Command line type @-7,0 then press [Enter] at the keyboard to locate the next point.
12. At the Command line type @1,-1 then press [Enter] at the keyboard to locate the next point.
13. At the Command line type @O0,-2 then press [Enter] at the keyboard to locate the next point.
14. At the Command line type @-1,-1 then press [Enter] at the keyboard to locate the last point.
Alternatively, you could use the [Close] option in the Line command.
15. Press [Esc] at the keyboard to end the Line command.

16. Save the drawing.
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2.1.4 Polylines

A polyline is a connected sequence of line segments created as a single object. You can create straight
line segments, arc segments, or a combination of the two.

L1

?Q—ﬂ'

=] |
T

—0

Some reasons you may choose to use polylines include the following:

e Vertices remain joined even after grip editing

e Absolute line width (as an alternative to relative lineweight) that can be constant or tapered
across a segment

e Move and copy a polyline as a unit
e Easily create rectangles and polygons as single objects
e Smart application of non-continuous linetypes across vertices

e Easy extrusion for 3D solids in AutoCAD

Modifying Polylines
Several methods are available to change the shape and appearance of a polyline.

When you select a polyline you can use grips to move, add, or delete individual vertices, and convert
between arc and straight segments.

You can also convert a polyline to a spline-fit or curve-fit polyline.
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‘“=| | Note: You can convert a spline-fit polyline into a B-spline with the Spline command, object option.

Use the PEDIT command to change the width of an individual segment or the entire polyline.

2

= Note: Many of the options for modifying polylines are also on the Properties palette.

Linetypes and Polyline Vertices

For polylines, you can specify whether a linetype pattern is centered on each segment or is continuous
across vertices throughout the entire length of the polyline.

|
]
e e

PLINEGEN =0 PLINEGEN =1

Use the PLINEGEN system variable to specify this option for new objects. You can update existing
polylines on the Properties palette in the Linetype Generation setting.
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Exercise | Working with Polylines

In these exercises you will draw and modify several polylines.
You do the following:

e Draw polylines.

e Switch between lines and arcs within a polyline.
e Modify polyline width.

e Close polylines and arcs.

e Open polylines.

e Explode polylines.

e Join lines and arcs to create polylines.

In this exercise you will create a series of connected lines and arcs using the
Polyline command.

2XR1.25

2.50

START POINT

5.00

1. Open drawing 5.2.1 Drawing Polylines 1.dwg.
This is an empty drawing.

2. Select the fly-out arrow next to the Polar Tracking button and select 90 degree increment
angles.

3. If necessary, select the Polar Tracking button to turn it on.
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4,

5.

Select Ribbon: Home = Draw = Polyline. / = —o.
. —— A

Line] Polyline § Circle  Arc
z = = -

S
Draw -

Select a point in the lower-left corner of the drawing window as the start point. The precise
location of the point is not important.

You will draw counterclockwise around the shape.

The arc previews.

6.

7.

8.

9.

10.

11.

12.

13.

14.

15.

16.

17.

18.

Draw a horizontal line 5 units to the right along the 0 degree Polar Tracking angle.
At the Command line select the [Arc] option.
Move the crosshairs vertically above

the endpoint of the line, along the 90
degree Polar Tracking angle.

At the Command line type 2.5 then
press [Enter] at the keyboard.

At the Command line select the [Line] option.

Draw a horizontal line 2.5 units to the left along the 180 degree Polar Tracking angle.
Draw a vertical line 2.5 units up along the 90 degree Polar Tracking angle.

At the Command line select the [Arc] option.

Move the crosshairs horizontally to the left of the endpoint of the line, along the 180 degree
Polar Tracking angle.

At the Command line type 2.5 then press [Enter] at the keyboard.
At the Command line select the [Line] option.
At the Command line select the [Close] option.

Save the drawing.
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In this exercise you will create Polylines with varying line widths.

1.50 2.00 2.00 !

1.00 3.50 1.00

1. Open drawing 5.2.2 Drawing Polylines 2.dwg.

This is an empty drawing. First you will create the rectangular shape by drawing
polylines.

2. Select the fly-out arrow next to the Polar Tracking button and select 90 degree increment
angles.

3. If necessary, select the Polar Tracking button to turn it on.

4. Select Ribbon: Home = Draw = Polyline. e —
4 el (%

Line} Polyline § Circle  Arc

Draw -

G O

R

5. Click a point in the upper left corner of the drawing window as the start point.

This point will be the upper-left corner of the rectangle. You will draw the rectangle in the
counterclockwise direction.

6. Draw a vertical line 3 units down along the 270 degree Polar Tracking angle.

7. Draw a horizontal line 1.5 units to the right along the 0 degree Polar Tracking angle.
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8.

Draw a vertical line 3 units up along the 90 degree Polar Tracking angle.

9. At the Command line select the [Close] option.

For the next polyline you will adjust the width values.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Select Ribbon: Home = Draw = Polyline. / 1= —o.
i Bl (A

Line} Polyline § Circle  Arc
- - Z -

Draw =

degree Polar Tracking angle, locate the

lower left corner of the new shape 2 units =

to the right of the lower-right corner of the ‘
rectangle.

Using Object Snap Tracking and the 0 | l ‘

At the Command line select the [Width] option.
At the Command line type .1 then press [Enter] at the keyboard to specify the starting width.

Press [Enter] at the keyboard to accept .1 as the ending width.

X Specify starting width <@.8e08>: .1
/& 5w PLINE Specify ending width <8.1866>:

Draw a horizontal line 2 units to the right along the 0 degree Polar Tracking angle.
Draw a vertical line 2 units up along the 90 degree Polar Tracking angle.
At the Command line select the [Arc] option.

Move the crosshairs horizontally to the left of the endpoint of the line along the 180 degree
Polar Tracking angle.

At the Command line type 2 then press [Enter] at the keyboard.
At the Command line select the [Line] option.

At the Command line select the [Close] option.

For the last polyline you will use several polyline width values to create the arrow shapes.

22.

Select Ribbon: Home = Draw = Polyline.

i

-6

Line} Polyline § Circle  Arc

A
oS

]

Draw «
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23. Using Object Snap Tracking and the 270 degree Polar
Tracking angle, locate the left endpoint of the new shape 2
units to below the lower-left corner of the rectangle.

24. At the Command line select the [Width] option.
25. At the Command line type 0 then press [Enter] at the keyboard to specify the starting width.
26. At the Command line type .5 then press [Enter] at the keyboard to specify the ending width.
27. Draw a horizontal line 1 unit to the right <
along the 0 degree Polar Tracking angle.
The first arrowhead shape has been created.
28. At the Command line select the [Width] option.
29. At the Command line type .1 then press [Enter] at the keyboard to specify the starting width.
30. Press [Enter] at the keyboard to accept .1 as the ending width.
31. Draw a horizontal line 3.5 units to the right ‘
along the 0 degree Polar Tracking angle.
The straight segment has been created.
Finally, you will create the last arrowhead shape.
32. At the Command line select the [Width] option.
33. At the Command line type .5 then press [Enter] at the keyboard to specify the starting width.
34. At the Command line type 0 then press [Enter] at the keyboard to specify the ending width.
35. Draw a horizontal line 1 unit to the
right along the 0 degree Polar M
Tracking angle.

36. Press [Esc] at the keyboard to end the Polyline command.

37. Save the drawing.
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In this exercise you will use several options of the Edit Polyline command to
modify existing polylines. You will also use the Join command to convert lines and
arcs into polylines and also to close an arc into a circle.

O N O D

1. Open drawing 5.2.3 Drawing Polylines 3.dwg.

First you will change the width of the lines that make up the hexagon shape.

2. Select Ribbon: Home = Modify = Edit Polyline. 4 Move () Rotate S Trim -
OF Copy b Miror (7 Fillet - ]
[L\ Stretch ] Scale  BS Amay - &
3. Select the hexagon shape.
4. At the Command line select the
[Width] option.
5. At the Command line type .2 then
press [Enter].
6. Press [Esc] at the keyboard to end the Edit Polyline command.
Next, you will complete the triangular shape by using the Close option of the Edit Polyline command.
7. Select Ribbon: Home = Modify = Edit Polyline. & Move () Rotate 3 Trim -
9% Copy A Miror [ Fillet -

m Qv

D_:_ Stretch B Scale 05 Array -

(=] s ]
{1 Madify

8. Select the polyline.

9. At the Command line select the [Close]
option.

10. Press [Esc] at the keyboard to end the Edit Polyline command.
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Next, you use the Open option of the Edit Polyline command to remove the last segment
that was drawn to close the rectangular shape.

11. Select Ribbon: Home = Modify = Edit Polyline. 4 Move () Rotate " Tim - 7
&

OF Copy A\ Mirror (7 Fillet - |5
[[\ Stretch ] Scale 85 Amay - &

=
{1 Modify

12. Select the rectangular polyline.

13. At the Command line select the
[Open] option.

14. Press [Esc] at the keyboard to end the Edit Polyline command.

Next you will use the Explode command to convert the octagon from a single selectable
polyline to eight separate lines.

15. Select Ribbon: Home = Modify = Explode. & Move (, Rotate 3 Trim -
O Copy  Ah Mimor {7 Fillet - 5
D_:_ Stretch m Scale 55 Array - .\;

Modify ~

16. Select the octagonal polyline, then
press [Enter] at the keyboard.

>

17. Select a line segment to confirm that the octagon is now made up of individual lines.

18. Press [Esc] at the keyboard to deselect the line.

Next, the Join command will be used to convert lines and arcs into one selectable
polyline.
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19. Select Ribbon: Home = Modify = Join.

20. Select the two lines and two arcs that
comprise the shape, then press
[Enter] at the keyboard.

4 Move
b Copy
D_:_ Stretch

.
L

N

o

. ey = E) n -
odify

6 Rotate 'ﬂ; Trim -

A Mirror (7 Fillet - |
a Scale 35 Aray -

M Qi

=

2> O B 95
|

21. Select the shape to confirm that it is now one selectable polyline.

22. Press [Esc] at the keyboard to deselect the polyline.

W

C o=

Finally, you will use the close option of the Join command to convert an arc into a circle.

23. Select Ribbon: Home = Modify = Join.

24. Select the arc, then press [Enter] at the
keyboard.

25. At the Command line select the [cLose] option.

26. Press [Esc] at the keyboard to deselect the polyline.

27. Save the drawing.

«+» Move
o3 -
oo Copy

D_:_ Stretch

N
l|

Tq

- .
L

Dn
11 I | [l
el W
odify

6 Rotate ﬂ; Trim -

A Mirror 7 Fillet - |
B Scale G5 Array -

M G

& £ B BB
1

bl

d®
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2.1.5 Circles

To create circles, you can specify various combinations of center, radius, diameter, points on the

circumference, and points on other objects.

You can create circles in several ways. The default method is to specify the center and the radius.

Three other ways to draw a circle are shown in the illustration.

center f/"_\\ | radius
'Elu:liu&—k—ﬁglI OA’J @
N

NN N

l\//h\ﬁ'l ﬁ/’l I//'_'“x\l objects I\/

1U2 1™~ 2

center, radius two points three poinis tangent, tangent,
defining defining radius
diameter circumference

Draw a Circle Tangent to Other Objects

The tangent point is a point where an object touches another object without intersecting it. To create a
circle that is tangent to other objects, select the objects and then specify the radius of the circle. In the

illustrations below, the bold circle is the one being drawn, and points 1 and 2 select the objects to which it

is tangent.
2
Yy l./’ — s
[ 1] 2 1]
N /2
radius of new radiuz of new radius of new
circle = 1 circle = 2 circle = 4

To create a circle tangent at three points, set running object snaps to Tangent and use the three-

point method to create the circle.
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Exercise: Drawing Circles

In these exercises, you will draw circles using several different methods.

You do the following:

Draw circles using the Center, Radius method.
Draw circles using the Center, Diameter method.
Draw circles using the 2-Point method.

Draw circles using the 3-Point method.

Draw circles using the Tan, Tan, Radius method.
Draw circles using the Tan, Tan, Tan method.

In this exercise you will create three circles to complete the drawing of the gasket
as shown below.

R1.00
@0.50 @0.50

1. Open drawing 3.1.1 Drawing Circles 1.dwg.

2. Select Ribbon: Home = Draw = Circle = Center, Radius. — 1 4.
e LN
Line Polylin] Circle li&&re

3. Atthe Command line type 5,3 then press [Enter] at the keyboard to locate the center of the

large circle.
4. Type 1 then press [Enter] at the keyboard to create the circle with a radius of 1.
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5. Select Ribbon: Home = Draw => Circle = Center, : — I
. LN b - = -
Diameter. / —A ¥

Line Palylinf Circle ygtArc
- . i

Draw =

6. Atthe Command line type 3,3 then press [Enter] at the keyboard to locate the center of the
first small circle.

7. Atthe Command line type .5 then then press [Enter] at the keyboard to create the circle with
a diameter of .5.

8. Press [Enter] at the keyboard to repeat the Circle command.

9. Atthe Command line type 7,3 then then press [Enter] at the keyboard to locate the center of
the second small circle.

lx /2 ()~ CIRCLE Specify radius of circle or [Diameter] <0.2500>:

Notice that the Command line is showing the radius value of the previous circle, .25.
10. Press [Enter] at the keyboard to apply the previous radius to the circle.
11. Save the drawing.

In this exercise you will create seven circles to complete the drawing of the gasket.

o
o O

1. Open drawing 3.1.2 Drawing Circles 2.dwg.

2. Draw each circle using the given center, radius, and diameter information in the drawing
below.
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CENTER: 11.75, 3.00

CENTER: 2.75, 3.00
—\ / 22,00 / R2.00 /—

oo O O PN
CENTER: 50@;28 \b Q Q
O
P —Q =0

CENTER: 18.50, 4.50
@0.50

~ 0 QA
CENTER: 5.00, 1.00 \ CENTER: 9.50, 1.00 CENTER: 17.50, .50
©0.80 20.80 @0.50

3. Save the drawing.

In this exercise you will create circles using the 2-Point and 3-Point methods.

1. Open drawing 3.1.3 Drawing Circles 3.dwg.

The drawing consists of a rectangle. Coordinate values are shown in the image below.

1,5 /—5,5 /— 9,5

1,1 \—51

The smaller circle will be created with the 2-Point option.
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2. Select Ribbon: Home = Draw = Circle = 2-Point. /
I‘\_ ‘/I

.
Line Polyling Circle hWgtArc

> [

| -

Draw ~

3. Atthe Command line type 5,1 then press [Enter] at the keyboard to locate the first point on
the circumference of the circle.

4. Atthe Command line type 5,5 then press [Enter] at the keyboard to locate the second point
on the opposite side of the circle.

The larger circle will be created with the 3-Point option.

5. Select Ribbon: Home = Draw = Circle = 3-Point. /
TE Clrcle SArc

> O

Draw -

6. Atthe Command line type 1,1 then press [Enter] at the keyboard to locate the first point on
the circumference of the circle.

7. Atthe Command line type 1,5 then press [Enter] at the keyboard to locate the second point
on the circumference of the circle.

8. Atthe Command line type 9,5 then press [Enter] at the keyboard to locate the third point on
the circumference of the circle.

9. Save the drawing.

In this exercise you will create circles using the Tan, Tan, Radius and Tan, Tan,
Tan methods.

/

N\

1. Open drawing 3.1.4 Drawing Circles 4.dwg.

The drawing consists of a rectangle. The three circles on the left will be created with the
Tan, Tan, Radius option of the Circle command.

The upper left circle will be created first.
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O

2. Select Ribbon: Home = Draw => Circle = Tan, Tan, N
Radius. / . |\_i/

Line Palylinf Circle g Arc

Draw =

3. Select the top line of the rectangle.
4. Select the vertical line on the left side of the rectangle.
5. Atthe Command line type.5 then press [Enter] at the keyboard to create the circle.

Next the circle on the lower left will be created.

6. Select Ribbon: Home = Draw = Circle = Tan, Tan, - —
Radius. / A7

Line Palylin

|

N

Arc
.

7. Select the bottom line of the rectangle.
8. Select the vertical line on the left side of the rectangle.
9. Atthe Command line type.5 then press [Enter] at the keyboard to create the circle.

Next you will draw a circle that is tangent to the two circles that were just created.

10. Select Ribbon: Home = Draw = Circle = Tan, Tan, 1
Radius. / ) |\

Line Polylinf Circle kg Arc
v

Y
[

11. Select the right half of one of the two circles that were just created.
12. Select the right half of the other circle that was just created.
13. At the Command line type 1.5 then press [Enter] at the keyboard to create the circle.

Note that the radius value must make sense. A much smaller circle, such as one with a
radius of .5, would be impossible to create because it could not be tangent to both circles
and retain the small radius.

Next you will create a circle using the Tan, Tan, Tan option.

14. Select Ribbon: Home = Draw = Circle = Tan, Tan, Tan.

SO

> [

Line Polyling Circle g Arc
- -

Draw

15. Select the top line of the rectangle.

16. Select the vertical line on the right side of the rectangle.
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17. Select the bottom line of the rectangle.

18. Save the drawing.
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2.1.6 Arcs

Create arcs by specifying various combinations of center, endpoint, start point, radius, angle, chord
length, and direction values.

Arcs are drawn in a counterclockwise direction by default. Hold down the Ctrl key as you drag to
draw in a clockwise direction.

Draw Arcs by Specifying Three Points

You can create an arc by specifying three points. In the following example, the start point of the arc snaps
to the endpoint of a line. The second point of the arc snaps to the middle circle in the illustration.

—endpoint of line

F:
2009
1‘/ N

Click Home tab > Draw panel > Arc drop-down > 3-Point.

Yy

Draw Arcs by Specifying Start, Center, End

You can create an arc using a start point, center, and a third point that determines the endpoint.

The distance between the start point and the center determines the radius. The endpoint is determined by
a line from the center that passes through the third point.

Using different options, you can specify either the start point first or the center point first.

S Vakt
H:F_; , <<
S <)

I
3 2
start{1), center(2), center{1), start{2),
end{3) end(3)

Click Home tab > Draw panel > Arc drop-down > Start, Center, End.
Click Home tab > Draw panel > Arc drop-down > Center, Start, End.
Draw Arcs by Specifying Start, Center, Angle

You can create an arc using a start point, center, and an included angle.

The distance between the start point and the center determines the radius. The other end of the arc is
determined by specifying an included angle that uses the center of the arc as the vertex.

Using different options, you can specify either the start point first or the center point first.
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m-c:lnur::h&u::lJ
angle

The included angle determines the endpoint of the arc. Use the Start, End, Angle method when you know
both endpoints but cannot snap to a center point.

start, center, angle center, start, angle start, end, angle

Click Home tab > Draw panel > Arc drop-down > Start, Center, Angle.
Click Home tab > Draw panel > Arc drop-down > Center, Start, Angle.
Click Home tab > Draw panel > Arc drop-down > Start, End, Angle.

Draw Arcs by Specifying Start, Center, Length
You can create an arc using a start point, center, and the length of a chord.

The distance between the start point and the center determines the radius. The other end of the arc is
determined by specifying the length of a chord between the start point and the endpoint of the arc.

Using different options, you can specify either the start point first or the center point first.

chord length
1 1 .
f/:l‘i\a f}f\r";\ NV
! -~ _h"-u\\..' I \_ _/,' \

v / / . x
"._ I_.l I

I"'. s ,-"l / A\“* /r" \
Y = L2 [ - "

L1 /

\\E:i/ 2

chord length
start, center, length center, start, length

The length of the chord of the arc determines the included angle.
Click Home tab > Draw panel > Arc drop-down > Start, Center, Length.

Click Home tab > Draw panel > Arc drop-down > Center, Start, Length.
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Draw Arcs by Specifying Start, End, Angle

You can create an arc using a start point, endpoint, and an included angle.

The included angle between the endpoints of the arc determines the center and the radius of the arc.
Click Home tab > Draw panel > Arc drop-down > Start, End, Angle.

Draw Arcs by Specifying Start, End, Direction

You can create an arc using a start point, endpoint, and a tangent direction at the start point.

The tangent direction can be specified either by locating a point on the desired tangent line, or by entering
an angle. You can determine which endpoint controls the tangent by changing the order in which you specify
the two endpoints.

Draw Arcs by Specifying Start, End, Radius
You can create an arc using a start point, endpoint, and a radius.

The direction of the bulge of the arc is determined by the order in which you specify its endpoints. You can
specify the radius either by entering it or by specifying a point at the desired radius distance.

N

radius A H'-..l

\ ﬁ I
- . LU f__,l..é----- a

1
1 irection

start, end, radius start, end, direction
Click Home tab > Draw panel > Arc drop-down > Start, End, Radius.
Click Home tab > Draw panel > Arc drop-down > Start, End, Direction.

Draw Contiguous Tangent Arcs and Lines

Immediately after you create an arc, you can start a line that is tangent to the arc at an endpoint. You need
to specify only the line length.

arc endpoint //ﬂ

/’ L resulting line

Immediately after you create a line or an arc, you can start an arc that is tangent at an endpoint by starting
the ARC command and pressing Enter at the Specify Start Point prompt. You need to specify only the
endpoint of the new arc.
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Exercise: Drawing Arcs

In these exercises you will draw arcs using several different methods.
You do the following:

e Draw arcs using the Start, End, Radius method.
e Draw arcs using the Start, Center, End method.
e Draw arcs using the Start, End, Direction method.

In this exercise you will create arcs using the Start, End, Radius and Start, Center,
End methods.

2X R2.50

1. Open drawing 5.1.1 Drawing Arcs 1.dwg.
2. Set Endpoint and Midpoint as Running Object Snaps.

First you will create the large arc on the left side of the part.

3. Select Ribbon: Home = Draw = Arc = Start, End,

e I .
Radius. / —) A N

Line Polyline Circll  Arc
- -

Draw =

4. Select the start point and end point as
shown. ‘
5. Atthe Command line type 2.5 then press
[Enter] at the keyboard to create the arc
with a radius of 2.5.

-
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Next you will create the large arc on the right side of the part.

6. Select Ribbon: Home = Draw = Arc = Start, End,

Radius. / —) Y N

Line Polyline Circll  Arc

Draw

Pressing [Enter] at the keyboard to repeat the last
command will begin the 3 Point arc, so you must —
choose the specific Arc command instead.

7. Select the start point and end point as —
shown.

8. Atthe Command line type 2.5 then press [Enter] at the keyboard to create the arc with a
radius of 2.5.

Next you will create the arc on the left side of the upper rectangle.

9. Select Ribbon: Home = Draw = Arc = Start, Center, End. / .
S— U

Line Polyline Circlg
-

Draw

10. Select the start point, center point, and end point as shown below:

Center Point »

W

The arc draws in the counterclockwise direction.
11. Select the vertical line.

12. Press [Delete] at the keyboard to erase the vertical line.
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Next you will create the arc on the right side of the upper rectangle.

13. Select Ribbon: Home = Draw = Arc = Start, Center, End.

./ ) ( :;/\ /

Line Polyline Circle  Arc

Draw =

14. Select the start point, center point, and end point as shown below:

Center Point »

i

The arc draws in the counterclockwise direction.

15. Erase the vertical line.

16. Repeat the process to create the arcs on the lower
rectangle, erasing the vertical lines when complete. ( )

17. Save the drawing.

In this exercise you will create arcs using the Start, End, Direction method.

90°

~.
N\,

1. Open drawing 5.1.2 Drawing Arcs 2.dwg.
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2. Set Endpoint as a Running Object Snap.

First you will create the 90 degree arc on the first square.

3. Select Ribbon: Home = Draw = Arc = Start, End,

Direction. D (7

Line Polyline Circldl  Arc

Draw =

4. Select the upper left corner of the rectangle as the start point.
5. Select the upper right corner of the rectangle as the end point.

6. Select the endpoint of the dashed line to specify a 90 degree direction angle.

[
|
End Point

The arc is created. Note that the arc drew in the clockwise direction. While using the
Start, End, Direction method arcs can be drawn either clockwise or counterclockwise
depending on the points selected.

Next you will create the 60 degree arc on the second square.

7. Select Ribbon: Home = Draw = Arc = Start, End,

Direction. D (A

Line Polyline Circldl  Arc

Draw =

8. Select the upper left corner of the rectangle as the start point.
9. Select the upper right corner of the rectangle as the end point.

10. Select the endpoint of the dashed line to specify a 60 degree direction angle.
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Start Point / ! - l /
art Foin / End Point /

>

Next you will create the 45 degree arc on the third square.

11. Select Ribbon: Home = Draw = Arc = Start, End,

C T,
Direction. / —d QY

Line Polyline Circldl  Arc

Draw =

12. Select the upper left corner of the rectangle as the start point.
13. Select the upper right corner of the rectangle as the end point.

14. Select the endpoint of the dashed line to specify a 45 degree direction angle.

End Point

9
v

Finally you will create the 30 degree arc on the fourth square.

15. Select Ribbon: Home = Draw = Arc = Start, End,

Direction. . / o) I( 7 e

[n|

Line Polyline Circll  Arc

Draw «

16. Select the upper left corner of the rectangle as the start point.
17. Select the upper right corner of the rectangle as the end point.

18. Select the endpoint of the dashed line to specify a 30 degree direction angle.

MDT Internal Use Only 83



101 — AutoCAD Fundamentals for Microstation Users User Guide

/’ ,/
- End Pomt -
v

19. Save the drawing.
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2.1.7 Object Snaps

Object snaps provide a way to specify precise locations on objects whenever you are prompted for a
point within a command.

For example, you can use object snaps to create a line from the center of a circle to the midpoint of
another line.

You can specify an object snap whenever you are prompted for a point. By default, a marker and a tooltip
are displayed when you move the cursor over an object snap location on an object. This feature, called
AutoSnap, provides visual confirmation that indicates which object snap is in effect.

Specify an Object Snap

To specify an object snap at a prompt for a point, you can do one of the following:
e Press Shift and right-click to display the Object Snap shortcut menu
e Right-click and choose an object snap from the Snap Overrides submenu
e Click an object snap button on the Object Snap toolbar

e Enter the name of an object snap

When you specify an object snap at a prompt for a point, the object snap stays in effect only for the next
point that you specify. Object snaps work only when you are prompted for a point.

%=/ | Note: If you want object snaps to ignore hatch objects, use the OSOPTIONS system variable.

Use Running Object Snaps
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If you need to use one or more object snaps repeatedly, you can turn on running object snaps, which persist
through all subsequent commands. For example, you might set Endpoint, Midpoint, and Center as running
object snaps.

e On the status bar, click the Object Snap button or press F3 to turn running object snaps on
and off.

e On the status bar, click the down-arrow next to the Object Snap button, and then click the
object snaps that you want to persist.

v I:,---"":I Endpoint
& Midpoint
v (=) Center
[o] Geometric Center

o Mode

Fe 9
4_F Quadrant

v F Intersection
» —- Extension
&4 Insertion
_L Perpendicular
-Ej Tangent
_,..-':'; Mearest

Apparent Intersection

Object Snap Settings...

]~

. Tip: If several running object snaps are turned on, more than one object snap may be eligible at
=l a given location. You can press Tab to cycle through the possibilities before you specify the
point.

When you specify an object snap, the cursor snaps to the specified point on an object closest to the center
of the cursor. By default, a marker and a tooltip are displayed when you move the cursor over the object
shap location on an object.
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Specify a Single Object Snap
If you specify a single object snap, it stays in effect only for the next point you specify.
You can specify an object snap with any of the following methods:

e Enter a object snap by typing its name. To see a list of valid object snaps, refer to the
OSNAP command or the Drafting Settings Dialog Box.

e Click an object snap from the Object Snap toolbar.

e Click an object snap from the Object Snap shortcut menu. You can display this shortcut
menu by pressing SHIFT while you right-click.
Use Running Object Snaps

Using the OSNAP or DSETTINGS commands, you can specify a set of running object snaps. Running
object snaps are one or more object snaps that remain in effect as you work.
e To turn running object snaps on and off, click the Object Snap button on the status bar or
press F3.

e Press TAB to cycle through the object snap possibilities before you specify the point.

e To turn off running object snaps for the next point only, specify the None object snap.
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Exercises: Object Snaps

In these exercises you will draw with several different object snaps. You will work with
Running Object Snaps as well as object snap overrides.

You do the following:

Set running object snaps.
Draw objects while snapping onto existing geometry.
Use object snap overrides.

In this exercise you will use Endpoint, Midpoint, and Quadrant object snaps to
complete the windows of a house.

O D
| __ s

1. Open drawing 4.1.1 Object Snaps 1.dwg.

You will begin by setting Endpoint, Midpoint, and Quadrant as Running Object Snaps.

2. Select Status Bar: Object Snap (if necessary to turn on Running v ./ Endpoint
Object Snaps). v 7 Midpoint

':::' Center

3. Select Status Bar: Object Snap fly-out = Endpoint (unless

[5] Geometric Center
already selected).

Node

4. Select Status Bar: Object Snap fly-out = Midpoint (unless A

already selected).

. .
. Intersection
—-- Extension

3 Insertion

5. Select Status Bar: Object Snap fly-out = Quadrant (unless

already selected). -4 Perpendicular
A7) Tangent
6. Disable all other Running Object Snaps. #a Nearest
; \ Apparent Intersection
7. Click in the drawing window to close the Object Snap flyout. // Parallel
Object Snap Settings...

88
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Next you will finish the round window.
8. Select Ribbon: Home = Draw = Line.

9. Select the left-side quadrant of
the circle to place the first point.

10. Select the right-side quadrant » U

of the circle to create the
horizontal line.

11. Press [Esc] at the keyboard to
end the Line command.

12. Select Ribbon: Home =

; V(A
Draw = Line. / “)

— \J

olyline Circle  Arc

B

Draw =

13. Select the top quadrant of the
circle to place the first point.

14. Select the bottom quadrant of /- \
the circle to create the vertical \ /
line.

15. Press [Esc] at the keyboard to
end the Line command.

Next you will complete the window located in the door.

16. Select Ribbon: Home = Draw = Line.

)] I/:}\I -/--. .I__l T
— N/
olyline  Circle  Arc

El R

Draw -

17. Select the top endpoint of the
vertical line on the left.

18. Select the top endpoint of the | | » | ‘

imm]|
LA
Im |
L

vertical line on the right.

19. Press [Esc] at the keyboard to end
the Line command.

The top horizontal line has been created.
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20. Select Ribbon: Home = Draw = Line.

] I/-';\I -/--. .I__|' T
—

olyline Circle  Arc
- -

] -

Draw -

21. Select the bottom endpoint of the

vertical line on the left. '

22. Select the bottom endpoint of the
vertical line on the right.

1
L
[ ml
L

23. Press [Esc] at the keyboard to end
the Line command.

The bottom horizontal line has been created.

24. Select Ribbon: Home = Draw = Line. — ..
[ - = =

____.-' \_ Y,

olyline  Circle  Arc

E R

Draw ~

25. Select the midpoint of the vertical
line on the left.

26. Select the midpoint of the vertical yi b » ya iy

line on the right.

27. Press [Esc] at the keyboard to end
the Line command.

The middle horizontal line has been created.

28. Select Ribbon: Home = Draw = Line.

| |/:}\ | e (R
— N/

olyline  Circle  Arc

Draw ~

29. Select the midpoint of the top
horizontal line.

[any
30. Select the midpoint of the bottom ‘

vertical line. -

31. Press [Esc] at the keyboard to end
the Line command.

The middle vertical line has been created.
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32. Repeat the process to create the
larger window.

33. Save the drawing. »

In this exercise you will use Center and Tangent object snaps to complete the
drawing of a pulley system.

2X 24.00

6.00
1. Open drawing 4.1.2 Object Snaps 2.dwg.
This drawing contains three circles representing the centers of the pullies.
You will begin by setting Center as a Running Object Snap.
2. Select Status Bar: Object Snap fly-out = Center (unless already selected).
3. Disable all other Running Object Snaps.

4. Click in the drawing window to close the Object Snap fly-out.

Next you will create the (/6.00 circle.

5. Select Ribbon: Home = Draw = Circle = Center, — 11—
Diameter. / S BN

Line Polylin CircleR Arc
. - 7.

Draw =

6. Select the lowest of the three circles to snap its center.

7. At the Command line type 6 then press [Enter] at the keyboard to create a circle with (/6.00.
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8. Select Ribbon: Home = Draw = Circle = Center, : = e

. -~ 7 L O-
Diameter. = LN d

Line Palylinf Circle ygtArc =

Draw =

9. Select the left-most circle to snap its center.
10. At the Command line type 4 then press [Enter] at the keyboard to create a circle with ¢/4.00.

11. Repeat the process to create the final /4.00 circle.

Next you will create the tangent lines
12. Select Status Bar: Object Snap fly-out = Center (to disable it).
13. Select Status Bar: Object Snap fly-out = Tangent (to enable it).
14. Click in the drawing window to close the Object Snap fly-out.

Because Center and Tangent both deal with circles, it can sometimes be difficult to work
with both object snaps at the same time. Center usually takes precedence over Tangent;
turning off the Center snap will allow the Tangent snap to work more effectively.

15. Select Ribbon: Home = Draw => Line.

\ (A O

— A/

olyline Circle  Arc
" . 7l -

Draw -

16. Select the top half of the upper-left circle.

92 MDT Internal Use Only



User Guide Chapter 2 | Drawing and Editing Tools

17. Select the top half of the upper-right circle.

18. Press [Esc] at the keyboard to end the Line command.

19. Repeat the process to create the remaining two tangent lines.

20. Save the drawing.
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In this exercise you will use Node and Perpendicular object snaps to add skylights
to the roof of a house.

NN

1. Open drawing 4.1.3 Object Snaps 3.dwg.
You will begin by setting Node and Perpendicular as Running Object Snaps.
2. Select Status Bar: Object Snap Fly-out = Node (unless already selected).
3. Select Status Bar: Object Snap Fly-out = Perpendicular (unless already selected).
4. Disable all other Running Object Snaps.
5. Click in the drawing window to close the Object Snap fly-out.

6. Zoom in to the two points on the left side of the roof.

7. Select Ribbon: Home = Draw = Line.

I/ }\I .f'/--. -
) . +
— A\
olyline  Circle  Arc

ElR

Draw ~

8. Select the lower point.

9. Select the roof line.

—>

10. Press [Esc] at the keyboard to end the Line command.

A line is drawn from the point to the perpendicular location on the roof line.
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11. Repeat the process to create a line from the other
point to the roof.

12. Select Ribbon: Home = Draw = Line.

13. Select each of the points to draw the line that
completes the skylight.

14. Press [Esc] at the keyboard to end the Line command.
15. Repeat the process to create the

skylight on the right side of the
house.

16. Freeze the Points layer.
The points are hidden.

17. Save the drawing.

— \J

olyline Circle  Arc
" .

Draw -

TNl =T

Bl
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In this exercise you will use Intersection and Geometric Center object snaps to

complete the drawing.

O O -

1. Open drawing 4.1.4 Object Snaps 4.dwg.

You will begin by setting Intersection and Geometric Center as

O

© O

O

O

Running Object Snaps.

2. Select Status Bar: Object Snap Fly-out = Intersection (unless already selected).

3. Select Status Bar: Object Snap Fly-out = Geometric Center (unless already selected).

4. Disable all other Running Object Snaps.

5. Click in the drawing window to close the Object Snap fly-out.

Next you will create four circles with a diameter of 1 at each co

6. Select Ribbon: Home = Draw = Circle = Center,

Diameter.

7. Select the intersection of the two magenta colored

nstruction line intersection.

/ S N Ea=N
e ,

Line Palylinf Circle pygArc
- -

Draw =

construction lines in the upper left corner

~

of the plate.
> | (
-

/

8. At the Command line type 1, then press [Enter] at
diameter of 1.

the keyboard to create the circle with a

9. Repeat the process to create a circle of the same size at the other three intersections.

10. Select the four construction lines.

96
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11. Press [Delete] at the keyboard to erase the four construction lines.

Next you will create the circles located at the geometric centers of the hexagons.

12. Select Ribbon: Home = Draw = Circle = Center, : — .

. == . u [
Diameter. /D YN §

Line Polyling Circle g Arc

Draw

13. Select the edge of one of the hexagons.

-

The center of the circle snaps to the geometric center of the hexagon.

14. At the Command line type 1.5, then press [Enter] at the keyboard to create the circle with a
diameter of 1.5.

15. Repeat the process to create a circle of the same size at the geometric center of the other
hexagon.

16. Press [Esc] at the keyboard to end the Circle command.
17. Save the drawing.

In this exercise you will use the Perpendicular Object Snap Override to complete
the pipe drawing.

o -
Pa—

1. Open drawing 4.1.5 Object Snaps 5.dwg.

Y

SWe

You will begin by setting Endpoint and Perpendicular as Running Object Snaps.
2. Select Status Bar: Object Snap Fly-out = Endpoint (unless already selected).
3. Select Status Bar: Object Snap Fly-out = Perpendicular (unless already selected).
4. Disable all other Running Object Snaps.

5. Click in the drawing window to close the Object Snap fly-out.

MDT Internal Use Only 97



98

101 — AutoCAD Fundamentals for Microstation Users

User Guide

Next you will connect the two pipes on the left.

6. Select Ribbon: Home = Draw = Line.

7. Select the upper-left endpoint of the
bottom horizontal pipe.

] I/ :/:\I
D )

olyline Circle  Arc

Draw ~
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8. Move the crosshairs to the pipe above and to the left.

PERPENDICULAR ENDPOINT

The perpendicular and endpoint object snaps are very close to each other, making it easy
to pick the incorrect point. You will use the Perpendicular object snap override to ensure
that the correct point is placed.

9. Hold [Shift] at the keyboard, then right-click the mouse. ) Tangent

_I_ Perpendicular

10. Select the Perpendicular object snap override. ' Parallel k

Node

Move the crosshairs over several objects on-screen. Notice that the endpoint object snap
is not available, only perpendicular is available.

11. Select the line that it needs to be perpendicular \
to, as shown.
N
Notice that you do not have to click at the exact location of
perpendicularity. This is another advantage of Object Snap
Overrides. Click anywhere on the line that you wish to be
perpendicular to and AutoCAD will calculate the

perpendicular location, even if it does not intersect. \

12. Repeat the steps to draw the bottom line of the pipe as well as the pipe on the opposite side.

13. Save the drawing.
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Section 2 | Editing Geometry

2.2.1 Object Selection
Selecting Objects Individually

At the Select Objects prompt, you can select one or more objects individually.

Use the Pickbox Cursor

When the square pickbox cursor is in position to select an object, the object is highlighted. Click to select
the object.

Select Objects Close Together

It is difficult to select objects that are close together or lie directly on top of one another. The example shows
two lines and a circle that lie within the pickbox.

Iy I
l\_ﬂfl: ':":\' - |

first selected object second selected object third selected object

If selection preview is turned on, you can cycle through the objects by rolling over the object on top to
highlight it and pressing and holding Shift and then pressing Spacebar continuously. When the required
object is highlighted, left click to select it.

If selection preview is turned off, hold down Shift+Spacebar and click to cycle through these objects, one
after the other, until the one you want is selected. Press Esc to turn off cycling.

Remove Selection from Objects

Remove objects from the current selection set by holding down Shift and selecting them again.

Selecting Multiple Objects

At the Select Objects prompt, you can select many objects at the same time.

Specify a Rectangular Selection Area

Specify opposite corners to define a rectangular area. The background inside the area changes color and
becomes transparent. The direction that you drag your cursor from the first point to the opposite corner
determines which objects are selected.

e Window selection. Drag your cursor from left to right to select only objects that are entirely
enclosed by the rectangular area.

e Crossing selection. Drag your cursor from right to left to select objects that the rectangular
window encloses or crosses.
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objects selected uging crossing selection box

With a window selection, usually the entire object must be contained in the rectangular selection area.
However, if an object with a noncontinuous (dashed) linetype is only partially visible in the viewport and all
the visible vectors of the linetype can be enclosed within the selection window, the entire object is selected.

Specify an Irregularly Shaped Selection Area

Specify points to define an irregularly shaped area. Use window polygon selection to select objects entirely
enclosed by the selection area. Use crossing polygon selection to select objects enclosed or crossed by
the selection area.

T ]

+ o

window polygon result

Specify a Selection Fence

In a complex drawing, use a selection fence. A selection fence looks like a polyline and selects only the
objects it passes through. The circuit board illustration shows a fence selecting several components.

D%%

10

fence selection selected objects highlighted

Sk= s
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Use Other Selection Options

You can see all selection options by entering ? at the Select Objects prompt. For a description of each of
the selection options, see the SELECT command.

Remove Selection from Multiple Objects

You can enter r (Remove) at the Select Objects prompt and use any selection option to remove objects
from the selection set. If you are using the Remove option and want to return to adding objects to the
selection set, enter a (Add).

You can also remove objects from the current selection set by holding down Shift and selecting them again,
or by holding down Shift and then clicking and dragging window or crossing selections. You can add and
remove objects repeatedly from the selection set.
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Exercise: Selection Techniques

In this exercise you will utilize several different techniques to select and delete objects.
You do the following:

e Select objects using the Pick method.

e Select objects using the Window method.
e Select objects using the Crossing Method.
e Select objects using the Lasso tool.

e Remove objects from a selection set.

In this exercise you will practice using the pick, window, crossing, and lasso selection techniques.
14. Open drawing 1.4.1 Selecting Objects.dwg.
15. Zoom in to box #1.

First you will use the Pick method to select and delete the red circles.

OO000O0 @ O O O ¢

000
OO0 O »
000

=

0000
0000
OO0
0000
OO00O0O0
O00O00O
OO0

16. Select each of the four red circles.
17. Press [Delete] at the keyboard to erase the circles.
18. Pan to box #2

Next you will use the Window method to select and delete the red circles.

O ©

= =

O ©

19. Select the two circles by using the Window selection method. Pick the first point, then move
up or down and to the right to create the Window, then pick the second point.

20. Press [Delete] at the keyboard to erase the circles.

21. Pan to box #3
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Next you will use the Crossing method to select and delete the red lines.

O O O

= Ic

O O O

22. Select the three red lines by using the Crossing selection method. Pick the first point, then
move up or down and to the left to create the Crossing, then pick the second point.

23. Press [Delete] at the keyboard to erase the lines.
24. Pan to box #4

Next you remove an object from a selection set.

33
O ¢© » O
g@@-

>
O00O0O0 & 6
00000 WP |66
00000 & 6
00000

25. Using the Crossing or Window method select all of the circles.

26. While holding [Shift] at the keyboard, select the circle in the center to remove it from the
selection set.

Make sure to select the circle rather than one of the grips.
27. Press [Delete] at the keyboard to erase the circles.
28. Pan to box #5

Finally, you will use the Lasso selection tool.

29. Select the red circles by using the Lasso selection tool. Click and drag around the red circles
in the clockwise direction.

30. Press [Delete] at the keyboard to erase the circles.
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31. Save the drawing.

2.2.2 Object Properties

Object properties control the appearance and behavior of objects and are used to organize a drawing.

Every object has general properties including its layer, color, linetype, linetype scale, lineweight,
transparency, and plot style. In addition, objects have properties that are specific to their type. For example,
the special properties of a circle include its radius and area.

When you specify the current properties in a drawing, all newly created objects use those settings
automatically. For example, if you set the current layer to Dimensions, the objects that you create will be
on the Dimensions layer.

Mo selection

H

General

Color ByLayer

Layer Dimensicn -
ByLayer
1.0000 .

Lineweight

Transparency Bylayer

You can set some properties of an object either by layer (ByLayer), or by specifying the property explicitly,
independent of its layer.

You can choose between several tools that control object properties depending on the work that you're
doing.

Using the Properties Palette

The Properties palette provides the most complete list of all property settings.

e |f no objects are selected, you can view and change the current properties to be used for all
new objects.

e |f asingle object is selected, you can view and change the properties for that object.

e |f several objects are selected, you can view and change their common properties.
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Mo selection

General

ByLayer

Lineweight — Bylayer

Transparency

3D Visualization

Material

Plot style

Plot style table

Plot table attached...
Plot table type

Width

Misc

LICS Mame

fin|

Using the Quick Properties Palette

Generally, you can double-click an object to open the Quick Properties palette, and make changes to its
properties.
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Notes

e Several types of objects open an editor or start an object-specific command when you
double-click them instead of the Quick Properties palette. These types of objects include
blocks, polylines, splines, and text.

e The Customize User Interface dialog box ( CUI) controls what palette or command is used
when you double-click each type of object.

Using the Properties Panel on the Ribbon

On the Home tab of the ribbon, use the Layers and Properties panels to verify or change the settings for
the most commonly accessed properties: layer, color, lineweight, and linetype.

I__ | - B elayer -
‘/:”:_ 5«;, & % Make Current ByLayer -
£ &, £ . & Match Layer ByLayer -

Layers = Properties = 4

If no objects are selected, the drop-down lists highlighted above display the current settings for the drawing.
If you select an object, the drop-down lists display the property settings for that object.
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Exercise: Viewing and Modifying Object
Properties

In this exercise you will use Properties tools to gain information from a drawing, including
distance, XY coordinates, and radius. You will also use Properties tools to modify
drawing objects.

| 7
o

| .
|

TOP VIEW

FRONT VIEW
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1. Open drawing 8.2.1 Properties.dwg.

First you will use the List command to find the length of a line.

2. Select Ribbon: Home = Properties Fly-out = List. Ij @ N oy -
iy =
= Bylayer -
Match
Properties == Bylayer -
= =  Transparency 0
[Rp List
1 Properties N
3. Select the line shown: | . |
PN ol BN
Press [Enter] at the keyboard. . N | | VAR
\\\ ,.-/’I‘ L ! \ L /';
The AutoCAD Text Window appears, displaying / P “l\ |
information about the line. [ [ \ | | <
1..‘ "\.\ ) :..“
) RSy
N RN s 4
‘ | ;

What is the length of the line?
a. 2.30 c. 3.30
b. 3.25 d. 2.35

4. Press [F2] at the keyboard to hide the Text Window.

Next you will use the List command to find the radius and center point of a circle.

5. Select Ribbon: Home = Properties Fly-out = List.

@ B Bylayer

T —
— ByLayer
Match T
Properties == ByLayer

£+ ~ Transparency

[Fy List

11 Properties
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6. Select the circle shown:

7. Press [Enter] at the keyboard.

The AutoCAD Text Window appears, displaying
information about the circle.

What is the radius of the circle?
a. 0.50 c. 0.70

b. 0.60 d.0.75

What are the X,Y coordinates of the center of the circle?
a. 4.25,4.75 c. 5.00, 4.00
b. 5.75, 6.00 d. 4.75, 3.25
8. Press [F2] at the keyboard to hide the Text Window.

Next you will use the Properties palette to change the location of a circle.

9. Select Ribbon: View = Palettes = Properties.

The Properties palette opens.

10. Select the circle shown: — A — + 4

The circle is not located Geometry -
correctly. Center X 2.96
Center ¥ 4,96

You will modify the X,Y coordinate values.

11. Change the Center X value to 4.
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12. Change the Center Y value to 5.

13. Press [Esc] at the keyboard to deselect the circle.

Next you will use the Properties palette to modify four circles simultaneously.

14. Select the four circles as shown:

The circles were drawn with a radius of .3, but the design
calls for a diameter of .3. This is a common drawing
mistake.

X

/

A

a
v

-/

S

15. Change the Diameter value to .3. Geometry -
Center X VARIES*
16. Press [Esc] at the keyboard to deselect the Center Y R
circles Center Z 0.00
. Radius 0.15
Diameter 0.30 &
The creator of this drawing made a mistake and drew all hidden features in the Phantom
layer, rather than the Hidden layer. You will use Quick Select and Properties to correct
this problem.
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17. Select the Quick Select button, located in the

top-right corner of the Properties palette. +
-
ByLayer

The Quick Select dialog box opens. A Quick Select %

18. Set Properties: to Layer. poplyto: | Ente craming o [+

Obj + | Muttipl w
19. Set Value: to Phantom. jecrtpe: B2
Properties:

20. Click <<OK>>.

All of the phantom lines are selected.

21. In the Properties palette, change the Layer to
Hidden.

22. Press [Esc] at the keyboard to deselect the
hidden objects.

Operator:

Walue:

How to apply:

Linetype scale
Plat style
Lineweight
Trangparency
Hyperink

= Equals

Phantom

(® Include in new selection set

(0 Exclude from new selection set

[ Append to cument selection set

Cancel Help

X

b |Line(12) - N o

] General =
Color I Bylayer
Layer Hidden -
Linetype ~  ==eeeeeeeeees ByLak
L I 0sn

Finally, you will use the Match Properties tool to update the drawing view labels to match.

23. Select Ribbon: Home = Properties = Match

Properties.

First you select the object with the desired properties.
24. Select the TOP VIEW label.
Next you select the objects to apply the properties.

25. Select the FRONT VIEW label

Il Bylayer -
Bylayer -
Bylayer -
Properties = 3
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Both labels are now formatted identically.
26. Press [Esc] at the keyboard to end the Match Properties command.

27. Save the drawing.
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2.2.2 Move Drawing Objects

The Move command moves objects a specified distance in a specified direction.

<

You can move objects at a specified distance and direction from the originals.
Use coordinates, grid snap, object snaps, and other tools to move objects with precision.

Specify Distance with Two Points

Move an object using the distance and direction specified by a base point followed by a second point. In
this example, you move the block representing a window. Select the object to be moved (1). Specify the
base point for the move (2) followed by a second point (3). The object is moved the distance and direction
of point 2 to point 3.

| o |
i m—

Use a Stretch-Move

You can also use STRETCH to move objects if all their endpoints lie entirely within the selection window.
Turn on Ortho mode or polar tracking to move the objects at a specific angle.

A practical example is moving a door in a wall. The door in the illustration is entirely within a crossing
selection, while the wall lines are only partly within the crossing selection area.

: |3]:=||
A

objects selected with door moved with result
crossing selection Ortho mode on and
direct distance entry

i b

The result is that only the endpoints that lie within the crossing selection move.
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Drag, Grip-Edit, or Nudge Objects
Move selected objects quickly by dragging, grip-editing, or nudging.

Drag objects within a drawing, or between open drawings and other applications. Dragging with the right
button on the pointing device allows you to specify whether to move, copy, or create a block from the
dragged objects. Dragging disregards all snap settings.

To nudge selected objects in orthogonal increments, press Ctrl + arrow keys. Snap mode affects the
distance and direction in which the objects are nudged.

e Nudge objects with Snap mode turned off: Objects move two pixels at a time; movement
is relative and orthogonal to the screen, regardless of the view direction or the UCS
orientation.

e Nudge objects with Snap mode turned on: Objects are moved in increments specified by
the current snap spacing; movement is orthogonal to the X and Y axes of the current UCS
and relative to the view direction.

Use coordinates, grid snaps, object snaps, and other tools to move objects with precision.

3

The following prompts are displayed.

Select objects

Specifies which objects to move.

Base point

Specifies the start point for the move.

Second point

In combination with the first point, specifies a vector that indicates how far, and in what direction,
the selected objects are moved.

If you press Enter to accept the Use first point as displacement value, the first point is interpreted
as arelative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter
at the next prompt, the objects move 2 units in the X direction and 3 units in the Y direction from
their current position.

Using a Specific Coordinate
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e If dynamic input is on: Type the pound sign (#) followed by the X-value, a comma,
then the Y-value, for example #4.0,6.75.

e If dynamic input is off: Type the X value, a comma, then the Y value, for example
4.0,6.75.

< Note: When dynamic input is on, relative coordinates are the default. When dynamic input is off,
=] | absolute coordinates are the default. Press F12 to turn dynamic input on or off.

Using a Relative Coordinate
A relative coordinate specifies the distance and direction from the previous coordinate.

e If dynamic input is on: Type the X-value, a comma, then the Y-value, for example
4.0,6.75.

e If dynamic input is off: Type the at sign (@) followed by the X-value, a comma, then
the Y-value, for example @4.0,6.75.

Displacement
Specifies a relative distance and direction.

The two points you specify define a vector that indicates how far from the original the copied objects
are to be placed and in what direction.
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Exercise: Moving Drawing Objects

In this exercise you will use the move command to relocate several incorrectly placed
holes.

You do the following:

e Start the Move command.

e Select objects.

e Specify base points.

e Specify a new location by typing a distance.

e Specify a new location by snapping to existing geometry.

—=1.00 k ﬂ 1.00 = — k 0.50 0.50 ——‘

5 0 5 10

o L— T 0o o L—_ T o

1. Open drawing 6.1.1 Moving Objects 1.dwg.

The circular holes should be .5 units away from each side. Each hole will need to be
moved .5 units toward the outside of the plate.

2. Set Center as a Running Object Snap.

3. Select Ribbon: Home = Modify = Move. ') Rotate W Trim -

oy Lopy >\ Mirror 7 Fillet ~
[T\ stretch ] Scale BB Array -
Modify =

M ap

4. Select the upper-left circle.
5. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
6. Select the center of the circle using the Center Object Snap to specify it as the base point.

You are now prompted to select the second point.
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7. Move the crosshairs to the left, locking on to the
180 degree Polar Tracking angle, to indicate the
direction to move.

8. At the Command line type .5 then press [Enter]
at the keyboard.

9. Repeat the process to move the lower-left circle .5 units to the left.

Next you will move the two circles on the right side of the plate. To save time, you will
select both circles and move them simultaneously.

10. Select Ribbon: Home = Modify = Move. ¢ Rotate & Trim - 7
o Copy e Ah Mirror {7 Fillet - ()
[\ stretch ] Scale B8 Amay - &

Modify «
11. Select the upper-right and lower-right circles.
12. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
13. Select the center of either of the circles to specify it as the base . Gé
point.

You are now prompted to select the second point.

14. Move the crosshairs to the right, locking on to the 0 degree
Polar Tracking angle, to indicate the direction to move.

15. At the Command line type .5 then press [Enter] at the
keyboard.

16. Save the drawing. O
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2.2.3 Copy Drawing Objects

The Copy command copies objects a specified distance in a specified direction.

O+
D

Use coordinates, grid snap, object snaps, and other tools to copy objects with precision.
You can also use grips to move and copy objects quickly.

Specify Distance with Two Points

Copy an object using the distance and direction specified by a base point followed by a second point. In
this example, you copy the block representing an electronic component. Select the original object to be
copied. Specify the base point for the move (1) followed by a second point (2). The object is copied the
distance and direction of point 1 to point 2.

copy of object
original object

SN = — HL | L]

— e i —
e Ju| |8 o el e L N
L n o o n o Ja 1
wm ! r' U ] -.I,i U LI ) '.J |:|
(- v o F L
object selected result

Specify Distance with Relative Coordinates

Copy an object using a relative distance by entering coordinate values for the first point and pressing Enter
for the second point. The coordinate values are used as a relative displacement rather than the location of
a base point.

Note: Do not include an @ sign as you normally would for relative coordinates, because relative
coordinates are expected.

&

To copy objects a specified distance, you can also use direct distance entry with Ortho mode and polar
tracking.

Create Multiple Copies

With COPY, you can create multiple copies from the specified selection set and base point. The options
include the following:

e Create copies at specified locations or displacements

e Automatically space a specified number of copies in a linear pattern.
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base point

next point

g next point
next point
e ) 3

second point
object selected result

You can also select objects and drag them to a new location using the left mouse button over one of the
selected objects; press Ctrl to make a copy. Using this method, you can drag objects between open
drawings and other applications.

If you drag with the right mouse button instead of the left, a shortcut menu is displayed after you drag the
objects. The menu options include Move Here, Copy Here, Paste as Block, and Cancel.

) @ E 8 5

i [ :}_ :><_) |
LK ___I_..______;__ ““““““:- __: T _______________
(/\{(A) ]

5 copies fit in a linear array between the base point and
second point

With the COPYMODE system variable, you can control whether multiple copies are created automatically.

1] pos,
(‘f 5 a4 HJ e

S
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The following prompts are displayed.
Select objects: Use an object selection method and press Enter when you finish

Specify base point or [Displacement/mOde/Multiple] <Displacement>: Specify a base point or enter an
option

Specify second point or [Array] <use first point as displacement>: Specify a second point or enter an option
Displacement
Specifies a relative distance and direction using coordinates.

The two points you specify define a vector that indicates how far from the original the copied objects are to
be placed and in what direction.

If you press Enter at the Specify Second Point prompt, the first point is interpreted as a
relative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter at the next
prompt, the objects are copied 2 units in the X direction and 3 units in the Y direction from their current
location.

Mode
Controls whether the command repeats automatically (COPYMODE system variable).
Single
Creates a single copy of selected objects and ends the command.

Multiple
Overrides the Single mode setting. The COPY command is set to repeat automatically for the
duration of the command.
Array

Arranges a specified number of copies in a linear array.

Number of Iltems to Array

Specifies the number of items in the array, including the original selection set.

Second Point

Determines a distance and direction for the array relative to the base point. By default, the first copy
in the array is positioned at the specified displacement. The remaining copies are positioned in a
linear array beyond that point using the same incremental displacement.

Fit
Positions the final copy in the array at the specified displacement. The other copies are fitin a linear
array between the original selection set and the final copy.
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Copy and Paste to Another Drawing

Use the following commands to copy and paste to another drawing:

COPYBASE - Copies selected objects to the Clipboard along with a specified base
point. r[l

COPYCLIP - Copies selected objects to the Clipboard. FD
il
PASTEBLOCK - Pastes objects from the Clipboard into the current drawing as a block. Lfé

PASTECLIP - Pastes objects from the Clipboard into the current drawing. [D
PASTEORIG - Pastes objects from the Clipboard into the current drawing using the original

Y

coordinates. va
PASTESPEC - Pastes objects from the Clipboard into the current drawing and controls the

).
format of the data. L;
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Exercise: Copying Drawing Objects

In this exercise you will create several copies of the bolt in the top view as well as the
section view.

You do the following:

e Start the Copy command.

e Select objects.

e Specify a base point.

e Copy an object to a new location by entering a distance value.

e Copy an object to a new location by snapping to existing drawing objects

____Q__+______

1. Open drawing 7.1.1 Copying Objects 1.dwg.

2. Set Center and Intersection as Running Object Snaps.

3. Disable Object Snap Tracking.

First you will create copies of the top view of the bolt.

4. Select Ribbon: Home = Modify = Copy. & Move (% Rotate % Trim -
% Copy B\ Mimor {7 Fillet - 51
L\ Stretcg | Scale 38 Amray - &

Modify +

5. Select the top view of the bolt.

6. Press [Enter] at the keyboard to finish selecting objects.
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7. Select the center of the top view of the
bolt to specify the base point.

8. Select the intersection of two of the center lines in the top view to specify the second point of
displacement.

A copy of the bolt has been placed. AutoCAD is in the Multiple copy mode by default,

which allows multiple copies to be placed.

10. Press [Esc] at the keyboard to finish the Copy l |
command. | |

Next you will place four copies of the longitudinal view of the bolt into the section view.

9. Select each of the other intersecting centerlines
until the view is complete.

11. Select Ribbon: Home = Modify = Copy. 4 Move () Rotate 3 Trim -
%% Copy R Miror {7 Fillet - i
L Stretcg | Scale B8 Amay -+ &

Modify ~

12. Select the longitudinal view of the bolt.
13. Press [Enter] at the keyboard to finish selecting objects.

14. Select the intersection of the bottom of the bolt head and the center line to specify the base
point.

( Second
~ Point
i Base

Point

_—

15. Select the intersection of the center line of the first hole and the top of the plate.
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A copy of the bolt has been placed. AutoCAD is in the Multiple copy mode by default,

which allows multiple copies to be placed.
16. Select each of the other intersections
along the top of the plate until the view
is complete.

17. Press [Esc] at the keyboard key to end
the Copy command.

18. Save the drawing.

CIr=———-+

CrE=——"—
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2.2.3 Offsetting Objects

Offset creates a geometric object that is parallel or concentric to the selected object at a specified distance.

For example, if you offset a circle or an arc, a larger or smaller circle or arc is created, depending on which side
you specify the offset. If you offset a polyline, the result is a polyline that parallels the original.

<J—*J

polyine polyline with offset

A

An effective drawing technique is to offset objects and then trim or extend their ends.

LA S
TSN

Use OFFSET to offset most of the geometric objects. Splines and polyline are trimmed automatically when
the offset distance is larger than can otherwise be accommodated.

Special Cases

Offsetting splines and polylines can produce complex results.

Splines and polylines are trimmed automatically when the offset distance is larger than can otherwise be
accommodated.

@_»

Polyline segments can be trimmed or deleted in some cases and extended to fill gaps in others.
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Gapsare filled (\ intersecting lines
/" \\r;\_‘\ are trimmed

e

L AN /'\

¢
R sharp Corners

The OFFSETGAPTYPE system variable controls whether the extended corners are sharp, filleted, or

chamfered.
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Exercise: Offsetting Drawing Objects
In this exercise you will complete the drawing of a gasket by offsetting several drawing
objects.
You do the following:
e Start the Offset command.
e Specify an offset distance by typing a value.
e Specify an offset distance by selecting points.
e Specify the direction to place the copy.
1.00
TYP. 4X @0.50
1.00 })
TYP.
050 !
TYP.
1. Open drawing 7.6.1 Offsetting Objects 1.dwg.
The outer rectangle has been created.
First you will locate the center of the four holes using the Offset command.
2. Select Ribbon: Home = Modify = Offset. 4 Move () Rotate \§ Trim -
9% Copy A Mimor {7 Fillet - 5§
D_:_ Stretch m Scale 55 Ammay | =
Meodify = L

The Command line prompts for the offset distance.

3. Atthe Command line type 1 then press [Enter] at the keyboard.
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4. Select the top line of the rectangle.

5. Click a location inside of the rectangle.

An offset construction line has been created.

6. Select the left side line of the rectangle, then
click to the inside of the rectangle.

7. Select the bottom line of the rectangle, then
click to the inside of the rectangle.

8. Select the right side line of the rectangle,
then click to the inside of the rectangle.

Four construction lines have been created.
9. Press [Esc] at the keyboard to end the Offset command.
10. Confirm that Intersection is set as a Running Object Snap.

A circle with diameter .5 will be drawn at each intersection.

11. Select Ribbon: Home = Draw = Circle = Center, : — .
H / " |/-;\| -~ ==
Diameter. . —Y N
Line Palylinf Circle ygtArc

Draw =

12. Select one of the intersections.

13. At the Command line, type .5 then press [Enter] at the keyboard.
14. Press [Enter] at the keyboard to repeat the command.

15. Select another intersection.

16. Press [Enter] at the keyboard to draw a circle of the same size.

17. Repeat the process to draw the remaining two
circles. O O

18. Erase the four construction lines.

The drawing appears as shown.

@) O

Next the inner opening of the gasket will be created by offsetting several lines and circles.

MDT Internal Use Only 129



101 — AutoCAD Fundamentals for Microstation Users

User Guide

19. Select Ribbon: Home = Modify = Offset.

20. At the Command line type .5 then press [Enter].

21. Offset each edge of the rectangle towards the
inside.

The drawing appears as shown.

Next the circles will be offset to the outside of the originals.

22. Select Ribbon: Home = Modify = Offset.

The .5 offset value is retained, so it is unnecessary to enter a value.

23. Select a circle.
24. Click a location outside of the circle.

25. Repeat the process for the other three
circles.

The drawing appears as shown.

26. Using the Trim and Erase commands,

remove the dashed segments shown to the
right.

The completed drawing appears as shown.

27. Save the drawing.

'-:H Mowve C; Rotate \A; Trirn = <

9% Copy A\ Mimor (T Fillet -

[J Stretch ] Scale B Amay - &

Modify ~ I
o O
O O

& Move () Rotate L Tim - 7

9¥ Copy AN Mimor {7 Fillet - 5

[J Stretch ] Scale B Amay § &

Modify ~ I

) ©

RN Loy

(o o}

e Oy

= ==
@) O
O O
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2.2.4 Rotate

The Rotate command rotates objects around a base point.

.
|

S

You can rotate objects in your drawing around a specified base point.

To determine the angle of rotation, you can enter an angle value, drag using the cursor, or specify a
reference angle to align to an absolute angle.

Rotate an Object by a Specified Angle

Enter a rotation angle value from 0 to 360 degrees. You can also enter values in radians, grads, or surveyor
bearings. Entering a positive angle value rotates the objects counterclockwise or clockwise, depending on
the base angle direction setting in the Drawing Units dialog box.

Rotate an Object by Dragging

Drag the object around the base point and specify a second point. Use Ortho mode, polar tracking, or object
snhaps for greater precision.

For example, you can rotate the plan view of a house by selecting the objects (1), specifying a base point
(2), and specifying an angle of rotation by dragging to another point (3).

object selected base point and angle of result
rotation

Rotate an Object to an Absolute Angle

With the Reference option, you can rotate an object to align it to an absolute angle.

For example, to rotate the part in the illustration so the diagonal edge rotates to 90 degrees, you select the
objects to be rotated (1, 2), specify the base point (3), and enter the Reference option. For the reference
angle, specify the two endpoints of the diagonal line (4, 5). For the new angle, enter 90.

MDT Internal Use Only 131



101 — AutoCAD Fundamentals for Microstation Users User Guide

The following prompts are displayed.

Select objects
Use an object selection method and press Enter when you finish.

Specify base point
Specify a point.

Specify rotation angle
Enter an angle, specify a point, enter ¢ , or enterr.

e Rotation Angle. Determines how far an object rotates around the base point. The
axis of rotation passes through the specified base point and is parallel to the Z axis of
the current UCS.

e Copy. Creates a copy of the selected objects for rotation.

o Reference. Rotates objects from a specified angle to a new, absolute angle. When
you rotate a viewport object, the borders of the viewport remain parallel to the edges
of the drawing area.

Rotate an Object in 3D

To rotate 3D objects, you can use either ROTATE or ROTATE3D.

e With ROTATE, you can rotate objects around a specified base point. The axis of rotation
passes through the base point and is parallel to the Z axis of the current UCS.

e With ROTATE3D, you can specify the axis of rotation using either two points; an object;
the X, Y, or Z axis; or the Z direction of the current view.
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Exercises: Rotating Drawing Objects

In this exercise you will use the Rotate command to adjust the orientation of several

doors.
You do the following:

e Start the Rotate command.
Select objects.
Specify base points.

Specify a rotation angle by typing a value.
Specify a rotation angle with Polar Tracking.
Use the reference option to orient drawing objects.

v

V!
|-

[

]

28. Open drawing 6.4.1 Rotating Objects 1.dwg.

29. Set Endpoint as a Running Object Snap.

f

Four doors have been placed, but they need to be rotated into place. Start with the door
in the lower left, then work clockwise around the building.

30. Zoom to the lower-left quadrant of the building.

31. Select Ribbon: Home = Modify = Rotate. 4 Move | ) Rotate I Trim - 7
O3 Copy . WMimor My Fillet ~ ]
[L\ Stretch 5] Scale BB Amay - &
Modify
32. Select the door.
33. Press [Enter] at the keyboard to finish selecting objects.
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You are now prompted to select the base point. M

34. Select the point where the arc touches
the wall to specify it as the base point.

Base Point
You are now prompted to specify the rotation angle.
35. At the Command line type 90 then press [Enter] at the keyboard.
The door is rotated into place.
36. Zoom to the upper-left quadrant of the building.
37. Select Ribbon: Home = Modify = Rotate. 4 Move [ ) Rotate | Trim -
Oc;‘) Copy m " Fillet - 5
[L\ stretch ] Scale B8 Amay - &
Modify ~
38. Select the door.
39. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point. I
40. Select the point where the arc touches
the wall to specify it as the base point.
- "V
You are now prompted to specify the rotation angle.
41. At the Command line type 45 then press [Enter] at the keyboard.
The last two doors will be rotated in the clockwise direction, which will require negative
rotation angles.
42. Zoom to the upper-right quadrant of the building.
43. Select Ribbon: Home = Modify = Rotate. 4 Move | ) Rotate | Trim - 7
Oc;‘j Copy IW " Fillet ~ &
[\ Stretch 5] Seale  BS Aray - &
Modify

44. Select the door.
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45. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.

46. Select the point where the arc touches
the wall to specify it as the base point.

You are now prompted to specify the rotation angle.
47. At the Command line type -45 then press [Enter] at the keyboard.
Next you will rotate the final door.

48. Zoom to the lower-right quadrant of the building.

49. Select Ribbon: Home = Modify = Rotate. 4 Move [ ) Rotate |5 Trim -

93 Copy Ak WMior Wy Fillet -

D_:_ Stretch m Scale 55 Array -
Madify ~

=

50. Select the door.
51. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.

52. Select the point where the arc touches
the wall to specify it as the base point.

You are now prompted to specify the rotation angle.

At the Command line type -90 then press [Enter] at the keyboard.
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The completed drawing appears as shown.

53. Save the drawing.
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Exercise: Rotating Objects with Polar Tracking

In this exercise you will use the Rotate command and Polar Tracking to speed up the

rotate process.
@

[ 1
1. Open drawing 6.4.2 Rotating Objects 2.dwg.
2. Set Endpoint as a Running Object Snap.
3. Select the fly-out arrow next to the Polar Tracking button and 90, 120, 270, 360...
select 45 degree increment angles. v 45,90, 135, 180..
. . 30, usa._na.‘za...%
4. If necessary, select the Polar Tracking button to turn it on. 23 45 68 00
18, 36, 54, 72...
15, 30, 45, 60...
10, 20, 30, 40...
510,15, 20..
Tracking Settings...
ELOHE v |:|_'
5. Zoom to the lower-left quadrant of the building.
6. Select Ribbon: Home = Modify = Rotate. 4 Move [ ) Rotate |5 Trim -

Oc;‘) Copy HE Thrror Ky Fillet -
D_:_ Stretch m Scale 55 Array -
Modify =

m oy

7. Select the door.

8. Press [Enter] at the keyboard to finish selecting objects.
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You are now prompted to select the base point.

9. Select the point where the arc touches the
wall to specify it as the base point.

Base Point
You are now prompted to specify the rotation angle. 5
10. Move the crosshairs above the previous ]
point, until it snaps on to the 90 degree
Polar Tracking angle, then select a point.
|
The door is rotated into place.
11. Zoom to the upper-left quadrant of the building.
12. Select Ribbon: Home = Modify = Rotate. 4 Move | ) Rotate | Trim - 7
Oc;‘j Copy IW " Fillet ~ &
[\ Stretch 5] Scale BB Amay - &
Modify

13. Select the door.

14. Press [Enter] at the keyboard to finish selecting objects.

You are now prompted to select the base point.

15. Select the point where the arc touches
the wall to specify it as the base point.

AV
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You are now prompted to specify the rotation angle.

16. Move the crosshairs above and to the e
right of the previous point, until it snaps -
on to the 45 degree Polar Tracking
angle, then select a point.

17. Repeat the process to complete the right side of the drawing.

18. Save the drawing.

Exercise: Rotating Objects with the Reference
Option

In this exercise you will use the Reference option of the Rotate command to adjust the
orientation of an object.

1. Open drawing 6.4.3 Rotating Objects 3.dwg.
2. Set Endpoint as a Running Object Snap.

A bolt head has been rotated at an unknown angle. You will rotate it until the top and
bottom edges are horizontal.

3. Select Ribbon: Home = Modify = Rotate. 4 Move [ ¢, Rotate |5 Trim -

O3 Copy . Mhror Wy Fillet -

D_:_ Stretch m Scale 55 Array -
Modify +

m -

4. Select the objects that make up the bolt head.

5. Press [Enter] at the keyboard to finish selecting objects.
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You are now prompted to select the base point.

6. Select the lower-left corner to specify
it as the base point.
Base Point

You are prompted for a rotation angle. By default, AutoCAD uses 0 as the reference
angle, meaning that you are rotating from horizontal. In this case the reference angle
should match the bottom edge of the bolt head. Since that value is unknown, you will
select the two endpoints of that line to specify it as the new reference angle.

7. Atthe Command line select the [Reference] option.

* Specify base point:

A= (,~ ROTATE Specify rotation angle or [Cop <@

You are prompted to specify the reference angle.

8. Click the lower-left point. Point2 |

9. Click the lower-right point.

The reference angle now matches the bottom
edge of the bolt head.

10. Move the crosshairs horizontally to
the right along the 0 degree Polar
Tracking angle.

11. Select a point to rotate the bolt head
into place.

Polar: 1.5474 < 0%

The top and bottom edges of the bolt head are now horizontal.

12. Save the drawing.
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2.3.5 Scale

Enlarges or reduces selected objects, keeping the proportions of the object the same after scaling.

—

To scale an object, specify a base point and a scale factor. The base point acts as the center of the scaling
operation and remains stationary. A scale factor greater than 1 enlarges the object. A scale factor between
0 and 1 shrinks the object.

The following prompts are displayed.

Select objects

Specifies which objects you want to resize.

Base point

Specify a base point for the scale operation.

The base point you specify identifies the point that remains in the same location as the selected
objects change size (and thus move away from the stationary base point).

Note: When you use the SCALE command with annotative objects, the position or location of
% the object is scaled relative to the base point of the scale operation, but the size of the object is
not changed.

Scale Factor

Multiplies the dimensions of the selected objects by the specified scale. A scale factor greater than
1 enlarges the objects. A scale factor between 0 and 1 shrinks the objects. You can also drag the
cursor to make the object larger or smaller.

Copy
Creates a copy of the selected objects for scaling.

Reference

Scales the selected objects based on a reference length and a specified new length.
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Exercises: Scaling Drawing Objects

In these exercises, you will use the Scale command to resize drawing objects.
You do the following:

e Start the Scale command.

e Select objects.

e Specify base points.

e Enlarge drawing objects.

e Reduce the size of drawing objects.

e Use the reference option to specify the size of an object.

In this exercise you will use the Scale command to resize several hex-head bolts.

~ ~) /e ~\
( p q p
R =7 P\ 7
@25 2.50 21.00 @1.50

20 R A

\
/

(
A\

.25 @.50 21.00 21.50

1. Open drawing 6.2.1 Scaling Objects 1.dwg.
2. Set Center as a Running Object Snap.

All five hex-head bolts currently have a diameter of 1. The first needs to be resized to a diameter of .25.
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3. Select Ribbon: Home = Modify = Scale.

4. Select the components of the first hex-head bolt.
5. Press [Enter] at the keyboard to finish selecting objects.

You are now prompted to select the base point.

6. Select the center of the circle to specify it as the base point.

You are prompted for the scale factor.

7. Atthe Command line type .25 then press [Enter] at the
keyboard.

You will scale the next bolt to half its original size.

8. Select Ribbon: Home = Modify = Scale.

9. Select the components of the second hex-head bolt.

10. Press [Enter] at the keyboard to finish selecting objects.

11. Select the center of the circle to specify it as the base point.

12. At the Command line type .5 then press [Enter] at the
keyboard.

4 Move C; Rotate \A: Trim ~ &
¥ Copy Mirror (" Fillet ~ [
[T\ stretch | 0] Scale B Amay - &
Troany

@225

.25
41* Maowve 6 Rotate ‘A: Trim =
%} Copy A Mimor (" Fillet - i
[\ stretch § 5] Scale BB Aray - &

— o Ty 1:

@.50

@.50
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The third bolt will remain the same size. The fourth bolt will now be resized to 150% of its original size.

13.

14,

15.

16.

17.

Select Ribbon: Home = Modify = Scale.

Select the components of the fourth hex-head bolt.

Press [Enter] at the keyboard to finish selecting objects.

Select the center of the circle to specify it as the base point.

At the Command line type 1.5 then press [Enter] at the
keyboard.

The final bolt will now be scaled to be twice its original size.

4 Move
% Copy

D_:_ Stretch

C; Rotate *A; Trim -

Ab Miror 7 Fillet ~ )

0 Scale JBR Armay -~ &

MoE.?\; ‘:

7\

N
=

N7

21.50

@1.50
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18.

19.

20.

21.

22,

23.

Select Ribbon: Home = Modify = Scale. 4 Move () Rotate 3 Trim -
¥ Copy Mirror (" Fillet ~ [
[Ty Stretchl 0] Scale B Amay - &
m
Select the components of the fifth hex-head bolt.

Press [Enter] at the keyboard to finish selecting objects.

Select the center of the circle to specify it as the base point.

22.00
At the Command line type 2 then press [Enter] at the
keyboard.
N~ 7
@2.00

Save the drawing.
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Exercise: Scaling Drawing Objects with the
Reference Option

In this exercise you will use the Reference option of the Scale command to properly size a nut.

02.12
@1.50
J1.50 @1.50
1. Open drawing 6.2.2 Scaling Objects 2.dwg.
2. Set Center and Midpoint as a Running Object Snap.
The nut has been incorrectly scaled. It needs to be scaled down until the outer diameter
is 1.50.
The scale value could be calculated, but the Reference option of the Scale command will
work more efficiently.
3. Select Ribbon: Home = Modify = Scale. 4 Move () Rotate % Trim -
% Copy b Miror (" Fillet - (Fi
[y stretch | ] Scale BB Aray - &
—Toamky
4. Select the components of the nut. Include the 2.12 S~ @212
diameter dimension. Exclude the 1.50 diameter
note below the drawing. ) Y
. 7
@1.50
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5. Press [Enter] at the keyboard to finish selecting objects.

MDT Internal Use Only 147



101 — AutoCAD Fundamentals for Microstation Users User Guide

You are now prompted to select the base point.

6. Select the center of the nut to specify it as the base
point.

22.12

You are prompted for the scale factor.
7. Atthe Command line select the [Reference] option.

You are prompted for the reference length. You will specify two points rather than type a

value.
8. Select the midpoint of the bottom line. \/

9. Select the midpoint of the top line.

N\

You are prompted for the new length.
10. At the Command line type 1.5 then press [Enter] at the keyboard.
The nut is now scaled properly.

@1.50

11. Save the drawing.
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2.2.6 Mirror

The Mirror command creates a mirrored copy of selected objects.

7N

You can flip objects about a specified axis to create a symmetrical mirror image.

You flip objects about an axis called a mirror line to create a mirror image. To specify this temporary mirror
line, you enter two points. You can choose whether to erase or retain the original objects.

1 4

mimer ing————

3
2
object selected mirror line defined result with original
with window with two points object retained

By default, when you mirror text, hatches, attributes, and attribute definitions, they are not reversed or
turned upside down in the mirror image. The text has the same alignment and justification as before the
object was mirrored. If you do want text to be reversed, set the MIRRTEXT system variable to 1.

You can create objects that represent half of a drawing, select them, and mirror them across a specified
line to create the other half.

1

-L'\-\.

3.”f’t

%

| | Note: By default, when you mirror a text object, the direction of the text is not changed. Set the
MIRRTEXT system variable to 1 if you do want the text to be reversed.

R3 EA R3
T+ ver+< ANy +12v<]]
10K Hor 10K

before mirroring after mirroring after mirroring
MIRRTEXT=1 MIRRTEXT=0
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The following prompts are displayed.

Select objects

Use an object selection method to select the objects to be mirrored. Press Enter to finish.

Specify first point, second point of mirror line

The two specified points become the endpoints of a line about which the selected objects are
mirrored. For mirroring in 3D, this line defines a mirroring plane perpendicular to the XY plane of
the user coordinate system (UCS) containing the mirror line.

-"',:""-\l-_-- l-"‘;\:“‘\-:‘1"! .-'_";'\:"-. :h-q'\. g L]
objects selected 1
Erase source objects

Determines whether the original objects are erased or retained after mirroring them.

SN,

QL)@
original objects
retained
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Exercise: Creating Mirrored Copies of Drawing
Objects

In this exercise you will use the Mirror command to create copies of a hole. While the
geometry of the hole itself will not be appear mirrored, its location will.

You do the following:

e Start the Mirror command.

e Select objects.

e  Specify a mirror line.

e Create a mirror image copy of drawing objects.

e Replace drawing objects with mirror image copies.

—>

1. Open drawing 7.2.1 Mirroring Objects 1.dwg.
2. Set Midpoint as a Running Object Snap.

First you will mirror the hole from the upper-left to the lower-left of the part, using the
midpoint of the vertical edges as the mirror line.

3. Select Ribbon: Home = Modify = Mirror. <+ Move Rotate % Trim -
% copy [ A\ Miror |7 Fillet -
[\ Stretch ] Scalelay BB Array - &

Modify +

4. Select the circle, then press [Enter] at the keyboard.
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You are prompted to select the first point of
the mirror line. O Original
First Hole Second
5. Select the midpoint of the left oo | Mirror
vertical line.
Mirrored
You are prompted to select the second point O Copy

of the mirror line.

6. Select the midpoint of the right
vertical line.

You are prompted to erase the source object.

7. Atthe Command line select the [No] option.

Finally, you will simultaneously mirror both holes to the right side of the part.

8. Select Ribbon: Home = Modify = Mirror.

9. Select the two circles, then press [Enter] at the keyboard.

You are prompted to select the first point of the mirror line.
10. Select the midpoint of the top horizontal line.
You are prompted to select the second point of the mirror line.

11. Select the midpoint of the bottom horizontal line.

You are prompted to erase the source object.
12. At the Command line select the [No] option.

13. Save the drawing.

4 Move Rotate *A; Trim - &
% copy [ A\ Miror |7 Fillet - )
[\ stretch 5 B0 Array =
Modify =
O (i O
Mirror
Point
Second
Mirror
O Eile
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2.2.7 Grip Editing

You can reshape, move, or manipulate objects in other ways using different types of grips and grip modes.

Objects with Multi-Functional Grips

The following objects have multi-functional grips that offer object-specific and, in some cases, grip-specific
options:

e 2D objects: Lines, polylines, arcs, elliptical arcs, splines, and hatch objects.

L) a

!f//j
- N

e

Annotation objects: Dimension objects and multileaders.

e 3D solids: 3D faces, edges, and vertices.

ON =1
h

AUTODESK

AUTODESK "

Important Notes

e Grips are not displayed on objects that are on locked layers.

e When you select multiple objects that share coincident grips, you can edit these objects using
grip modes; however, any object- or grip-specific options are not available.

Tips for Stretching with Grips
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e When you select more than one grip on an object to stretch it, the shape of the object is kept
intact between the selected grips. To select more than one grip, press and hold the Shift key,
and then select the appropriate grips.

e Grips on text, block references, midpoints of lines, centers of circles, and point objects move
the object rather than stretching it.

e When a 2D object lies on a plane other than the current UCS, the object is stretched on the
plane on which it was created, not on the plane of the current UCS.

e If you select a quadrant grip to stretch a circle or ellipse and then specify a distance at the
Command prompt for the new radius—rather than moving the grip—this distance is
measured from the center of the circle, not the selected grip.

Limit the Display of Grips to Improve Performance

You can limit the maximum number of objects that display grips. For example, when a drawing contains
hatch objects or polylines with many grips, selecting these objects can take a long time. The GRIPOBJLIMIT
system variable suppresses the display of grips when the initial selection set includes more than the
specified number of objects. If you add objects to the current selection set, the limit does not apply.
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Exercise: Modifying Drawing Objects with
Grips

In this exercise you will use grips to perform several different modify commands,
including move, stretch, rotate, and copy.

You do the following:

e Select objects.
e Select grips.
e Move, copy, rotate, and stretch drawing objects with grips.

1. Open drawing 7.7.1 Grip Editing.dwg.

The right-side view of the part has been created. You will use the provided circles and
lines to complete the front view.

2. Confirm that Running Object Snaps are set to Endpoint, Midpoint, Center, and
Intersection.
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3. Select the center line that is
farthest to the left.

Grips appear at the midpoint and endpoints
of the line.

4. Select the midpoint grip. [ W—— —— -~
5. Right-click the mouse, then R ;:’Et"”
select Rotate in the context 5 o
menu. Scale

A Mirror

6. Atthe Command line, type 90
then press [Enter] at the
keyboard.
The line is now vertical.
Next you will move the vertical line to the midpoint of the horizontal line.

The vertical line is still selected from the previous step.

7. Select the midpoint grip of the
vertical line.

Select this line

\
I
8. Select the midpoint of the ‘

remaining horizontal line. \

9. Press [Esc] at the keyboard to - —~_ - I

I
deselect the line. ‘
I
|

The drawing appears as shown.

Next you will move the three largest circles into place.
10. Select the largest circle.
11. Select the center grip.
12. Select the intersection of the two center lines.

13. Press [Esc] at the keyboard to deselect the circle.

156
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14.

The drawing appears as shown: /7 _—4—_ + \ = @ /— ___|

Repeat the process to
move the next two
largest circles to the
same locaton. N ke

Missing centerline extension

Missing centerline extension

Notice that the vertical centerline does not correctly extend past the outer circle.

15.

16.

17.

18.

19.

20.

21.

22.

Select the vertical centerline.

Select the endpoint grip at the
top of the line.

Move the crosshairs above the
original grip location along the 90
degree Polar Tracking angle.

At the Command line type .125
then press [Enter] at the
keyboard.

Select the endpoint grip at the
bottom of the line.

Move the crosshairs below the
original grip location along the
270 degree Polar Tracking angle.

At the Command line type .125
then press [Enter] at the - N

keyboard. :

Press [Esc] at the keyboard to
deselect the line.

Next you will simultaneously copy and rotate the vertical centerline to create 45 degree centerlines.

23.

24,

25.

26.

27.

Select the vertical centerline.

Select the midpoint grip.

Right-click the mouse, then select Rotate in the context menu.
At the Command line select the [Copy] option.

At the Command line type 45 then press [Enter] at the keyboard.
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28. At the Command line type -45 then press [Enter] at the keyboard.

20.

The drawing appears as shown:

Press [Esc] at the keyboard to deselect the line.

Next you will copy the remaining small circle to the eight centerline intersections.

30.

31.

32.

33.

34.

Select the small circle to the left of the drawing.
Select the center grip.
At the Command line, select the [Copy] option.

Click at each intersection of the centerlines to place
eight copies.

Press [Esc] at the keyboard to end the Copy
command.

The original circle is still selected.

35.

The protruding shaft in the right-side view is
too long and must be shortened.

Press [Delete] at the keyboard to erase the original circle.

36. Select the protruding rectangle.

This shape was drawn with the rectangle command, resulting in midpoint grips that allow
you to stretch the entire side of the shape.
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37.

38.

39.

40.

Select the midpoint grip of the left R
vertical edge of the rectangle. \ _____
Move the crosshairs directlytothe  ™S&}  ITTTT

right of the original point along the 0 l

degree Polar Tracking ange. |\ | ]

At the Command line, type .5 then e
press [Enter] at the keyboard.

Press [Esc] at the keyboard to -
deselect the rectange. = ———f

Similarly you will stretch the centerline to maintain consistent centerline extensions.

41,

42.

43.

44,

45,

Select the centerline running through the center of the right-side view.
Select the grip on the left endpoint of the line.

Move the crosshairs directly to the right of the original point along the 0 degree Polar
Tracking angle.

At the Command line type .5 then press [Enter] at the keyboard.

Press [Esc] at the keyboard to deselect the line.

The completed drawing appears as shown:

46.

Save the drawing.
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2.2.8 Trim and Extend
You can shorten or lengthen objects to meet the edges of other objects.

In practice, this means you can first create, copy, or offset an object such as a line or an arc, and then later
adjust it to fit exactly between other objects.

Quick Mode Operation - Default
After you start the TRIM or EXTEND commands, simply select the objects near the ends to be trimmed or

extended. There are three default options for selecting the objects:

e Two-point fence selection. Click two points that define a segment crossing through the
objects near the ends to be trimmed or extended. In this case, the lines are being extended:

1

— ,

N il

— [ |

'

Individual selection. Simply click one or more objects near the ends to be trimmed or
extended. In this case, the selected line is being trimmed:

=|-=f-=

e Freehand selection. Click and hold down the left mouse button in an empty area and drag the
cursor through one or more objects near the ends to be trimmed or extended. In this case,

the lines are being trimmed:

Note: Hold down Shift to switch temporarily between the TRIM and EXTEND commands.
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Standard Mode Operation

When you use Standard mode, objects you select as cutting edges or boundary edges are not required to
intersect the object being trimmed. You can trim or extend an object to a projected edge or to an
extrapolated intersection; that is, where the objects would intersect if they were extended.

If you do not specify a boundary and press Enter at the Select Objects prompt, all displayed objects become
potential boundaries.

E Note: To select cutting edges or boundary edges that include blocks, you can use only the single
selection, Crossing, Fence, and Select All options.

Trim Objects

You can trim objects so that they end precisely at the edges of selected objects. An object can also be one
of the cutting edges and one of the objects being trimmed. For example, in the illustrated light fixture, the
circle is a cutting edge for the construction lines and is also being trimmed.

| J?‘ﬁl L

7 | JPEIAE
cutting edges objects to tim result
selected selected

When you trim several objects, the different selection methods can help you choose the current cutting
edges and objects to trim. In the following example, the cutting edges are selected using crossing selection.

]

-~

edges selected with objects to tnim selected result
crossing selection

The following example uses the fence selection method to select a series of objects for trimming.

cutling edge selected objects to tim selected result
with fence selection
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You can trim objects to their nearest intersection with other objects. Instead of selecting cutting edges, you
press Enter. Then, when you select the objects to trim, the nearest displayed objects act as cutting edges.

In this example, the walls are trimmed so that they intersect smoothly.

all objects are selected objects to trim selected result

by pressing ENTER

Note: You can extend objects without exiting the TRIM command. Press and hold Shift while
selecting the objects to be extended. When COMMANDPREVIEW system variable is on, an

interactive preview of the command outcome is shown.

Extend Objects
You can extend objects so that they end precisely at boundary edges defined by other objects. In this
example, you extend the lines precisely to a circle, which is the boundary edge.

Sl

ocbjects to extend
selected

boundary selected

= Note: You can trim objects without exiting the EXTEND command. Press and hold Shift while
selecting the objects to be trimmed. When COMMANDPREVIEW system variable is on, an

interactive preview of the command outcome is shown.

Trim and Extend Wide Polylines
2D wide polylines trim and extend at their centerlines. The ends of wide polylines are always squared off
to the end of the polyline, not rounded or at a diagonal.

If you trim or extend a tapered 2D polyline segment, the width of the extended end is corrected to continue
the original taper to the new endpoint, if possible. Otherwise, the ending width is forced to 0, a sharp point.
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——ll
I—

selected boundary

I .
polylines 1o extend resuli

Trim and Extend Spline-Fit Polylines

Trimming a spline-fit polyline removes the curve-fit information and changes the spline-fit segments into
ordinary polyline segments.

Extending a spline-fit polyline adds a new vertex to the control frame for the polyline.
Extend a Spline

Extending a spline preserves the shape of the original portion of the spline, but the extended portion is
linear and tangent to the end of the original spline.

’/._;r '\.\‘\ / e »"f{<i//
e KL -_:.____.__--' %/

Trim or Extend in 3D

You can trim or extend an object to any other object in 3D space, regardless of whether the objects are on
the same plane or parallel to the cutting or boundary edges. In the TRIM and EXTEND commands, use the
Project and Edge options to select one of three projections for trimming or extending:

e The XY plane of the current UCS

The plane of the current view

True 3D, which is not a projection
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How To Trim an Object
1. Click Home tab * Modify panel * Trim. \AD
2. Select the objects to trim nearest the end to be trimmed and then press Enter.

You can select the objects using one or more of these automatic methods:

e Select the objects to be trimmed individually nearest the end to be trimmed.

e Specify a two-point fence by clicking two different points in empty areas as a two-point fence
that crosses the objects to be trimmed.

e Click and drag your cursor across the objects to be trimmed as a freehand selection.

= | Note: These steps work for the Quick mode. For Standard mode, you select the boundaries for
trimming first and press Enter. Then you select the objects to be trimmed.

How to Extend an Object
1. Click Home tab * Modify panel * Extend. -
2. Select the objects to extend nearest the end to be extended and then press Enter.

You can select the objects using one or more of these automatic methods:

e Select the objects to be extended individually nearest the end to be extended.

e Specify a two-point fence by clicking two different points in empty areas as a two-point fence
that crosses the objects to be extended.

e Click and drag your cursor across the objects to be extended as a freehand selection.

\% Note: These steps work for the Quick mode. For Standard mode, you select the boundaries for
— | extending first and press Enter. Then you select the objects to be extended.
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2.2.9 Erase

The Erase command removes objects from a drawing.

-

You can erase selected objects from the drawing. This method does not move objects to the Clipboard,
where they can then be pasted to another location.

If you are working with 3D objects, you can also erase sub objects such as faces, meshes, and vertices.

Instead of selecting objects to erase, you can enter an option, such as L to erase the last object drawn, p to
erase the previous selection set, or ALL to erase all objects. You can also enter ? to get a list of all options.

J P
had

I|—|.—
1 I
1 P

— r‘l‘n.ll 'H
g

=]

!
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Exercise: Trimming Drawing Objects

In this exercise you will use the Trim command to remove portions of the walls and
sidewalk throughout a building.

You do the following:

e Start the Trim command.
e Select cutting edges.
e Select objects to be trimmed.

N s

my |

B

—

1. Open drawing 6.5.1 Trimming Objects.dwg.

A sidewalk is being created on each side of the building.
You will start by trimming out the vertical line as illustrated
by the dashed line in the image to the right.

N

166
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2. Select Ribbon: Home = Modify = Trim. 4 Move () Rotate] § Tim ~|| 7
% Copy  Ah Mirror / = etg (il

By default, the Trim command begins in Quick mode. [\ Stetch ] Scole D5 Array - &

This means that all drawing objects have automatically Modify +

been selected as cutting edges.

You are prompted to select the objects to be trimmed.

3. Select the vertical line in each of the five
locations where it needs to be trimmed, as
shown in the image to the right.

chclcRo &

4. Press [Esc] at the keyboard to end the Trim command.

Often, having all objects selected as cutting edges can save time. However, in this
example it forced you to select multiple segments to be trimmed due to several cutting
edges.

Next you will trim the similar line on the right side of
the building as illustrated by the dashed line in the
image to the right.

This time, you will specify cutting edges.
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5. Press [Enter] at the keyboard to repeat the Trim command.

You are prompted to select the objects to be trimmed. \

6. Atthe Command line select the [cuTting
edges] option.

7. Select the outer wall lines on the top and
bottom of the building as shown in the image
to the right.

8. Press [Enter] at the keyboard to finish
selecting objects.

You are now prompted to select the objects to be trimmed. f

9. Select the vertical line to remove the interior
portion.

Selecting the cutting edges allowed you to trim the entire portion at once.
10. Press [Esc] at the keyboard to end the Trim command.
Finally, you will trim portions of the wall for the door openings.

11. Press [Enter] at the keyboard to repeat the
Trim command.

Once again, all objects are selected as cutting edges.

12. Select the eight line segments as shown in
the image to the right.

In this instance it was much more efficient to select all objects as cutting edges rather
than selecting them individually.

13. Press [Esc] at the keyboard to end the Trim command.

14. Save the drawing.
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Exercises: Extending Drawing Objects

In this exercise you will use the Extend command to extend several lines to complete the bolt drawing.
You do the following:
e Start the Extend command.

e Select boundary edges.
e Select objects to be extended.

1. Open drawing 6.6.1 Extending Objects.dwg.

First you will extend the upper and lower horizontal object lines to the chamfered end on
the right.

2. Select Ribbon: Home = Modify = Extend. & Move (5 Rotate % Trim -

% Copy b Mirro "y
[T Stretch 5] Seale
Modj _

By default, the Extend command begins in Quick mode. This means

that all drawing objects have automatically been selected as boundary
edges.

M o |
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You are prompted to select the objects to be extended.

3. Select the two horizontal object lines
as shown:

\

Because the lines are extending to the right, it is important to click somewhere along the
right half of each line. If you select the left half of the line AutoCAD assumes that you
want to extend in that direction, instead.

4. Press [Esc] at the keyboard to end the Extend command.

Next the hidden lines will be extended to the far right vertical line.

5. Select Ribbon: Home = Modify = Extend. & Move () Rotate 3 Trim -
9% Copy A\ Mime| Q™
[T\ stretch 7] Scale

Modl _

m o

6. Atthe Command line select the
[Boundary edges] option.

7. Select the far right vertical line as the
boundary edge.

8. Press [Enter] at the keyboard to
finish selecting objects.

extended.

You are now prompted to select the objects to be /

9. Select the two horizontal dashed
lines as shown.

Specifying the boundary edge reduced the i
number of clicks needed to fully extend the
hidden lines.

10. Press [Esc] at the keyboard to end the Extend command.

11. Save the drawing.
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Section 3 | Drawing Organization

Layers are the primary method for organizing the objects in a drawing by function or purpose. Layers can
reduce the visual complexity of a drawing and improve display performance by hiding information that you
don’t need to see at the moment.

Before you start drawing, create a set of layers that are useful to your work. In a house plan, you might
create layers for the foundation, floor plan, doors, fixtures, electrical, and so on.

In this example, the display is limited to the objects on the Floor Plan layer by turning off the other layers.

. -

E==in , —
= =

’ ’

For other disciplines, the names and number of layers that you create will be different. Once you create a
standard set of layers, you can save the drawing as a template file (.dwt) that you can use when you start
a new drawing.

For complex drawings, you might want to consider a more elaborate layer naming standard. For example,
layer names could begin with 3 digits followed by a haming code that accommodates multiple floors in a
building, project numbers, sets of survey and property data, and so on. This type of naming convention also
makes it easy to control the order of the layers and limit the layers displayed in the layer list.

2.3.1 Layers

Layer Tools

£z
Use the Layer Properties Manager to manage your layers. —

e Create, rename, and remove layers

e Set the current layer on which new objects are automatically created
e Specify the default properties for objects on the layer

e Set whether the objects on a layer are displayed or turned off

e Control whether objects on a layer are plotted

o Set whether a layer is locked against editing

e Control the layer display properties for layout viewports

e Sort, filter, and group layer names
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. Note: You can override any layer property of an object. For example, if an object’s color property
1=/ | is set to BYLAYER, the object displays the color of that layer. If the object’s color is set to Red,
the object displays as red, regardless of the color assigned to that layer.

In addition to the Layer Properties Manager, you can access layer tools on the Layers panel on the Home
tab of the ribbon.

£z | a B -
o o
—s
1 “a £, “L < £ Make Current
ayer
- - -
Properties £° &5 &2 £% Match Layer
Layers =
Unsaved Layer State -
v e 5 E S LR LT
= Z 2 E S TR
g 50%

1 Layers

For example, the Off button turns off the layers of any objects that you select.

&
5 L~ o
“o E. “& G £5 Make Current
Layer =
! & o o

Properties =5 =a =i Match Layer

Current Layer

All new objects are drawn on the current layer by default. The green check mark on the Layer Properties
Manager indicates the current layer.

x
7 Current layer: 10 WALLS

w 03 B2 48
Filters L 24

= All
LB All Used Layer

]

11 FACIMNG

AAMNAGER
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A layer cannot be the current layer if:
e The layer is frozen
e The layer is part of an external reference

For certain types of objects, you can specify a default layer other than the current layer by setting a system
variable. These include the following objects:

e Dimension objects: DIMLAYER system variable
e Text and Mtext objects: TEXTLAYER system variable
e Hatch objects: HPLAYER system variable
e Centerline objects: CENTERLAYER system variable
e Center Mark objects: CENTERLAYER system variable
e Converted SHX text from imported PDF files: PDFSHXLAYER system variable
Layer Visibility
You can control the visibility of objects on a layer by toggling the layer on/off or by using freeze/thaw.

% ¥ You can tun layers off and on as needed. Objects on layers turned off are invisible in the drawing.

T Freezing and thawing layers is similar to turning them off and on. However, when working with
drawings with lots of layers, freezing unneeded layers can speed up display and regeneration. For example,
objects on a frozen layer are not considered during a ZOOM EXTENTS.

Locking Layers

You can prevent objects on selected layers from being inadvertently modified by locking those layers. By
default, objects on locked layers appear faded and a small lock icon is displayed when you hover over the
object.

=
You can set the fade level for locked layers or hide them. =

The fading feature for locked layers lets you reduce the visual complexity of a drawing, but still maintain
visual reference and object snapping capabilities.
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In this example, the fading level is set at the fading levels of 90%, 50%, and 25%.

| T — I - !

There are a few things to keep in mind when working with locked layers:
e The locked layer fading value further reduces the visibility of transparent objects.
e The locked layer fading value does not affect how objects appear when plotted.
e Grips are not displayed on objects that are on locked layers.

Alternatively, you can hide the objects on locked layers instead of fading them.

Layers =

Unsaved Layer State

ocked layer fading

Layers

This is a fast way of turning the fading level to 0% and back to the previous level. If you're not using the
ribbon, use the LAYISO command.

Layer Filters

Sometimes drawings can include dozens or even hundreds of layers. A layer filter limits the display of layer
names in the Layer Properties Manager and in the Layer control on the ribbon. You can create
layer property filters based on the name, color, and other properties. For example, you can define a property
filter that lists all layers that include the letters "mech" in the layer name and are set to red.

You can also create layer group filters where you choose specific layers to include in the group. For
example, you could create a group called Tool Fixture that includes all the layers associated with the tool
fixtures in your drawing. When you click the Tool Fixture group in the Layer Properties Manager, only the
layers in the Tool Fixtures group are listed.

Override the Current Layer by Object Type

By default, all new objects are created on the current layer. For some types of objects, you can specify a
default layer based on the object type rather than the current layer. For example, if you want all dimension
objects to be created on a layer named 040 Dim, set the DIMLAYER system variable to 040 Dim. All
subsequently created dimensions are then automatically assigned to that layer.
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The object types that can be set include the following:
e Centerlines - CENTERLAYER system variable
e Hatches - HPLAYER system variable
e Dimensions - DIMLAYER system variable
e Text and multiline text - TEXTLAYER system variable

o Xrefs - XREFLAYER system variable

Tip: You can reset these system variables at any time to a different layer or back to the current
layer.

2.3.2 Layer Manager

You can add, delete, and rename layers, change their properties, set property overrides in layout viewports,
and add layer descriptions.

£7Z
LAYER (Command) =&

X Canceh forl O
b Current layer: 0 SCh TOF tayes .
P — £ 2 2 2 2 ~ 0
w g B3| %@ e oEp B 5 o 2 X
Filters << |IS.. Name On Freeze Lock P. Color Linetype Lineweight Tran...
5@ Al v 0 & © ' & B wh... Continu... —— Defa.. 0
verl (a] o ] =) Cont £
5 All Used Layes || Layer! ? o g S Wred Continu. Defa... 0
b Layer2 o e d © yel... Continy... —— Defa... 0
iy lor Layer3 o ® £ & @ gr.. Continu.. — Defa.. 0
<L o~ i
& o Layerd [ & [ cyan Continu... —— Defa.. 0
= lor LayerS = & B blue Continu... —— Defa.. 0
s o Layer 5 d S B ma.. Continu... —— Defa.. 0
- K >
& Invert filt
s [ Invert filter <« ||< S
.:,-:] Alk: 7 layers displayed of 7 total layers
s

Filter list Layer list

{b Hover over the image to find clickable areas which jump to the Help section for those controls.

Layers and Layer Properties
New Layer

Creates a layer with a default name that you can immediately change. The new layer inherits the properties
of the currently selected layer in the layer list.
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New Layer Frozen VP In All Viewports

Creates a layer and freezes it in all existing layout viewports. This button is accessible from the Model tab
or layout tabs.

Delete Layer

Deletes selected layers. The following layers cannot be deleted:

Layers 0 and Defpoints

The current layer

Layers used in a block definition
Layers used in an external reference

Layers in a partially opened drawing.

\E

Note: Be careful about deleting layers if you are working on a drawing in a shared project or one
based on a set of layer standards.

Set Current

Sets the selected layer as the current layer. New objects are automatically created on the current layer.
(CLAYER system variable)

Layer List

Modify the layer properties using the layer list. Click the current setting to change the layer property for the
selected layer or group of layers.

\E

Note: The layer list can be filtered and sorted to make it easier to find and select the layers that
you want to change.

Sort

Click a column label to sort by that column.

Column Order

Drag a column to a new location in the list to change the column order.
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Status

o+ This layer is the current layer.

e =7 This layer contains objects.

. ~7 This layer does not contain any objects. This icon is controlled by the
SHOWLAYERUSAGE system variable.

. @—7 This layer contains objects, and a property override is turned on in a layout
viewport.

. " This layer does not contain any objects, and a property override is turned on in a

layout viewport.

o = This layer contains objects, and xref and viewport property overrides is turned on
in a layout viewport.

. This layer does not contain objects, and xref and viewport property overrides is
turned on in a layout viewport.

. @; This layer contains objects, and an xref property override is turned on.

. O This layer does not contain objects, and an xref property override is turned on.

Note: To improve performance in drawings with a very large number of layers, all layers are

indicated as containing objects, <=, by default. You can change this option in layer settings
, or by setting the SHOWLAYERUSAGE system variable to 1.

If the Status column is left blank, it means that the item in the layer list is a layer filter. This occurs
when you choose the option to display layer filters in the layer list.

Name

Displays the name of the layer or filter. Press F2 to enter a new name.

on'%

Turns the selected layers on and off. When a layer is on, it is visible and available for
plotting. When a layer is off, it is invisible and not plotted, even if the setting in the Plot
column is turned on.

! v
Freeze = @

Freezes the selected layers. You can freeze layers to improve performance and reduce
regeneration time in complex drawings. Objects on frozen layers are not displayed, plotted,
or regenerated.

In drawings that support 3D modeling, frozen layers are not rendered.
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< Tip: Freeze the layers that you want to remain invisible for long periods. If you plan to switch
H visibility settings frequently, use the On/Off setting to avoid regenerating the drawing.

Lock & (&

Locks and unlocks the selected layers. Objects on a locked layer cannot be modified.
Objects on locked layers appear faded and a small lock icon is displayed when you hover
over the object.

% B
1| | Note: Set the fade level for locked layers to see which objects are on locked layers =%

Color ]

Displays the Select Color dialog box, where you can specify a color for the selected layers.

Linetype

Displays the Select Linetype dialog box, where you can specify a linetype for the selected
layers.

Lineweight

Displays the Lineweight dialog box, where you can specify a lineweight for the selected
layers.

Transparency

Displays the Transparency dialog box, where you can specify a transparency for the
selected layers. Valid values are from 0 to 90. The higher the value, the more transparent
the objects appear.

Plot Style

Displays the Select Plot Style dialog box where you can change the plot style for the
selected layers. For color-dependent plot styles (the PSTYLEPOLICY system variable is
set to 1), you cannot change the plot style associated with a layer.

Plot & &

Controls whether the selected layers are plotted. If you turn off plotting for a layer, the
objects on that layer are still displayed. Layers that are off or frozen are not plotted,
regardless of the Plot setting.

New VP Freeze : &

Freezes selected layers in new layout viewports. For example, freezing the DIMENSIONS
layer in all new viewports restricts the display of dimensions in any newly created layout
viewports but does not affect the DIMENSIONS layer in existing viewports. If you later
create a viewport that requires dimensions, you can override the default setting by
changing the current viewport setting.
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VP Freeze (available only from a layout tab) & B

Freezes selected layers only in the current layout viewport. If a layer is already frozen or
turned off in the drawing, you can't thaw the layer in the current layout viewport.

VP Color (available only from a layout tab) Il []

Sets an override for the color associated with the selected layer for the current layout
viewport.

VP Linetype (available only from a layout tab)

Sets an override for the linetype associated with the selected layer for the current layout
viewport.

VP Lineweight (available only from a layout tab)

Sets an override for the lineweight associated with the selected layer for the current layout
viewport.

VP Transparency (available only from a layout tab)

Sets an override for transparency associated with the selected layer for the current layout
viewport.

VP Plot Style (available only from a layout tab)

Sets an override for the plot style associated with the selected layer for the current layout
viewport. Override settings are not visible in the viewport or plotted when the visual style
in the drawing is set to Conceptual or Realistic. For color-dependent plot styles (the
PSTYLEPOLICY system variable is set to 1), you cannot set a plot style override.

Description

(Optional) Describes the layer or the layer filter.
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Manage the Layer List
Search for Layer H

Filters the layer list by name as you enter characters in the box.

The following wildcards are available:

Character Definition

# (pound) Matches any numeric digit

@ (at) Matches any alphabetic character

. (period) Matches any non-alphanumeric character

* (asterisk) Matches any string and can be used anywhere in the search string

? (question mark) Matches any single character; for example, ?BC matches ABC, 3BC, and so
on

~ (tilde) Matches anything but the pattern; for example, ~*AB*matches all strings that
don't contain AB

[ Matches any one of the characters enclosed; for example, [AB]JC matches AC
and BC

[~] Matches any character not enclosed; for example, [~AB]C matches XC but
not AC

[-] Specifies a range for a single character; for example, [A-G]C matches AC, BC

to GC, but not HC

" (reverse quote) Reads the next character literally; for example, "~AB matches ~AB

New Property Filter

Displays the Layer Filter Properties dialog box, where you can create a layer filter. Layer filters limit the
layers listed in the Layer Properties Manager to those with specified settings and properties. For
example, you can limit the list of layers to only those that are turned on and thawed.
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New Group Filter [@]

Creates a layer filter that includes only the layers that you drag to the filter.

Invert Filter

Displays all layers that do not meet the criteria in the selected layer filter.
Filters List

Displays the list of layer filters in the drawing. Click | # “to expand or collapse the filter list. When the

Filters list is collapsed, use the Layer Filter button ("'-‘} ') at the bottom-left corner of the Layer Properties
Manager to display a list of filters.

There are seven predefined filters:
e All. Lists all the layers in the current drawing.
e All non-Xref Layers. Lists all the layers that are not referenced from an xref drawing.
e All Used Layers. Lists all the layers that contain objects.
o Xref Lists all the layers being referenced from an xref drawing.

o Xref Overrides Lists all the layers being referenced from an xref drawing that have an xref layer
property override.

e Viewport Overrides. Lists all the layers containing property overrides in the current layout
viewport.

e Unreconciled New Layers. Lists all new unreconciled layers that were added since the drawing
was last opened, saved, reloaded, or plotted. When the layer notification feature is turned on, a
new layer is considered unreconciled until you accept the layer as reconciled.

Miscellaneous Tools

A
Layer States Manager

Displays the Layer States Manager, where you can save, restore, and manage sets of layer settings
that are called layer states.

Refresh E]

Refreshes the order of the layer list and the layer status information.

Toggle Override Highlight E

Turns on or off the background highlighting for layer property overrides. By default, the background
highlighting is turned off.

Settings

Displays the Layer Settings dialog box, where you can set various display options.
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User Guide

Column Label Shortcut Menu
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Column Names

Current layer: 10 WALLS
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00 REFEREMCE
0

01 VIEWPORTS
10 WALLS

12 HATCH

15 DOORS

20 ELECTRICAL

I FVIT INEC
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Status
Mame
On
Freeze
Lock
Plot

Colar

Lists all columns by name. A check mark indicates that the column is included in the display. Click
a column name to display or hide the column. VP Freeze, VP Color, VP Linetype, VP Lineweight,

and VP Plot Style are available only when a layout viewport is active.

L

L N O T U Y

£

Customize

Status

Mame

On

Freeze

Lock

Plot

Color
Linetype
Lineweight
Transparency

Plot Style

Mew WP Freeze

Description

Displays the Customize Layer Columns dialog box, where you can specify which columns are

hidden or displayed or change the column order.

Maximize All Columns

Changes the width of all columns to fit the column headers and the data content.

Maximize Column

Changes the width of the selected column to fit the column header and the data content of that
column.
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Optimize all columns

Changes the width of all columns to fit the content in each column.

Optimize column

Changes the width of the selected column to fit the content in that column.

Freeze column (or Unfreeze column)

Freeze keeps the column, and any columns to the left, visible while scrolling. Unfreeze so that all
columns scroll.

Restore All Columns to Defaults

Sets all columns to their default display and width settings.

Layer List Shortcut Menu

’ Current layer: 10 WALLS right-click
=g=1 % 5 4
Filters €¢ 5. MName « 0. F. L. P. Color Linetype
o-£ All & 0 \ 4 = Wl white COMTIM...
. EZ All Used Layers % 01 VI «  Show Filter Tree
----- 3 Electrical v 10W Show Filters in Layer List
i = P '17 LR

Show Filter Tree

Displays the Filters list. Clear this option to hide the list. Same as |# <«

Show Filters in Layer List

Displays layer filters at the top of the layer list. Clear this option to display only layers in the layer
list.

Set Current
Sets the selected layer as the current layer. Same as .

New Layer

Creates a layer. Same as

Rename Layer

Edits the layer name.
Delete Layer

Deletes selected layers from the drawing file. Same as .
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Change Description

Edits a description for the selected layer. If layer filters are displayed in the layer list, editing the
description for the filter, edits it on all layers in the filter.

Remove from Group Filter

Removes the selected layers from the layer group filter that is selected in the Filters list.

Reset Xref Layer Properties for

Removes a single override property or all property overrides on selected layers (or all layers) for
an xref or all xrefs. Different options display in a flyout menu depending on where the cursor is
located when the shortcut menu is opened. To remove a single xref property override, right-click
the property override.

Reconcile Layer

Removes new layers from the Unreconciled New Layers filter. This option is available only when
unreconciled layers are selected. When the layer notification feature is turned on, a new layer is
considered unreconciled until you accept the layer as reconciled.

Remove Viewport Overrides For

This option is only available in layout viewports. Removes a single override property or all property
overrides on selected layers (or all layers) for the current viewport or all viewports. Different options
display in a flyout menu depending on where the cursor is located when the shortcut menu is
opened. To remove a single property override, right-click the property override.

New Layer Frozen in All Viewports
Creates a layer and freezes it in all existing layout viewports and new viewports. Same as .

VP Freeze Layer

Freezes the selected layer in all new and existing layout viewports.

VP Thaw Layer in All Viewports

Thaws the selected layer in all new and existing layout viewports.

Isolate Selected Layers

Turns off all layers except the selected layers.

Merge Selected Layer(s) To

Combines the selected layers into a specified layer. Objects on the selected layers are moved to
the new layer and inherit the properties for that layer.

Select All

Selects all the layers displayed in the layer list.

Clear All

Deselects all layers in the layer list.
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Select All But Current

Selects all the layers displayed in the layer list except the current layer.

Invert Selection

Selects everything displayed in the layer list except the items that are currently selected.

Invert Layer Filter

Displays all layers that do not meet the criteria in the active layer property filter.

Layer Filters

Displays a list of layer filters, including default layer filters. Click a filter to apply it to the layer list.

Save Layer States

Saves the current layer settings as a layer state.

Restore Layer State

Displays the Layer States Manager, where you can select a layer state to restore. This operation
restores only those settings that were specified in the Layer States Manager when the layer state
was saved.

Filter List Shortcut Menu

Current layer: 10 WALLS right-click

X

(1]

= g=]
Filters

4+ 0. F. L. P. Color Linetype
® M red CONTIN..

F a
-2 All

2 [l wh... CONTIN...
ANNCT, Visibility » | CONTIN...
H ol
BT ELECTRI Lock 5 GO
H Col
LEIFURNITL CEAL
Viewport CONTIN...
= Isolate Group > | CONTIM...
2 Reset Xref Layer Properties CONTIN...
z CONTIN...
E New Properties Filter... CONTIN...
E New Group Filter CONTIN...
E P
g Convert to Group Filter CONTIN...
2| CONTIN...
é [ invert filter Rename | ronmm
o Delete
=
‘-'[,El All Used Layers: 14 layers displayed of 14 total layers

Visibility
Changes the visibility of the layers in the selected filters.

Lock

Controls whether layers are locked or unlocked in the selected filters.

Viewport

In the current layout viewport, controls the VP Freeze setting of the layers in the selected filters.
Isolate Group

Freezes all layers that are not included in the selected filters.
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e All Viewports.

o In all layout viewports, sets VP Freeze for all layers that are not included in the
selected filters.

o In model space, freezes all layers that are not in the selected filter, except for the
current layer.

e Active Viewport Only.

o In the current layout viewport, sets VP Freeze for all layers that are not included in
the selected filters.

o In model space, turns off all layers that are not included the selected filters, except
for the current layer.

Reset Xref Layer Properties

Removes the xref property overrides for the selected xref. You can either reset all overrides for a
selected xref or a specific xref layer property override.

New Properties Filter
Displays the Layer Filter Properties dialog box. Same as .

New Group Filter
Creates a layer group filter. Same as @

Convert to Group Filter

Converts the selected layer property filter to a layer group filter.

Rename

Edits the selected layer filter name.

Delete

Removes the selected layer filter. You cannot delete the All, All Used Layers, or Xref layer filters.

Properties

Displays the Layer Filter Properties dialog box, where you can modify the definitions of the selected
layer property filter. This option is available only when a layer property filter is selected.

Select Layers

Adds or replaces layers in the selected layer group filter. This option is available only when a layer
group filter is selected.

o Add. Adds layers to the selected layer group filter from the objects selected in the drawing.

o Replace. Replaces the layers of the selected layer group filter with the layers of the objects
that are selected in the drawing.
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Exercises: Drawing with Layers and Adjusting

Layer Settings

In these exercises you will draw in layers. You will also convert the layers of existing
objects. You will adjust the appearance of layers through visibility states. Finally, you will

create and modify new layers.

You do the following:

In this exercise you will complete the drawing using several different layers.

Set the current layer.

Draw in several layers.

Move existing objects to the correct layer.

Unlock a layer in order to modify objects on that layer.
Turn layers on and off.

Freeze and thaw layers.

Create new layers.

Rename layers.

Adjust the color, linetype, and lineweight of layers.
Set up a non-printing layer.

|
N GB _
|
|
g

2,2 42
v

51
X
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1. Open drawing 2.4.1 Layers.dwg.
You will begin by drawing the rectangular outline of the front view.

2. Notice that the current layer is set to OBJECT.

3. Select Ribbon: Home = Draw = Line.

] I/:}\I
— \J

olyline Circle  Arc
- -

Draw «

4. At the Command line type 2,2 then press [Enter] at the keyboard to locate the first point of

the rectangle.

5. Draw the rectangular outline of the front view, as shown in the graphic at the start of the

exercise, using Polar Tracking.
The distance between each gridline is 1.
Next you will draw the hidden lines.

6. Set the current layer to HIDDEN.

7. Select Ribbon: Home = Draw = Line.

] I/:}\I
— \J

olyline Circle  Arc
- -

Draw -

Bl

8. Atthe Command line type 4,2 then press [Enter] at the keyboard to locate the first point of

the first hidden line.

9. Draw a line straight up 4 units along the 90 degree Polar Tracking angle.

10. Repeat the process to draw the remaining three hidden lines, using the grid to determine

endpoints and length.
Finally, you will draw the center lines.

11. Set the current layer to CENTER.

12. Select Ribbon: Home = Draw = Line.

) |/:;\|
= N

olyline  Circle  Arc

Draw ~

ElR

13. At the Command line type 5,1 then press [Enter] at the keyboard to locate the first point of

the first center line.

14. Draw a line straight up 6 units along the 90 degree Polar Tracking angle.
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15. Repeat the process to draw the remaining center line, using the grid to determine endpoints
and length.

16. Press [Esc] at the keyboard to end the Line command.
17. Save the drawing.

In this exercise you will move existing drawing objects onto the appropriate layers.

|
|

I
. |
PROPERTY LINE ‘
1
1

1. Open drawing 2.4.2 Changing Layers.dwg.
The civil drawing consists of several different types of objects, all created in the 0 layer.
2. Select the four outer lines that represent the property line.

3. Click the drop-down arrow on the Layer Control then select the layer named
PROPERTYLINE.

The four lines are now in the correct layer, PROPERTYLINE.
4. Press [Esc] at the keyboard to deselect the lines.
Repeat the process to make the following changes:
5. Move the four trees into the LANDSCAPING layer.
6. Move the lines representing the existing fence into the FENCE layer.
7. Move the lines representing the existing house into the BUILDING-EXISTING layer.
8. Move the lines representing the existing deck into the DECK layer.

9. Move the lines and hatch patterns representing the existing patio and existing driveway into
the CONCRETE-EXISTING layer.
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10. Move the lines and hatch pattern representing the proposed concrete pad into the
CONCRETE-PROPOSED layer.

11. Move the lines representing the proposed shed into the BUILDING-PROPOSED layer.
12. Move all text objects to the TEXT layer.
13. Save the drawing.

In this exercise you will work with several different layer states.

1. Open drawing 2.4.3 Layer States.dwg.
2. Select a tree, then press [Delete] at the keyboard.
The tree is not deleted because it is on a locked layer.

3. Press [Esc] at the keyboard to end the Erase command.

4. Select the drop-down arrow on the Layer Control, . e
then select the padlock icon next to the _ B LANDSCAPING
LANDSCAPING layer. .

The LANDSCAPING layer is now unlocked.

5. Press [Esc] at the keyboard to close the Layer Control fly-out.

The trees can now be modified.

6. Select the four trees, then press [Delete] at the keyboard to erase them.
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7. Select the drop-down arrow on the Layer Control,
then select the snowflake icon next to the TEXT layer.

= B FIoJFLIel T CITIE
s E‘s M e
8. Press [Esc] at the keyboard to close the Layer Control fly-out.
The TEXT layer is thawed, revealing the text EXISTING HOUSE.
9. Select the drop-down arrow on the Layer Control, . LI L
then select the lightbulb icon next to the FENCE layer. | ¢ B FErICE
k- -I ol A a0 w1 10 Pl
10. Press [Esc] at the keyboard to close the Layer Control fly-out.
The FENCE layer is turned off, hiding the fence in the drawing.

11. Select the drop-down arrow on the Layer Control, . Wl TRNTERrTTe
then select the sun icon next to the PROPERTY LINE 8 [ PROPERTY LINE
layer. |:§

TLsT

12. Press [Esc] at the keyboard to close the Layer Control fly-out.
The PROPERTYLINE layer is frozen, hiding the property line in the drawing.
13. Double-click the scroll wheel button on the mouse to perform a Zoom Extents.

The drawing window zooms to show all objects on-screen. Notice that objects on the
PROPERTY LINE layer are completely ignored, because that layer was frozen. Also

notice that AutoCAD is still calculating the objects on the FENCE layer, because it was
turned off instead of frozen.

14. Select the drop-down arrow on the Layer Control, . LI
then select the lightbulb icon next to the FENCE layer | B FEnCE
to turn it on. h
| NN st A 1A T

15. Select the sun icon next to the FENCE layer to freeze . LI HA
it. i E Il FEMICE
- Y el Asll N Fal

16. Press [Esc] at the keyboard to close the Layer Control fly-out.

17. Double-click the scroll wheel button on the mouse to perform a Zoom Extents.

This time the drawing window zooms to show only the existing house. This illustrates why
freeze/thaw is recommended over on/off.

18. Save the drawing.
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In this exercise you will utilize the Layer Properties Manager to create several

different layers.

x —~
b Current layer: 0 Search for layer (&}
IR REE] === T g (I o)
Filters € Status Name On Freeze Lock Plot Color Linetype Lineweight Transparency MNew WP Freeze
=2, Al 4 0 Q9 Ii @ [Jwhite Continuous —— Default 0 =2
i All Used L = BORDER ol C’{ o 2@ [Meyan Continuous s 0,50 mm 0 =
= =  CENTER 0¥ & 8 B CENTER  —— 013mm 0 B
% = DIMENSION AR 2 g @ [Oyellow  Continuous —— 0,13 mm 0 =
E = HIDDEN 7 % & S Mble HIDDEN —— 0.13mm 0 B
E = OBJECT 0 4 @ © [Owhite  Continuous —— 0.25mm 0 [}
= = SECTION ol T o 2 [Mmagenta PHANTOM = 0.35mm 0 =
a = VIEWPORTS G ¥ g & Mgreen  Continuous —— Default 0 (=]
Z ||« »
o Invert filter
£ O Invert filter ¢ ¢ >
=Z All: 8 layers displayed of 8 total layers
1. Open drawing 2.4.4 Creating Layers.dwg.
The drawing is empty and contains only the 0O layer.
2. Select Ribbon: Home = Layers = Layer Properties. O osrct N

3
=t

Layer

Properties

& 5 S
=% Make Current
£ <. £ Match Layer

Layers =

This opens the Layer X[
. .‘ Urrent [ayer
Properties Manager. rp & 5
Filters < | Status
Only one layer, the 0 e »
. . . =-S5
layer, exists in this All Used Layers
. o
drawing. 8
z
=
[«
2
[+
; [ Inwert filter « | ¢
£ 4
Z All: 1 layers displayed of 1 total layers

ko
Mame On
a i

Search for layer Q

(I o ]

Freeze Lock Plot  Celor Linetype Lineweight
Lf o = Mwhite Continucus —— Default
>

£

button.

3. Select the New Layer

192
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4. Name the new layer BORDER.

Status  Mame

o 0
BORDER

5. Select the white color swatch for the BORDER layer. Color
[] white
i white
The Select Color dialog box opens. A Select Color w
6. Select the cyan color. Inde:x Color True Color Color Books

AutoCAD Color Index (ACH):

7. Click <<OK>>.

Index calor: 4 Red, Green, Blue: 0,255,255
. . .. . ByLayer ByBlock
HEN

Color:

|cyan |

Cancel Help

8. Select the Default lineweight for the BORDER layer. Li :
ineweight
—— Default
— Default
The Lineweight dialog box opens. A Lineweight ? %
9. Select 0.50 mm. o
— 0.18mm A
. ——————— 020mm
10. Click <<OK>>, — 025mm
0.30 mm
0.35 mm
—— ) 40 mm

s () 53 mm i g

e () 50 mm

s () 70 mm
s (.30 mm v

Criginal: Default
MNew: 0.50 mm

Cancel Help
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11. With the BORDER layer still selected, select the New Layer button.

A new layer is created with the same properties (cyan color and 0.50 mm lineweight) as the BORDER
layer.

12. Name the new layer CENTER.

13. Select the cyan color swatch for the new layer. Select the red color, then click <<OK>>.

14. Select the 0.50 mm lineweight, select 0.13 mm, then click <<OK>>.

15. Select the Continuous Linetype to open the Select Linetype dialog box.

Continuous is the only linetype loaded in the drawing; you will need to load additional linetypes.

16. Click <<Load...>>.

17. Scroll down the list of linetypes then select the CENTER linetype.

18. Click <<OK>>.

The CENTER linetype has been loaded into the drawing, but it still needs to be applied to the CENTER

layer.
19. Select the CENTER linetype, then click <<OK>>.

b Current layer: 0 Search for layer Q,
Filters «  Status  MName On Freeze Lock Plot Coler Linetype Lineweight Transparency MNew VP Freeze
=5 All v 0 E ﬁ & @ [white Continuous Default 0 =)

B All Used | < BORDER Y o o 2@ [Mcyan Continugus s 0,50 mam 0 i=3

T = CENTER q L & S Mrd CENTER — 013 mm 0 =

%’ = DIMENSION (A o & © [Oyellow Continuous —— 0.13 mm 0 =)

< = HIDDEN q - & 2 HEblue HIDDEN — 013 mm 0 =

b = OBJECT q L & & [Owhite Continuous —— 0.25 mm 0 =

E = SECTION [V o af © Mmagenta PHANTOM s 0.35 mm 0 =

= = VIEWPORTS § W & & Mgreen Continuous —— Default 0 =

=< >

S| [invertfilter  « | ¢ >
All: 8 layers displayed of 8 total layers

Use the image above to determine each layer's color, lineweight, and linetype. Notice

20. Repeat the process to create the remaining layers (DIMENSION, HIDDEN, OBJECT,

SECTION, and VIEWPORTS).

that the VIEWPORTS layer is a non-printing layer.

21. Save the drawing.
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Section 3 | Hatching

Most commonly, hatch patterns indicate the material of an object. For example, different hatch patterns can
be used to indicate concrete, landscaping materials, earth, for details and sections. Once a hatch pattern
is created, they can also be used to calculate area.

You can fill existing objects or enclosed areas with hatch patterns, solid color fills, or gradients, or you can
create new hatch objects.

Choose from:

e Predefined hatch patterns. Choose from over 70 ANSI, ISO, and other industry-standard
hatch patterns, or add hatch pattern libraries supplied by other companies.

e User-defined hatch patterns. Define your own hatch patterns based on the current linetype,
with spacing, angle, color, and other properties you specify.

e Custom hatch patterns. Hatch patterns are defined in
the acad.pat and acadiso.pat (acadlt.pat and acadltiso.pat for AutoCAD LT) files. You can
add custom hatch pattern definitions to these files.

e Solid fill. Fill an area with a solid color.

e Gradient fill. Fill an enclosed area with a color gradient. A gradient fill can be displayed as
a tint (a color mixed with white), a shade (a color mixed with black), or a smooth transition
between two colors.

Gradients that mimic colors displayed on a cylinder, a sphere, or other shapes are available.

Hatch Boundaries and Associativity
In the following illustration, the concrete hatches are bounded, while the earth hatches are unbounded.
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T
'S

By default, bounded hatches are associative, which means that the hatch object is associated with the
hatch boundary objects changes to the boundary objects are automatically applied to the hatch.

A S A
5
F
natched object result of editing result of editing
boundany with boundary with
nonassociative hatch associative hatch

Nonassociative hatches are not updated when their original boundary is changed.

Hatch associativity is turned on by default and is controlled by the HPASSOC system variable. You can
change hatch associativity using the Associate button on the Options palette, the Properties palette, or the
Hatch Edit dialog box.

Note: The OSOPTIONS system variable controls how object snaps work with hatch objects.

Current Layer Override

By default, all new objects are created on the current layer. For new hatch objects, you can specify a default
layer that's different than the current layer by specifying the layer with the HPLAYER system variable.

2.3.1 Creating and Editing Hatches

Hatch or Fill an Object or an Area

=
1. Click Home tab * Draw panel * Hatch.
Note: The Hatch Creation ribbon tab displays once the hatch command is active.

2. On the Hatch Creation tab > Properties panel > Hatch Type list, select the type of hatch that
you want to use.

Solid

Gradient

Pattern

User defined

3. On the Pattern panel, click a hatch pattern or fill.
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Pattern

SOLID

Wireframe]

4. On the Boundaries panel, specify the how the pattern boundary is selected:

o Pick Points. Inserts the hatch or fill within a closed area that is bounded by one or
more objects. With this method, you click within the boundaries to specify the area.

o Select Boundary Objects. Inserts the hatch or fill within a closed object, such as
a circle, closed polyline, or a set of objects with endpoints that touch and enclose
an area.

The selection method is retained until you change it.

5. Click an area or object to be hatched.
6. On the ribbon, make any adjustments as needed:

o On the Properties panel, you can change the hatch type and colors or modify the
transparency level, angle, or scale for the hatch.

o On the expanded Options panel, you can change the draw order to specify
whether the hatch and its boundary are displayed in front of or behind other
objects.

7. Press Enter to apply the hatch and exit the command.

< Note: Enclosed areas can be hatched only if they are in a plane parallel to the XY plane of the
—J | current UCS.

Hatch or Fill a Large Number of Closed Objects

1. Use a window, crossing, or fence selection method to select all the closed objects to hatch or
fill.

Alternatively, select a closed object, right-click, and choose Select Similar from the shortcut
menu.

2. Start the Hatch (or -Hatch) command and choose any options or settings.
3. If necessary, specify the Select Objects option.
4. At the prompt, enter p (Previous) and press Enter.

The objects in the previous selection set are hatched or filled.
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Separate Hatch Objects

By default, when you apply a hatch to multiple areas within one command, the result is a single hatch
object. If you need to change the properties of one area or remove an area, you need to separate the
hatch objects.

1. Click on the hatch. Notice that wherever you click on the hatch, it acts as one object with a
single grip.

Note: The Hatch Editor ribbon tab displays as soon as you select the hatch object.
2. On the Hatch Editor ribbon, expand the Options panel and select Separate Hatches.
Hatch Creation

parency

Aszociative| Annotative Match
Origin Properties

Origin =
Gap Tolerance 0.0000

Create Separate Hatches

Cuter |sland Detection -
%5 Do Mot Assign -

b Options

The result is that each hatch area is now its own hatch object and can be edited or removed
separately.

‘“=| | Note: Once a hatch is separated it can't be combined back into a single hatch object.

From the Command prompt, modifies existing hatches or fills.

Uses Command prompts to modify hatch-specific properties, such as pattern, scale, and angle for
an existing hatch or fill.

After you select one or more hatch objects, the following prompts are displayed.

Prompt availability differs, depending on the type of hatch object in the selection set.

Disassociate

Removes the associative quality from an associative hatch or fill.

Style

Specifies the method used to hatch or fill boundaries within the outermost boundary.

Ignore

Ignores all internal objects and hatches or fills through them.
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Outer (Recommended)

Hatches or fills inward from the outer boundary. HATCH turns hatching or filling off if it encounters
an internal island. This option hatches or fills only the outermost level of the structure and leaves
the internal structure blank.

Normal

Hatches or fills inward from the outer boundary. If HATCH encounters an internal island, it turns off
hatching or filling until it encounters another island within the island.

Properties

Specifies new hatch properties for the selected hatch or hatches. You can specify a new pattern or pattern
type and then enter the pertinent properties.

Draw Order

Assigns a draw order to selected hatches or fills. You can place a hatch or fill behind all other objects, in
front of all other objects, behind the hatch boundary, or in front of the hatch boundary. (HPDRAWORDER
system variable)

Add Boundaries

Modifies the area of a single hatch or fill by adding boundaries.

Remove Boundaries

Modifies the area of a single hatch or fill by removing boundaries.

Recreate Boundary

Creates a polyline or region around the selected hatch or fill, and optionally associates the hatch object
with it.

Associate

Specifies that the hatch or fill is associative. A hatch or fill that is associative is updated when you modify
its boundary objects.

Specify Internal Point

Determines a boundary from existing objects that form an enclosed area around the specified point
and associates the selected hatch with the boundary objects.

Select Objects

Determines a boundary from selected objects that form an enclosed area and associates the
selected hatch with the boundary objects.

Separate Hatches

Separates multiple hatch objects that were created as a single object into individual hatch objects.
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Origin
Controls the starting location of hatch pattern generation. Some hatches, such as brick patterns, are meant

to be aligned with a point on the hatch boundary. By default, all hatch origins correspond to the current
UCS origin.

Use Current Origin

Sets the hatch origin to use the value set in the HPORIGINMODE system variable.
Set New Origin

Specifies the new hatch origin point directly.

Default to Boundary Extents

Calculates a new origin based on the rectangular extents of the hatch. Choices include each of the
four corners of the extents and its center. You can also store the value of the new hatch origin in
the HPORIGIN system variable.

Annotative

Specifies that hatches in the selection set are annotative. This property automates the process of scaling
annotations so that they plot or display at the correct size on the paper.

Hatch Color

Overrides the current color with a specified color for hatch patterns and solid fills. The color value is stored
in the HPCOLOR system variable. When Hatch Type is set to Pattern, you can also specify a new
background color. The background color value is stored in the HPBACKGROUNDCOLOR system variable.

To set the hatch color back to the current color for objects, enter “.” or Use Current. To turn off the

background color, enter “.” or none.
Default object color

Enter the color number (1 through 255) or the color name (the names for the first seven colors).
For example, you can specify the color red by entering the ACI (AutoCAD Color Index) number 1 or
the ACI name red. You can also set the hatch color to ByLayer or ByBlock.

Truecolor

Specify an RGB color expressed as values from 0 to 255, such as 210,155,95.
Colorbook

Specify a custom color from a color book installed on your system.

If the selected hatch objects are all gradients, use the Properties option to specify colors.

Layer

“w

Assigns selected hatch objects to the specified layer, overriding the current layer. Enter “.” to use the current

layer.
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Transparency
Sets the transparency level for selected hatches or fills. Enter a transparency value (0 to 90) or “.” to use
the current object transparency setting.
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Exercise: Adding and Modifying Hatch Patterns

In these exercises you will add hatch patterns to drawing regions to symbolize material.
You do the following:

e Start the Hatch command.

e Add hatch patterns using the Pick Points method.

e Add hatch patterns using the Select Object method.

e Adjust the base point of a hatch pattern.

e Adjust the scale of a hatch pattern.

e Adjust the rotation angle of a hatch pattern.

e Use the Match Properties tool to match an existing hatch pattern.
e Modify a drawing to see the benefit of associative hatching.

In this exercise you will use the Hatch command to add several hatch patterns to
an assembly drawing to indicate sectioned material.

—

[7
I

==

1. Open drawing 9.1.1 Hatching Objects 1.dwg.

2. Set Hatching as the current layer.

You will begin by hatching the main body of the assembly.

3. Select Ribbon: Home = Draw = Hatch. / ~ (A < o-
— \_/ f
Line Paolyline Circle  Arc

Draw =

The Hatch Creation contextual Ribbon tab appears.
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4. Inthe Options panel (Ribbon: Hatch Creation = Options), 75 =
confirm that Associative is enabled, and Annotative is disabled. % A E
Associative finnotative Match

Properties i

Options = 8

5. Select Ribbon: Hatch Creation = Pattern = .

ANSI31. . Hl a2 .

SOLID AMNGLE ANSIZT ANSI32
Pattern
6. In the Properties panel (Ribbon: Pattern <] % - [Jiatch Transparency | 0 |
Hatch Creation = Properties), Z W bylaye Angle 0
confirm that Angle is set to 0, . None 7, 1.0000
and Scale is set to 1. Pmper;e - 1
7. Select Ribbgn: Hatch Cregtion 7 Select
= Boundaries = Pick Points. Vird:

Pick Points

8. Click inside each of the six =
regions as shown.

|

|

|

|

|
=}

9. Press [Esc] at the keyboard to
end the Hatch command. é

The hatch pattern has been added. — =
|
|

f

Next you will hatch the bushings.

10. Select Ribbon: Home = Draw => Hatch. / “ (A O
— \‘—/ { [
Line Polyline Circle  Arc g

Draw ~

The Hatch command will be in the same mode as the last time it was used. In this case,
Pick Points. This is confirmed by the Command line:
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* Command: _hatch
/= 1~ HATCH Pick internal point or [Select objects Undo seTtings]:

As a result, it is only necessary to select the boundary mode when switching to a new
mode.

11. Select Ribbon: Hatch Creation

= Pattern = ANSI32. . Q

S0LID ANGLE ANSI3T ANSIZ2
Pattern
12. In the Properties panel (Ribbon: Pattern +] # . [Hatch Transparency 0 |
Hatch Creation = Properties), 7 B Byloyer 4 50
set the Angle to 90, and the . None 17 o <000
un “m 02000 v
Scale to .5. P 1

13. Click inside each of the six
regions as shown.

14. Press [Esc] at the keyboard to
end the Hatch command. (

7?

)
|
|
|}
|
|
S

Next the shaft will be hatched while matching the pattern that has already been used in the top view.

15. Select Ribbon: Home = Draw = Hatch. / ~ (A ~O-
= N4
Line Polyline Circle  Arc

Draw «
16. Select Ribbon: Hatch Creation = Options = 7 =
Match Properties. @l A E
Ascociative| Annotative | Match
Properties ~
Options = —

17. Select the existing hatch pattern in the top view.

18. The pattern, angle, and scale have been set to
match the existing hatch pattern.
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19. Select Ribbon: Hatch Creation = Boundaries = Select. B Select
Pick Points

20. Select the inner most circle in the section view.

The centerlines divide the circle into four regions. The Pick Point method
would require four clicks, while the select method required only one.

21. Press [Esc] at the keyboard to end the Hatch command.

Boundaries =

Finally, the drawing will be modified to see the effect on the hatching.

22. Select Ribbon: Home = Modify = Stretch. 4 Move () Rotate 3 Trim -
CF Copy A\ Mimor {7 Fillet - &)
[Ty stretch E Scale 55 Amay - (=

Modify +

23. Create a crossing window as
shown.

24. Stretch the objects down 1 unit.

The bushing and the base object stretch and
the hatching adjusts. This is because the
hatch patterns were created with the
Associative option turned on.

The completed drawing appears as shown:

25. Save the drawing.

A

AN

W

AV

j
=Y
L

SECTION A-A
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Chapter 3 | Drawing Annotation

Section 1 | Annotation Tools

3.1.1 Text - Single Line and Multiline

Creates a single-line text object.

A

You can use single-line text to create one or more lines of text, where each text line is an independent
object that you can move, format, or otherwise modify. Right-click in the text box to select options on the
shortcut menu. While you are in the TEXT command:

e Click elsewhere in a drawing to start a new set of rows of single-line text

e Press Tab or Shift+Tab to move forward and back between the sets of single-line text
e Press Alt and click a text object to edit a set of text lines

e Once you leave the TEXT command, these actions are no longer available.

If TEXT was the last command entered, pressing Enter at the Specify Start Point of Text prompt skips the
prompts for paper height and rotation angle. The text that you enter in the text box is placed directly beneath
the previous line of text. The point that you specified at the prompt is also stored as the insertion point of
the text.

If the TEXTED system variable is set to 1, text created using TEXT displays the Edit Text dialog box. If
TEXTED is set to 2, the In-Place Text Editor is displayed.

You can enter special characters and format text by entering Unicode strings and control codes.

Note: Text that would otherwise be difficult to read (if it is very small, very large, or is rotated) is
displayed at a legible size and is oriented horizontally so that you can easily read and edit it.

=
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The following prompts are displayed.

Start Point

Specifies a start point for the text object. Enter text in the In-Place Text Editor for single-line text.

The Specify Height prompt is displayed only if the current text style is not annotative and does not have a
fixed height.

The Specify Paper Text Height prompt is displayed only if the current text style is annotative.
height
.
f&D{:’P?{‘
P al

1 rotation angle

Justify

Controls justification of the text.

You can also enter any of these options at the Specify Start Point of Text prompt.
Left
Left-justifies the text at the baseline, which you specify with a point.

ALUTOCAD
LITOCAD

1

Center
Aligns text from the horizontal center of the baseline, which you specify with a point.

The rotation angle specifies the orientation of the text baseline with respect to the center point. You
can designate the angle by specifying a point. The text baseline runs from the start point toward
the specified point. If you specify a point to the left of the center point, the text is drawn upside
down.

ALTQCAD
1

Right
Right-justifies the text at the baseline, which you specify with a point.

AUTOCAL

Align
Specifies both text height and text orientation by designating the endpoints of the baseline.

The size of the characters adjusts in proportion to their height. The longer the text string, the shorter
the characters.

MDT Internal Use Only 207



101 — AutoCAD Fundamentals for Microstation Users User Guide

312.7 FOR 28

12 1LF FPUR 285
-:,'U":.— ‘-,l:; Fl:___-.'_;«.:_;

FIT—4 REQ.—-EQ, 5P,

Middle

Aligns text at the horizontal center of the baseline and the vertical center of the height you specify.
Middle-aligned text does not rest on the baseline.

The Middle option differs from the MC option in that it uses the midpoint of all text, including
descenders. The MC option uses the midpoint of the height of uppercase letters.

ALUTECAD

i

Fit
Specifies that text fits within an area and at an orientation defined with two points and a height.
Available for horizontally oriented text only.
$12.7 FOR ¢8
BLSHING=PRESS
FIl-4 REG-ED. SP.
The height is the distance in drawing units that the uppercase letters extend from the baseline.
Designated text height is the distance between the start point and a point you specify. The longer
the text string, the narrower the characters. The height of the characters remains constant.
TL (Top Left)
Left-justifies text at a point specified for the top of the text. Available for horizontally oriented text
only.
1
AUTOCAD

TC (Top Center)

Centers text at a point specified for the top of the text. Available for horizontally oriented text only.

1
AUTOCAD

TR (Top Right)

Right-justifies text at a point specified for the top of the text. Available for horizontally oriented text
only.

I BTAN-1L
AUTOCAD

ML (Middle Left)
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Left-justifies text at a point specified for the middle of the text. Available for horizontally oriented
text only.

PAUTOCAD

MC (Middle Center)

Centers the text both horizontally and vertically at the middle of the text. Available for horizontally
oriented text only.

The MC option differs from the Middle option in that it uses the midpoint of the height of uppercase
letters. The Middle option uses the midpoint of all text, including descenders.
1.
AlLTECAD
MR (Middle Right)

Right-justifies text at a point specified for the middle of the text. Available for horizontally oriented
text only.

o b TR
I-\_-“-\_-'u"'._'l

Al
BL (Bottom Left)
Left-justifies text at a point specified for the baseline. Available for horizontally oriented text only.

ALTOCAL

BC (Bottom Center)

Centers text at a point specified for the baseline. Available for horizontally oriented text only.

ALTOCAD

1

BR (Bottom Right)

Right-justifies text at a point specified for the baseline. Available for horizontally oriented text only.

ALTOCAD

1
Style

Specifies the text style, which determines the appearance of the text characters. Text you create uses the
current text style.

Entering ? lists the current text styles, associated font files, height, and other parameters.
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II III'_.F--l.i--
AUT O

AUTO {?,ﬂl 2

..d—\- = 0
'""Il-!"!-' | H._.-'S.-'Il_ll

various styles

o
i
L=y

Create Single-line Text

For short, simple notes and labels, use single-line text.

1. Click Home tab * Annotation panel * Single Line Text. I\

2. Specify the insertion point.

If you press ENTER, the program inserts the new text immediately below the last text object
you created, if any.

3. Enter a height or click to specify the height of the text.

Note: If a specific text height is set in the current text style, this prompt is skipped.
4. Enter an angle value or click to specify the rotation angle.
5. Enter the text.

“=| | Note: While typing, the text may be displayed horizontally and at a legible size.

6. To create another single-line text, do one of the following:
o Press ENTER to start another line of text immediately below.
o Click a location for the next text object.

7. Press ENTER on a blank line to end the command.

Create Multiline Text

For longer notes and labels with internal formatting, use multiline text.

1. Click Home tab * Annotation panel * Multiline Text. M
2. Specify opposite corners of a bounding box to define the width of the multiline text object.

If the ribbon is active, the Text Editor contextual tab displays.

Text Editor

« A Annotative A - ,&" simplex
- Ao 1 T ¥ u o [ Bytaye

54 Match
. Mask . = Ho

Formatting «

A Annotative _|IJE.tifi'CEti|:|r'l

If the ribbon is not active, the Text Formatting toolbar displays.
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Text Formatting
| Standard \f|~zg§\simplex v A |B I A0 0 % v o l’a-||:|B)rLa)rer V| r"_"r|| oK | (™)
| E~| S| E==2 = =] 2| B| %a % ¥ x| @] ¢/ 0000 ] abiooo E| o 1000

=/ | Note: The MTEXTTOOLBAR system variable controls the display of the Text Formatting toolbar.

3. Specify the initial formatting.

o Toindent the first line of each paragraph, drag the first-line indent slider on the
ruler. To indent the other lines of each paragraph, drag the hanging indent slider.

o To set tabs, click the ruler where you want a tab stop.

o To change the current text style, select the desired text style from the drop-down

list.
f"sz ine
ndent tab stop
tab style hanging
\ /indent
V£
L l/ll’ | I I I [ 1 k! |I.¢\

123 [ > wan
\

corner

height resizer

resizer
4. Enter the text.
Note: While typing, the text may be displayed horizontally and at a legible size.

5. To change individual characters, words, or paragraphs, highlight the text and specify the
formatting changes.

=| | Note: SHX fonts do not support boldface or italics.

6. To save your changes and exit the editor, use one of the following methods:

o On the Text Editor ribbon contextual tab, in the Close panel, click Close Text
Editor.

o Click OK on the Text Formatting toolbar.
o Click in the drawing outside the editor.
o Press Ctri+Enter.

Press Esc to exit the editor without saving your changes.
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About Multiline Text Format
Justification

Justification of multiline text objects controls both text alignment and text flow relative to the text insertion
point. Text is left-justified and right-justified with respect to the boundary rectangle that defines the text
width. Text flows from the insertion point, which can be at the middle, the top, or the bottom of the resulting
text object.

Note: If a single word is longer than the width of the paragraph, the word will extend beyond the paragraph
boundary.

Columns

You can create and edit multiple columns in multiline text using the In-Place Text Editor column options
and column grips. Editing columns using grips allows you the flexibility of seeing the changes as you make
them.

Columns follow a few rules. All columns have equal width and equal gutters. A gutter is the space between
columns. The height of columns remains constant unless more text than the column can accommodate is
added, or you manually move the editing grip to adjust the column height.

When you are working with columns in the In-Place Text Editor, the columns are in a frame. The ruler bar
spans across all columns, but is only active for the current column.

|_I||||||||||||||||||||||||||||l4 alg

rips onthe corners wark similar as legacy
MTEXT grips. When the width of the object i=
changed by mowing one of the four grips, the
change will be evenly distributed to e ach
gutter.

The minimum gutter width = 0. Any changes
beywond that will be ignored. For example, as
Grip 2 is mowing for the left, the gutter width
keaps decreasing.

Once the grip passes a certain pointwhere
gutter width is 0, further mowement of the grip

to the left will not change the gutter waith ary

mare. hlowing this grip will not affect column
width.

Grips onthe corners wak similar as legacy
MTEXT grips. When the width of the objectis
changed by mowing one of the four grips, the
change will be evenby distributed to each
gutter.

Once the grip passes a certain pointwhere
gutter width i 0, further movement of the grip
ta the left will not change the gutter with any
mare. howing this grip will not affect column
width.

Adding text to a column with an arbitrary height will not increase the column height even if text is already
filling the column. Text flows into another column. You can also insert a column break to force text to start
flowing into the next column. Anytime a column break is inserted, it is assumed that the current height of
the column is fixed.
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Tabs and Indents

Sliders on the ruler show indentation relative to the left side of the bounding box. The top slider indents the
first line of the paragraph, and the bottom slider indents the other lines of the paragraph.

The long tick marks on the ruler show the default tab stops. If you set your own tabs, the ruler displays a
small, marker at each custom tab stop. The marker indicates the type of tab stop; left, center, right or
decimal.

|_[||||||||||||||l-vlb I.[||_||_||||_||||||i-qr
Thisis a multiline text. Thisis a multiline text.
text] text]
temxt? text?
et text3

Paragraph and Line Spacing

You can control paragraph spacing and paragraph line spacing in multiline text. Paragraph spacing
specifies the spacing before or after the current or selected paragraphs. Line spacing for multiline text is
the distance between the baseline (bottom) of one line of text and the baseline of the next line of text. When
you change line spacing, it applies to the spacing in the current or selected paragraphs, not to selected
lines.

Bullet and Numbered Lists

You can create bulleted lists, lettered or numbered lists, or simple outlines in multiline text. When you add
or delete an item, or move an item up or down a level, the list numbering automatically adjusts. You can
remove and reapply list formatting with the same method as used in most text editors.

When you apply list formatting, you can specify bullets, uppercase or lowercase letters, or numbers. Default
settings are used for the type of list you choose. Letters or numbers are followed by a period. Nested lists
use a double bullet, letter, or number. Items are indented based on the tab stops on the ruler in the In-Place
Text Editor.

By default, list formatting is applied to all text that looks like a list. Text that meets all the following criteria
is considered to be a list:

e The line begins with one or more letters or numbers or a symbol.

e The letters or numbers is followed by punctuation.

e A space after the punctuation is created by pressing Tab or Space.

e The text following the space is ended by Enter or Shift+Enter.

Note: If you do not want list formatting applied to all text that fits the criteria, clear the Allow
‘\% Bullets and Lists option. (Right-click in the In-Place Text Editor, click Bullets and Lists Allow

Bullets and Lists.) When Allow Bullets and Lists is not checked, you cannot create new formatted
lists in the multiline text object.
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The following characters can be used as punctuation after the number or letter when you type a list but
cannot be used as bullets:

Character Description

Period

Colon
) Close parenthesis
> Close angle bracket
] Close square bracket
} Close curly bracket

Stacked Characters

Stacked text refers to the fraction and tolerance formats applied to characters within multiline text objects
and multileaders. Characters representing fractions and tolerances can be formatted to conform to several
standards.

B 8

& &

& &

. 054-.057DIA-2HOLES HN_ g5 DIA-2HOLES
unstacked text tolerance stack

[]

a 13 @ GALV.STL. POSTS

=3

diagonal fraction vertical fraction
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You use special characters to indicate how selected text should be stacked.

o Forward slash (/) stacks text vertically, separated by a horizontal line.
e Pound sign (#) stacks text diagonally, separated by a diagonal line.
e Caret (M) creates a tolerance stack, which is stacked vertically and not separated by a line.

By default, numeric characters entered before and after a forward slash, pound sign, or caret stack
automatically. For tolerance stacking, the plus sign (+), minus sign (-), and decimal point (.) also stack
automatically.

How To Work With Lists in Multiline Text

Follow these basic steps to work with lists in multiline text.
1. Create or edit a multiline text object.

o Insert. Click Home tab * Annotation panel *» Multiline Text. A
o Edit. Double-click the multiline text object.

2. Right-click in the editor. Click Bullets and Lists and verify that Allow Bullets and Lists and
Allow Auto Bullets and Numbering are checked.

Follow the steps as described in the following sections to work with lists.
4. To save your changes and exit the editor, use one of the following methods:

o On the Text Editor ribbon contextual tab, on the Close panel, click Close Text
Editor.

o Click OK on the Text Formatting toolbar.
o Click in the drawing outside the editor.

Note: Press Esc to exit the editor without saving your changes.

Create a Lettered or Numbered List as you Type

1. Enter a letter or a number and punctuation. The following characters can be used as
punctuation after letters and numbers:

o Period.

o Colon:

o Close parenthesis )

o Close angle bracket >

o Close square bracket ]

o Close curly bracket }
2. Press TAB.

3. Enter the text for the list item. Press ENTER to proceed to the next item, or press
SHIFT+ENTER to add a plain paragraph before the next item.

The item is automatically lettered or numbered in sequence.

4. Press ENTER twice to end the list.
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Create a Bulleted List as you Type
1. Use one of the following methods to select the bullet character:

o Enter U+2022, the Unicode string for a bullet.

o On the Text Editor ribbon contextual tab, in the Paragraph panel, click Bullets and
Numbering Bulleted.

o Copy and paste a character from the Character Map.
2. Press TAB.

3. Enter the text for the list item. Press ENTER to proceed to the next item, or press
SHIFT+ENTER to add a plain paragraph before the next item.

The bullet character is automatically added to the next item.

4. Press ENTER twice to end the list.
Convert Existing Paragraphs to a List
1. Select the paragraphs to convert.

2. Onthe Text Editor ribbon contextual tab, Paragraph panel, click Bullets and Numbering, and
select from the following:

o Numbered. Uses numbers with periods for the items in a list.

o Lettered = Uppercase or Lowercase. Uses letters with periods for the items in
a list. If the list has more items than the alphabet has letters, the sequence
continues by using double letters.

o Bulleted. Uses a bullet or other character for the items in a list.
3. To add new list items, enter the text.
4. Press ENTER twice to end the list.
Move a List Item Down a Level
1. Place the cursor at the beginning of a list item and press TAB.
The item moves down one level and begins a nested list.

2. Press ENTER to start the next item at the same level or press SHIFT+TAB to move the item
up a level.

Restart Numbering a Part of an Existing List

1. Select a sequence of list items or place the cursor at the beginning of the item where you
want to start the new list.

2. Right-click in the editor. Click Bullets and Lists » Start.

The selected items are renumbered as a separate sequence. If you select items in the middle
of a list, unselected items below the selected items also become part of the new list.
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Modifying Multiline Text

You can change the contents, formatting, and properties of multiline text.

How To: Edit Multiline Text
1. Double-click a multiline text object.

2. Inthe In-Place Text Editor, enter the new text.
3. To save your changes and exit the editor, use one of the following methods:

o Onthe Text Editor ribbon contextual tab, on the Close panel, click Close Text
Editor.

o Click OK on the Text Formatting toolbar.
o Click in the drawing outside the editor.
Press Esc to exit the editor without saving your changes.

How To: Change Multiline Text Properties
Select a multiline text object.

1
2. Right-click the selected object and select Properties.

3. Justification. To change the justification, select one of the Justification options.
4. Line Space Style. To change the line space style, select one of the following:

o At Least. Adjusts lines of text automatically based on the height of the largest
character in the line. More space is added between lines of text with taller
characters. This is the default setting.

o Exactly. Forces the line spacing to be the same size for all lines of text regardless
of format differences such as font or text height.

5. Line Spacing. To change the line spacing, enter a new value for either of the following
options:

o Line Space Factor. Sets the line spacing to a multiple of single-line spacing.
Single spacing is 1.66 times the height of the text characters.

o Line Space Distance. Sets the line spacing to an absolute value measured in
drawing units. Valid values must be between 0.0833 and 1.3333.

Note: After you exit the Properties palette, the value of the other line spacing option is updated
to correspond with the line spacing value that you entered.

6. Frame. To add a frame to the text object, set Text Frame to Yes.

o Note: The frame inherits all the properties of the text object such as color, linetype, transparency,
\E and layer.
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Set Paragraph and Line Spacing
1. Double-click a multiline text object.

2. Select the paragraphs that you want to change. If no paragraphs are selected, the changes
are applied to the current paragraph.

3. Right-click in the editor and select Paragraph.
4. Inthe Paragraph dialog box, do any of the following:

o To add space before and after paragraphs, check Paragraph Spacing and enter
before and after values.

o To add spacing between the lines within paragraphs, check Paragraph Line
Spacing and select a spacing option and enter a value.

How To: Change the Width of Multiline Text
1. Double-click the multiline text object.
2. Inthe In-Place Text Editor, use one of the following methods:

o Move the cursor over the right boundary of the text frame until the cursor changes
to a double arrow. Drag the cursor to adjust the width. For multiple columns, drag
the first column boundary to set the width for all columns.

i -
= :

>

o Move the cursor over the right end of the ruler until the cursor changes to a double
arrow. Drag the cursor to adjust the width. For multiple columns, drag the first
column ruler to set the width for all columns.

L] =

o Right-click the bottom of the ruler. Click Set Mtext Width. Enter the width in
drawing units. For multiple columns, the width is distributed evenly to each column
gutter.

How To: Format Characters in Multiline Text
1. Double-click the multiline text object.
2. Select the text that you want to format.

3. On either the Text Editor contextual tab or Text Formatting toolbar, make format changes as
follows:

o Font: To change the font of the selected text, select a font from the list.

o Height: To change the height of the selected text, enter a new value in the Height
box.

o Format: T o format text with boldface, italics, underlined, overlined, or
strikethrough, click the corresponding button.
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Note: SHX fonts do not support boldface or italics.

Color. To apply color to selected text, select a color from the Color list. Click Other
to display the Select Color dialog box.

Oblique. To set an obliquing angle for the text, enter a value between -85 and 85.
A positive value slants text to the right. A negative value slants text to the

(.0000 =
left. o/ -

Spacing. To change letter spacing in the selected text, enter a new

ash 1.0000 =
value.

Character width. To change the width of characters in the selected text, enter a

1.0000 =
new value. — -

How To: Set Indentation and Tabs

1.
2.
3.

Double-click the multiline text object.

Select the paragraphs that you want to indent.

On the ruler, slide the top indent marker to where you want the first line of each paragraph to

start.

Slide the bottom indent marker to where you want the other lines of each paragraph to start.

This step indents turnover lines in paragraphs that are more than one line long.

To work with tabs, select the paragraphs you want to change, and do any of the following:

o

o

o

Style. Click the tab style until the tab type you want is displayed.
Insert. Click the location on the ruler for the new tab.
Move. Drag an existing tab to a new location on the ruler.

Delete. Drag a tab off the ruler.

f"sz ine
ndent . tab stop
tab style hanging
\ /indent
T T—F
|_JI||||||||||_||l¢

23

= Note: Right-click in the editor and select Paragraph to specify indentation and tabs on the
Paragraph dialog box.
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Exercises: Adding Text to a Drawing

In these exercise you use the Multiline Text command to add notes to a drawing. You will
also modify several text options.

You do the following:

e Start the Multiline Text command.

e Specify text location.

e Type text.

e Adjust text style.

e Spell check text.

e Adjust text justification and indentation.
e Insert common symbols.

In this exercise you will use the Multiline Text command to add several room labels
to adrawing. You will also modify existing text to match.

— — F——  — p——

I DINING ROOM

I GARAGE

LIVING ROOM

BEDROOM BEDROOM

——————————————————————————

= = ——

1. Open drawing 12.1.1 Text 1.dwg.
You will begin by setting the current layer and text style.

2. Set TEXT as the current layer.

3. Select Ribbon: Annotate = Text = Text Style drop- A “edl Room Labels
down, then select Room Labels to set it as the current B
Multiline
text style. T " A6
Text =

Next you will add a label to the dining room.
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4. Select Ribbon: Annotate = Text = Multiline Text.

5. Pick two diagonal points in the upper-left room to place the
text box.

6. Confirm that the text height is set to 6", located at
Ribbon: Text Editor = Style = Text Height.

Multiline
Text

Reom Labels -

Text «

I

AaBb1]

« A Annotative

AaBbi23

6 -

Roman Room Labels . o
Style
Why was the height set to 6"? The drawing will be printed at the scale of 1/4" = 1'-0",
which is a scale factor of 48 (12" divided by 1/4" = 48). This means that everything is
scaled down 48 times to fit on the paper. The printed room labels should be 1/8" tall on
the paper. Multiplying the desired height (1/8") by the scale factor (48) results in the value
6".
7. Atthe keyboard, type the text DINING
ROOM, then select Ribbon: Text Editor
= Close = Close Text Editor. DINING ROOM
8. Repeat the process to add room labels to the remaining rooms as shown.
You may find it faster to copy the DINING ROOM label to the other rooms, then edit the
copies to change the text.
—— —
BATH \
DINING ROOM
BEDROOM
] BaTH j .
_______ Iﬂ
LIVING ROOM ‘_‘ : \
BEDROOM BEDROOM
r —AF———AdF—A J\ ————— ———
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Next you will modify the GARAGE label to match the others.

9. Double-click on the GARAGE label to open the text editor.

The text has a red underline, indicating that it is ;
misspelled. ‘ '

GARRAGE.

lo

10. Right-click on the text, then select the | L caRace
correctly spelled version from the ARRANGE

context menu. GA R RA GARAGED

"""""""""""" Mare Suggestions >

s

Add to Dictionary

Ignore All

The text was not created in the correct style.

11. Select Ribbon: Text Editor = Style = Room » ) ~ A Annotative

Labels, to set it as the text style for the label. 0Bb1Y[AaBbi23 f -
Roman Room Labels A Mask

It may be necessary to click the drop-down arrow to view all text E— )
styles.
By default, AutoCAD will display a dialog box indicating Multiline Text - Text Style Change %

that changing a text style affects the entire text box, not

just the selected text This change will affect all text objects using this

style, not just the selection. Do you want to

12. Click <<Yes>> to apply the style change. change the text style?

[0 Amways change the text style Yes No

Finally, you will adjust the text height. In contrast to the text style, changes in text height
are only applied to selected text.

13. Click and drag to select the GARAGE text.

14. Select Ribbon: Text Editor = Style = Text Height — ]~ A Annotative
drop-down, then select 6". AaBb1Y| daBbi23 | o
Roman Room Labels y NRTERS
Style

The GARAGE label now matches the other labels.
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15. Select Ribbon: Text Editor = Close = Close Text Editor.

v

Cloze
Text Editor
Cloze
16. Save the drawing.
In this exercise you will use the Multiline Text command to add notes to a drawing.
You will also make several modifications to the text.
@0.81
+
GENERAL NOTES:
1. MATL SAE 1020 STEEL.
2. ALLDIMENMSIONS IN INCHES UNLESS
OTHERWISE SPECIFIED.
3. DIMENSIONS ARE SYMMETRICAL ABOUT
275 @1.60 CYLINDER.
) 4. ALLDIMENSIONS 202 UNLESS
OTHERWISE SPECIFIED.
SN I 5. FILLETS AND ROUNDS R.01 UNLESS
o _J: _L 1_ :L_ - OTHERWISE SPECIFIED.
I “l . lf_ 1 6. BREAK ALL SHARP EDGES.
| |
| | |
T
1. Open drawing 12.1.2 Text 2.dwg.
2. Set Endpoint as a Running Object Snap.
You will begin by setting the layer and text style.
3. Set TEXT as the current layer.
4. Confirm that Standard is the current text style, A sefl Standard -
located at Ribbon: Annotate = Text = Text Style. 2
Multiline b
Tet ~ [A] 0.2000 -
Text = §
Next you will add several lines of notes.
5. Select Ribbon: Annotate = Text = Multiline A Standard -
Text. o 3
Multiline *
Tedt p A 0.2000 -
Text = o

A rectangle has been added to the drawing to act as a guide for placing the text.
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6. Click the upper-left, then lower-right corners of the
rectangle.
O
fe]
7. Select Ribbon: Text Editor = Style = Text A Annotative
Height, then type .125 and press [Enter] at the AaBb123 || AaBb123 | (T -
keyboard_ A Annotative Standard - N
Style
Be sure to select the existing value before typing. Do not
select the drop-down arrow. After the value has been added
for the first time it will be available in the drop-down list.
8. Type the following text exactly as it appears. Press llets and Numbering ~ | == @\.
[Enter] at the keyboard after each line. To place == 2

the symbols for diameter and plus/minus, select
Ribbon: Text Editor = Insert = Symbol.

GENERAL NOTES:
MATL SAE 1020 STEEL.

e Spacing ~

Degrees %%d
Plus/Minus %%p

Diameter %:%c

Columns ~ Symbol

ALL DIMENSIONS IN INCHES UNLESS OTHERWISE SPECIFIED.
DIMENSIONS ARE SYMMETRICAL ABOUT @1.60 CYLINDER.
ALL DIMENSIONS +.02 UNLESS OTHERWISE SPECIFIED.
FILLETS AND ROUNDS R.01 UNLESS OTHERWISE SPECIFIED.

BREAK ALL SHARP EDGES.

9. Select Ribbon: Text Editor = Close = Close Text Editor.

Next you will make several changes to the text.

10. Double-click on the text to open the Text Editor.

v

Close
Text Editor

Close
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11.

12.

13.

14,

15.

16.

Click and drag to select the text GENERAL
NOTES..

Select Ribbon: Text Editor = Formatting =
Underline.

Click and drag to select all of the text except
GENERAL NOTES..

Select Ribbon: Text Editor = Paragraph =
Bullets and Numbering, then select
Numbered from the drop-down list.

Locate the diamond icon on the far right of the
ruler at the top of the text window.

Click and drag the diamond to the left to reduce
the width of the text box.

The rows of text will begin wrapping to multiple lines.

L[ v
AATI CAE 1N2N QTEFI

Matclg

Q

=Y = 1T Arial
B Eylayer
=1 L34

[ ]

Formatting ~

" GENERAL NOTES:

v Off
i= Numbered %

Lettered
Bulleted

i= Bullets and Numbering ~

Ll

RS —
GENERAL NOTES:
1. MATL SAE 1020 STEEL.

2. ALL DIMENSIONS IN INCHES UNLESS

OTHERWSE SPECIFIED.
3. DIMENSIONS ARE SYMMETRICAL
ABOUT @1.60 CYLINDER.

17. Release the diamond when the text appears as 4. ALL DIMENSIONS +.02 UNLESS
shown OTHERWISE SPECIFIED.
' 5. FILLETS AND ROUNDS R.01 UNLESS
OTHERWISE SPECIFIED.
6. BREAKALL SHARP EDGES.
18. Click anywhere in the first row of text (that reads GENERAL NOTES).
19. Click Ribbon: Text Editor = Paragraph = Center. |A_| I B
Jus:caizion I_§ LineS_acing '_ —
- === ==
Paragraph | 3 N
20. Click Ribbon: Text Editor = Close = Close Text Editor. \/
Close
Text Editor
Close
21. Erase the guide rectangle.
22. Save the drawing.
MDT Internal Use Only 225



101 — AutoCAD Fundamentals for Microstation Users User Guide

3.1.2 Multileaders

About Creating Leaders

You can create a leader line from any point or feature in a drawing and control its appearance as you draw.
Leaders can be straight line segments or smooth spline curves.

) Stranght leader
Spline leader

A multileader object, or mleader, comprises a leader and a note. It can be created arrowhead first, tail first,
or content first. If a multileader style has been used, then the multileader can be created from that style

Multileader objects can contain multiple leader lines, each of which can have one or more segments, so
that one note can point to multiple objects in your drawing. You can modify the properties of leader segment
in the Properties palette. Add leaders to or remove leaders from a multileader object with MLEADEREDIT
or choose options from the leader grip menus.

Annotative multileaders containing multiple leader segments can have different head points in each scale
representation. Horizontal landings and arrowheads can have different sizes, and landing gaps can have
different distances, depending on the scale representation. The appearance of the horizontal landing within
a multileader, as well as the type of leader line (straight or spline) and number of leader segments will
remain the same in all scale representations.

Arranging Leaders

Multileaders can be arranged to add order and consistency to your drawing.

Multileader objects with blocks as content can be collected and attached to one landing line. Using
MLEADERCOLLECT, multileaders can be collected horizontally, vertically, or within a specified area
depending on your drawing needs.
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Standard v Ve

Collect Multileaders

Organizes selected multileaders that contain blocks into rows
or columns, and displays the result with a single leader line

; MLEADERCOLLECT

Press F1 for more help

before MLEADERCOLLECT after MLEADERCOLLECT

el &)

Multileader objects can be sorted evenly along a specified line. Using MLEADERALIGN, selected
multileaders can be aligned and evenly spaced as specified.

Associate Leaders with Objects

When associative dimensioning is turned on, the leader arrowhead can be associated with a location on an
object using an object snap. If the object is relocated, the arrowhead remains attached to the object and
the leader line stretches, but the multiline text remains in place.

3.1.3 Dimensions

About the Types of Dimensions

You can create several types of dimensions for a variety of object types in many orientations and
alignments.

The basic types of dimensioning are linear, radial, angular, ordinate, and arc length. Use the DIM command
to create dimensions automatically according to the object type that you want to dimension.

You can control the appearance of dimensions by setting up dimension styles, or by editing individual
dimensions in special cases. Dimension styles allow you to specify your conventions quickly and maintain
industry or project dimensioning standards.

Tip: To simplify drawing organization and dimension scaling, you can create dimensions on
layouts rather than in model space.

=
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Linear Dimensions

Linear dimensions can be horizontal, vertical, or aligned. You can create an aligned, horizontal, or vertical
dimension with the DIM command depending on how you move the cursor when placing the text.

T 2 =
N> \i

In rotated dimensions, the dimension line is placed at an angle to the extension line origin points. In this
example, the angle specified for dimension rotation is equal to the angle of the slot.

12'

Note: You can also create linear dimensions with extension lines that are not perpendicular to their
dimension lines. These are called obliqgue dimensions and they are most commonly used with isometric
drafting. In this case, the dimension line angles will be oriented at 30 and 60 degrees depending on the
current isoplane.

Radial Dimensions

A radial dimension measures the radius or diameter of arcs and circles with an optional centerline or center
mark. Several options are displayed in the illustration.

;)—RE' ;Eﬁd' );—RE mim 594 mm
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Note: When part of the dimension is located within the dimensioned arc or circle, the non-
associative centerline or center mark is automatically suppressed.

=

Angular Dimensions

Angular dimensions measure the angle between two selected geometric objects or three points. From left
to right, the example shows angular dimensions created using a vertex and two points, an arc, and two

—~ X"
O o

-
©
!

Ordinate Dimensions

30°

Ordinate dimensions measure the perpendicular distances from an origin point called the datum, such as
a hole in a part. These dimensions prevent escalating errors by maintaining accurate offsets of the features
from the datum.

Important: The datum is established by the current location of the UCS origin.

60 — D . @
o
0—+p P
| | | |
= s £ g8 8 g

In this example, the datum (0,0) is indicated as the hole in the lower-left corner of the illustrated panel.

Arc Length Dimensions

Arc length dimensions measure the distance along an arc or polyline arc segment. Typical uses of arc
length dimensions include measuring the travel distance around a cam or indicating the length of a cable.
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To differentiate them from linear or angular dimensions, arc length dimensions display an arc symbol by

default. The arc symbol, also called a hat or cap, is displayed either above the dimension text or preceding
the dimension text.

30 mm

Baseline and Continued Dimensions

Continued dimensions, also called chained dimensions, are multiple dimensions placed end-to-end.

@ ©

@Goo@

Baseline dimensions are multiple dimensions with offset dimension lines measured from the same location.

@D ©®

@o'oo@

l———— T[] ————=
- 100 -
- 130 =
~ 170 -
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Note: Before you can create continued or baseline dimensions, you must first create a linear,
% . . . . . -

=/ | angular, or ordinate dimension to act as a base dimension from which to reference the
subsequent dimensions.

Current Layer Override

By default, all new objects are created on the current layer. For new dimension objects, you can specify a
default layer that's different than the current layer by specifying the layer with the DIMLAYER system
variable.

Rotated Views

Leader landings, components of dimensions, and text objects determine their horizontal and vertical
directions from the UCS axes at the time when they are created. If a view in a drawing is rotated, you can
first use the UCS /View option to set the horizontal and vertical directions relative to the drawing rather than
the rotated view.

Dimension Styles Overview

A dimension style is a named collection of dimension settings that controls the appearance of dimensions,
such as arrowhead style, text location, and lateral tolerances.

You create dimension styles to specify the format of dimensions quickly, and to ensure that dimensions
conform to industry or project standards.
e When you create a dimension, it uses the settings of the current dimension style.

e |f you change a setting in a dimension style, all dimensions in the drawing that use the style
update automatically.

e You can create dimension substyles that use specified settings for different types of
dimensions.

e You can override a dimension style with dimension settings that deviate from the current
dimension style.

e All dimension styles in your drawing are listed in the Dimension Style drop-down.

Working with Linear Dimensions

Create linear dimensions with horizontal, vertical, and aligned dimension lines. Create baseline or
chained dimensions. Place dimension lines at an angle to the extension lines or make extension
lines oblique.

How To: Create Horizontal, Vertical, or Aligned Dimensions

Click Annotate tab * Dimensions panel * Dimension. ﬁ
Select a line or specify the first and second extension line origin points.
Move your pointing device to the desired position and orientation of the dimension.

Before specifying the dimension line location, you can edit or rotate the text.

a > D

Click to place the dimension line.
6. Repeat steps to continue dimensioning or press Enter to end dimensioning.

Continued, baseline, and ordinate dimensions can be created using the options in this command.
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How To: Create a Linear Dimension with Angled Extension Lines
Click Annotate tab * Dimensions panel * Linear. "_.‘
Specify the first and second extension line origin.

At the prompt, enter r (Rotated).

Enter an angle for the dimension line.

o > 0w N E

Click to place the dimension line.
How To: Create a Continued or Chain Dimension

1. Click Annotate tab * Dimensions panel * Continue. |"H

2. If prompted, select the dimension to continue.

Note: This prompt is skipped if the first extension line origin can be assumed from the origin of
the second extension line of the last created linear or angular dimension.

3. Use object snaps to specify additional extension line origins.
4. Press Enter twice to end the command.

How To: Create a Baseline Dimension
1. Click Annotate tab *> Dimensions panel > Baseline. t—_-l'

2. If prompted, select the base dimension.

Note: This prompt is skipped if the first extension line origin can be assumed from the last created
linear or angular dimension.

3. Use an object snap to select the second extension line origin, or press Enter to select any
dimension as the base dimension.

The second-dimension line is automatically located at the distance specified by the Baseline
Spacing option in the Dimension Style Manager, Lines tab.

4. Use an object snap to specify the next extension line origin.

5. Continue to select extension line origins as needed.

6. Press Enter twice to end the command.

How To: Modify a Dimension to Specify Oblique Extension Lines

1. Click Annotate tab * Dimensions panel > Oblique. I
2. Select a linear dimension.

3. Enter a value for the angle of obliqueness or specify two points.
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Working with Radial Dimensions

Create radius or diameter dimensions of arcs or circles.

How To: Create a Radius or Diameter Dimension

Click Annotate tab * Dimensions panel » Dimension. ﬁ

Select an arc or a circle.

At the prompt, enter r (Radius) or enter d (Diameter).

Before specifying the dimension line location, you can edit or rotate the text.

Click to place the dimension line.

o g~ w N PE

Repeat steps to continue dimensioning or press Enter to end dimensioning.

How To: Create a Jogged Radius Dimension

Click Annotate tab * Dimensions panel » Dimension. ﬁ

1.
2. Hover over an arc or a circle.
3. At the prompt, enter j (Jogged).
4. Select the arc or circle.
5. Click to specify a point for the false-center dimension origin, called the center location
override.
R1.00

4

6. Click to specify a point for the dimension line angle.
7. Click to specify the location of the dimension jog.
8. Repeat steps to continue dimensioning or press Enter to end dimensioning.

How To: Create an Angular Dimension

1. Click Annotate tab * Dimensions panel > Dimension. ﬁ

N

At the prompt, enter a (Angular).
3. Select one of the following:
o Anarc
o A circle and two points
o Two nonparallel lines
o A vertex and two points
4. Before specifying the dimension line location, you can edit or rotate the text.
Click to place the dimension line.

6. Repeat steps to continue dimensioning or press Enter to end dimensioning.
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How To: Create an Ordinate Dimension

Ordinate dimensions measure the perpendicular distances from an origin point called the datum, such as
a hole in a part. The datum is established by the current location of the UCS origin.

60 —H-P . @

& o

0 D Ep

/ T
= s ® g8 g ¢

1. Move the UCS origin to the datum.

Ty

Click Annotate tab * Dimensions panel > Dimension. ﬁ
At the prompt, enter o (Ordinate).
If you do not want jogs in the ordinate leaders, turn on Ortho mode [F8].

Specify a point for the feature location.

o g > w N

Specify a leader endpoint.

Note: You can also specify an X- or Y-datum to determine the orientation of the dimension
= location and dimension text.

You can use polar tracking to line up the text of the ordinate dimensions.

How To: Create an Arc Length Dimension

Click Annotate tab » Dimensions panel » Dimension. ﬁ
Hover over an arc or an arc segment in a polyline.

At the prompt, enter L (Arc Length).

Select the arc or the arc segment in a polyline.

Click to place the dimension line.

o g > w N P

Repeat steps to continue dimensioning or press Enter to end dimensioning.
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How To: Create Multiple Types of Dimensions Within a Single Command Session

1. Click Annotate tab * Dimensions panel > Dimension. "_.‘
2. Hover the cursor over objects, lines, or points to preview the resulting dimension.
3. Select the objects or points to dimension.

The available options depend on the selected objects, lines, or points.

4. Modify the dimension options as desired.

5. Click where you want to insert the dimension.

6. Select other objects or points to create multiple dimensions.
7. Press Enter to end the command.

Associative Dimensions Overview

Dimensions can be associative, which mean that they adjust to changes in the geometric objects that they
measure.

Dimension associativity defines the relationship between geometric objects and the dimensions that give
their distance and angles. Several types of relationships are possible between geometric objects and
dimensions. Leader and multileader objects can also be associative.

e Associative dimensions automatically adjust their locations, orientations, and measurement
values when the geometric objects associated with them are modified. Dimensions in a layout
may be associated to objects in model space. These are created when the DIMASSOC system
variable is set to 2.

e Partially associative dimensions exist when only one extension line is associated with a
geometric object. This typically occurs when a geometric object associated with a dimension is
deleted.

e Non-associative dimensions can be selected and modified with the geometry they measure,
but they do not change automatically when the geometric objects they measure are modified.
These are created when the DIMASSOC system variable is set to 1.

o Exploded dimensions contain a collection of separate geometric and text objects rather than a
single dimension object. These are created when the DIMASSOC system variable is set to 0,
or when you apply the EXPLODE command to an existing dimension.

You can determine whether a dimension is associative or non-associative with the Properties palette or the
LIST command. You can use the DIMREASSOCIATE command to reassociate partially associative or non-
associative dimensions.

Tip: You can use DIMREGEN to update associative dimensions after panning or zooming model
‘“=| | space in a layout viewport, after opening a drawing that was modified with an earlier release, or
after opening a drawing with external references that have been modified.
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The Annotation Monitor

You can track annotations that lose associativity with the help of the annotation monitor. Associativity can
be lost for several reasons:

e Associativity is not maintained if an associated geometric object is modified significantly or
deleted.

e Associativity is not maintained if an associated block is redefined such that the edge that the
dimension is associated with is displaced.

When the annotation monitor is turned on, it identifies the annotations that have lost associativity by
displaying a badge. In the example, when the circle is erased, the dimension associativity is lost and a
badge displays on the affected dimension.

Clicking the badge, displays a menu with options that are specific to the disassociated annotation. In this
example, the menu provides access to the DIMREASSOCIATE and ERASE commands.
Special Situations and Limitations
Associative dimensions support most types of geometric objects that you would expect to dimension. They
do not support objects such as

e Hatches

e Images

e Underlays

e  Multiline objects

e 2D solids

ﬁ Note: Dimensions associated to model drawing views may lose their associativity if the drawing
is opened and re-saved in a pre-2012 release of AutoCAD.
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How To: To Work with Dimension Associativity

Add, redefine, or remove the associativity between dimensions and the objects that they measure.

How To: Associate or Reassociate a Dimension

1. Click Annotate tab * Dimensions panel > Reassociate. E—;‘
2. Select one or more dimensions to associate or reassociate.
3. Press Enter and do one of the following:

o To associate the dimension to a specific object, enter s (Select object) and select
the geometric object.

o Select the reference point on an object, using object snaps as needed, to
associate the indicated extension line.

4. Repeat steps as needed.

How To: Disassociate a Dimension
1. Atthe Command prompt, enter DIMDISASSOCIATE.

2. Select one or more dimensions to disassociate and press Enter.

How To: Control Whether New Dimensions Are Associative
1. Click Application button = Options.

2. In the Options dialog box, User Preferences tab, under Associative Dimensioning, select or
clear Make New Dimensions Associative.

3. Click Apply or OK.
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Exercises: Adding Dimensions to a Drawing

In these exercise you add dimensions to drawings to indicate several types of

measurements.

You do the following:

In this exercise you will add linear dimensions to a multi-view drawing.

Add Linear dimensions.

Add Aligned dimensions.

Add Angular dimensions.

Add Radius dimensions.

Add Diameter dimensions.

Add Continuous and Baseline dimensions.
Adjust dimension styles.

Add notes to dimensions.

~— 1.00 1.50

} /
075

3.75 2.50

1. Open drawing 12.2.1 Dimensioning 1.dwg.

2. Set Endpoint as a Running Object Snap.

The drawing consists of two views. You will add all the necessary linear dimensions to
fully describe the part.

3. Set Dimension as the current layer.

238
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4. Confirm that Standard is set as the current Standard T
Dimension Style, located at B = 5
Ribbon: Annotate = Dimensions = Dimension b Linear ~ [7] Quick | Continue -
Dimension Style drop-down = Standard. Dimend
IMENsSIONS ™
5. Select Ribbon: Annotate = Dimensions = Standard v T
Linear. e Use Current - m IE'I r_‘l
- Quick [ Continue ~
Hensions -
6. Click the bottom two endpoints of the front
view, then click below the view to place the
dimension.
While the endpoints in the example are numbered, they 1 2
can be selected in either order.
375
3
Next you will add dimensions to the angled feature in the right-side view.
7. Select Ribbon: Annotate = Dimensions = Standard v T
Linear. Dimencio Use Current - [4 1] [=]
[ Linear - Quick [{ Continue -
Nensions N

8. Click the two endpoints of the angled line, then
click above the view to place the horizontal
dimension.

1.00«‘ = 3
1
- )

The Linear dimension tool only allows you to create horizontal and vertical dimensions,
even if you are dimensioning an angled object.
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9. Select Ribbon: Annotate = Dimensions = Standard - T
Linear. Use Current » [+ 1=l [=]

10. Click the two endpoints of the angled line,
then click to the left of the view to place the
vertical dimension.

Next you will use object snaps to line dimensions up.

11. Select Ribbon: Annotate = Dimensions =
Linear.

12. Click the two endpoints of the upper horizontal
line, then select the endpoint of the previously
created dimension line.

Dimensio

[ Linear - Quick [ Continue -

3 0.75
1
Standard - —L—H : A
e Use Current - [+ =] [=]

Quick [ Continue ~

13. Repeat the process to add the remaining dimensions as shown.

~—1.00 1.0

e

3.75

14. Save the drawing.

2.50

240
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In this exercise you will add aligned and angular dimensions to a building. You will
also modify the building to see the effect of associative dimensioning.

25'-3"

1. Open drawing 12.2.2 Dimensioning 2.dwg.
2. Set Endpoint as a Running Object Snap.

You will begin by adding aligned dimensions. Unlike linear dimensions, which always
dimension horizontally or vertically, an aligned dimension can be created at an angle.

3. Set Dimension as the current layer.

4. Select Ribbon: Annotate = Dimensions = Architectural T«
Dimension Style drop-down = Architectural "_" Lg'luﬂurr&nt =Tl 13 =]
to set it as the current dimension style. Dimension F Linear ~ [7] Quick | Baseline -

Dimensions = §

This dimension style has been set up to display feet and inches, and fractions rather than decimals.

5. Select Ribbon: Annotate = Dimensions = Architectural - T

Aligned =
. = Use C t v || 2
Dimensic = S H H H
A, Aligned -] Quick | Baseline ~
Imensions * 3

6. Using endpoint object snaps for | |
accuracy, select the lower left-corner of L
the building, then the lower-right /
corner. Click below the building to
place the dimension.

25'-3 7

When dimensioning horizontal or vertical objects, the aligned dimension command works
identically to the linear dimension command.
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Next you will dimension an angled line.
7. Select Ribbon: Annotate = Dimensions = Architectural T
Allgned. Use Current - [+ =] [=]

8. Select the endpoints, then click to place the

dimension as shown.

Next you will place some angular dimensions.

9. Select Ribbon: Annotate = Dimensions =

10.

11.

Angular.

Select the two interior wall lines, then
click to place the angular dimension as
shown.

Repeat the process to create the other
angular dimension. The dimensioned
drawing appears as shown.

Dimensio

-0%] Quick = Baseline ~

Dimensic

Architectural

v I A

MigR=EE

Quick |= Baseline ~

25'-3"

N—
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Finally, you will modify the building by stretching the right side. Because the dimensions
are associative, they will update to the display the new lengths and angles.

12. Use the Stretch command to stretch /\
the right side of the building 24 inches ] \ﬁﬁ """""""""""""""""""
to the right. Refer to the example to the ] /* \m>\
right for the recommended location of \‘
the stretch crossing window.
120
! v
13. The completed drawing appears as ol
shown. ‘ [T
w l‘l‘ \ ::: \:\ |3'_341“
Notice that all dimensions have been updated. _/ BT TR T
T/

14. Save the drawing.

» }

In this exercise you will add radius and diameter dimensions to circular drawing
objects. You will also edit dimension text. Finally, you will add linear dimensions

and modify the precision of the values.

2625 2.625

R1.756 22 60

2X R0.50 2X @0.50
SO0 K]
1/

%

1N

1. Open drawing 12.2.3 Dimensioning 3.dwg.
2. Set Endpoint and Center as Running Object Snaps.

You will begin by adding diameter dimensions. Most drafting standards indicate that
diameter dimensions are added to full circles, while radius dimensions are added to arcs.
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3. Set Dimension as the current layer.

4. Confirm that Standard is set as the current r_.‘ Standard T4
Dimension Style, located at |2 g —ent > 1]
Ribbon: Annotate = Dimensions = Dimension i Linear - [7] Quick M Continue -
Dimension Style drop-down = Standard. Dimensions - ,
5. Select Ribbon: Annotate = Dimensions = Standard v T
Diameter. B -
Dirnensior ,_0_/ et V11l [=1
() Diameter ~ Quick |= Baseline -
— Imensicns =
6. Select the large circle at the center of the part, /- 9260
then click above and to the right to place the i ){
dimension. - g Y SN
/// . ﬁf[ ""‘ ) N\
."/ -‘f/ﬁ\l [ \ TN
7. Repeat the process to add a diameter 0.50
dimension to the small circle on the right side
of the part.
At this point, do not worry about dimensioning the -
remaining circle on the left side of the part.
Next you will add radius dimensions.
8. Select Ribbon: Annotate = Dimensions = Standard - T
Radius. Dimencio Use Current - 7] 2] [=]
Quick |5 Baseline -
9. Select the large arc at the top of the part, then click R1.75

above and to the left to place the dimension.

10. Repeat the process to add a radius dimension to the R0.50
small arc on the left side of the part.

At this point, do not worry about dimensioning the remaining arc
on the right side of the part.

Whenever possible, adding notes to repeated objects is desirable because it reduces
clutter. You will now add a label to two of the dimensions to indicate quantity.
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11. Double-click on the 0.50 diameter dimension. -
P
The Multiline Text Editor appears. The dimension text is highlighted in ,/
purple. The blinking cursor appears in front of the text. \\/\
12. At the keyboard, type 2X followed by a space. 2X @0 50
13. Click Ribbon: Text Editor = Close = Close Text Editor. \/
Close
Text Editar
Close
14. Repeat the process to add the 2X label in front of the 2X R0O.50
0.50 radius dimension.
e
Next you will add linear dimensions and modify their precision.
15. Select Ribbon: Annotate = Dimensions = Standard v T
Linear. S = Lse Current - m I'E;] r‘]
l }—| Linear -:l Quick [ Continue -
16. Using object snaps for accuracy, select the 263
center of the small circle to the left, then the
center of the large circle. Click above the R1.75
drawing to place the dimension.

2X R0.50

N

The dimension displays the value 2.63. This is a rounded value. You will adjust the
precision to show three decimal places.
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17. Select the 2.63 dimension.

18. Right-click, then select Precision =

0.000 from the context menu.

The dimension updates to display the value 2.625.

19. Repeat the process to add a similar dimension to the right-side of the part. When placing the

dimension, snap to the endpoint of the previous dimension to line them up.

| 2625 J-L

Repeat DIMLINEAR
Recent Input

Dimension Style
Precision
Remave Style Overrides

Annotative Object 5cale
Clipboard
Isolate

Erase

+  Move

0
0.0
0.00

0.000
0.0000 Q

0.00000
0.000000

¥

20. The finished drawing appears as shown:

2.625

2.625

2X R0.50

21. Save the drawing.

R1.75

2X 20.50
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In this exercise you will use the baseline and continue dimension tools to quickly
add several linear dimensions to a drawing. You will also work with multiple
dimension styles.

2.38 263 1.50

2375

5.000

6.500

1. Open drawing 12.2.4 Dimensioning 4.dwg.
2. Set Endpoint as a Running Object Snap.
You will begin by adding a continuous chain of dimensions to the top of the drawing.

3. Set Dimension as the current layer.

4. Select Ribbon: Annotate = Dimensions = ’-—-‘ 0.00 -l T
Dimension Style drop-down = 0.00 to set it =7 l%usecurrent > <] 3]
as the current dimension style. Dimension (| Linear - [7] Quick [ Continue -

Dimensions - N

This dimension style has been set up to display values to two decimal places.

5. Select Ribbon: Annotate = Dimensions = "—-‘ 0.00 v T
Linear. Use Current ~ 7] =] [=]

)

Dimensiol

Dimensions - 3

6. Pick the two points in the order
shown, then click above the
drawing to place the dimension.

238 2
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When using the Continue dimension command, the next dimension will start at the
second point of the original dimension. Therefore it is critical in this example to click from
left to right, since the dimensions will be continuing to the right.

7. Select Ribbon: Annotate = Dimensions = 0.00 - T
Continue. Z . .
Dimensicn 2 .U_eCurrent m r:I r_1
| Linear - r_1 Quickf [+ Continue ~
| %
Dimensions = e §

The dimension continues to the right of the previous dimension.

8. Select the next endpoint to the 2.38 263

right.
4E

9. Select the last endpoint to the 238 263 150
right.

10. Press [Esc] at the keyboard to end the Continue dimension command.

Next you will add baseline dimensions to the bottom of the part. As with continuous
dimensions, you will start by adding the first linear dimension. You will also use a different
dimension style.

11. Select Ribbon: Annotate = Dimensions = r—-‘ uuuuu T
Dimension Style drop-down = 0.000 to set it 1= T corent Tl 15 =]
as the current dimension style. Dimension 1 Linear - 7] Quick | Continue -

Dimensions ~ ¥
This dimension style has been set up to display values to three decimal places.

12. Select Ribbon: Annotate = Dimensions = r—-‘ 0.000 v T

Linear. Dimensio Use Current - [+ 1=l [=]
Quick [ Continue ~
Dimensions ~ N

13. Pick the two points in the order
shown, then click below the 1 2
drawing to place the dimension.

L 2375 -

When using the Baseline dimension command, the first point selected on the original
dimension will act as the datum. This means that all other dimensions will start at this
point. Once again, it is critical in this example to click from left to right.
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14. Select Ribbon: Annotate = Dimensions =

Baseline.

You will need to select the drop-down arrow next to
Continue to access the Baseline command.

15. Select the next endpoint to the
right.

16. Select the last endpoint to the

g . Use Current

f—| Linear - r_1 Quic

Dimensicn

Dimensions =

- —J:-H : A

f‘ [ [=]
|=r Baseline |
F

o

2.375

5.000

right.
I_J
2.375
5.000
6.500
17. Press [Esc] at the keyboard to end the Baseline dimension command.
18. Save the drawing.
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Chapter 4 | Blocks
Section 1 | Working with Blocks

Blocks are compound objects that are commonly used for symbols, parts, detail views, and title blocks.

A block is one or more objects combined to create a single object. The following are some examples of
blocks inserted into drawings.

COMesWel '
" "

.

prrAnLE

Using blo

@ W

cks provides the following advantages:

You can ensure uniformity between identical copies of furniture, fixtures, parts, symbols, and
title blocks in drawings.

You can insert, rotate, scale, move, and copy blocks much faster than operating on
selections of individual geometric objects.

If you edit or redefine a block definition, all block references in that drawing are updated
automatically.

You can include data such as part numbers, costs, service dates, and performance values to
blocks. The data is stored in special objects called block attributes.

You can reduce the file size of a drawing by inserting multiple block references instead of
duplicating object geometry.

Tip: With online access, you can download AutoCAD drawing files from the web sites of

commercial vendors and suppliers. This option can save you a significant amount of time but
check to make sure that these drawings are drawn correctly and to scale.
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4.1.1 Inserting Blocks

Save time and control the drawing size by inserting references to a set of objects that have been combined
to form a block.

Sources of Block Definitions

You can insert blocks from these sources:

e Blocks defined in the current drawing
e Other drawing files inserted as blocks into the current drawing

e Blocks defined in other drawing files, called block library drawings, which can be inserted into
the current drawing

e Blocks created by online vendors and services. These blocks are often associated with
specific parts or products

Insert Blocks

When you insert a block reference, you specify its location, scale, and rotation. Subsequent references to
that block definition can be inserted in different locations, scales, and rotation angles. When a block is
inserted into a drawing, it is scaled automatically according to the ratio of units defined in the drawing to the
units defined in the block. For example, if the unit of measurement is meters in the destination drawing and
centimeters in the block, the block is inserted at 1/100 scale.

Although a block reference is always inserted on the current layer, the block reference preserves the
properties in the block definition. This means, for example, that blocks can have multiple colors even when
they are inserted on a layer set to red or some other color.

Several tools are available for inserting blocks, and which tool you decide to use depends on factors such
as how many blocks you typically need in a drawing and whether you use a large variety of source drawings.

e Ribbon Gallery

On the Home tab, Blocks panel, you can click Insert to display a gallery of block definitions in
the current drawing. Use the gallery when you have a small number of blocks to insert quickly
by clicking and placing them in your drawing.

e Blocks Palette

The Blocks palette is designed for fast and anytime access when you use a moderate
number of blocks in a drawing. In the Blocks palette, sign in to your Autodesk Account, and
specify a cloud storage location to sync and access your blocks anytime, anywhere. This
palette displays blocks organized into four tabs: Current Drawing, Recent, Favorites, and
Libraries. You can access the Blocks palette with the BLOCKSPALETTE command.

e Tool Palettes

The Tool Palettes window is designed for when you use a large variety of blocks. Many tabs
are available and you can create custom tabs for sets of related blocks and specialized tools.
You can insert blocks from tool palettes by dragging the block tool into the drawing or by
clicking the block tool and then specifying an insertion point. You can access the Tool
Palettes window with the TOOLPALETTES command.
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e DesignCenter

The DesignCenter window is designed for browsing and selecting a variety of definitions from
existing drawings and drawing libraries. These definitions include blocks, layers, linetypes,
and other content. DesignCenter offers a quick, visual way to drag and drop blocks within the
current drawing or from another drawing. Double-click the block names to specify the precise
location, rotation, and scale of the blocks. You can access the DesignCenter window with the
ADCENTER command.

e Drawings in Folders

Drawing files can be dragged and dropped into the current drawing from a file folder as
blocks.

Try each of these tools to determine which of them is more appropriate to your environment. You can dock
the palettes and DesignCenter; then turn on auto-hide for convenience and efficient use of the drawing
area.

Note: You can remove block references in a drawing by erasing them, however, you remove
unused block definitions from the drawing by purging them with the PURGE command.

=

4.1.2 Defining Blocks

You can create blocks by associating objects and giving them a name or by creating a drawing to be used
as a block.

Block Definitions

Whenever you create a block or insert a drawing as a block, all the block information in the block definition,
which includes its geometry, layers, colors, linetypes, and block attribute objects, is stored within the
drawing file as non-graphic information. Every block you insert is a block reference to a block definition.
Block references are often simply called blocks.

Blocks can be created and saved in several places:

e Within a drawing file intended for use only within that drawing
e Within a drawing template file intended for use by any drawing that starts with it
e As separate drawing files intended to be inserted into other drawings as blocks

e As multiple blocks within a drawing file intended to serve as a block library drawing to be
accessed from other drawings

e As online block definitions provided by one of several vendors and services. These blocks
are often associated with specific parts or products.
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Create a Block Within a Drawing

A block definition typically includes the following information:

e The block name
e Objects that are included
e A base point that's used for placing the block in a drawing

e Optionally, block attribute objects used to store data such as the part number, vendor name,
service information, and so on.

Create Drawing Files for Use as Blocks

You can create drawing files for the purpose of inserting them into other drawings as blocks. Individual
drawing files are easy to create and manage as the source of block definitions. Related drawings can be
stored in a folder as a library of blocks.

e Specify the name of the block

The drawing name serves as the name of the block.

e Specify the base point of the drawing

By default, the WCS (world coordinate system) origin (0,0,0) is used as the base point for
drawing files inserted as blocks. You can reset the base point to specify a different base point
for insertion using the BASE command.

e Create the objects

These objects typically include geometric objects, text, and block attribute objects. When
you're finished, save the drawing in a folder with other drawings that you intend to use as
blocks.

There are several methods of creating blocks so that they inherit one or more properties such as layers,
colors, or linetypes from the current setting.

Note: Objects in paper space are not included when you insert a drawing as a block. To transfer paper
space objects to another drawing, save the objects as a block or save them in a separate drawing file, and
then insert the block or drawing file into the other drawing.

Work with a Block Library Drawing

You can create collections of related blocks with the BLOCK command and stored them in a dedicated
drawing file called a block library drawing. You can then insert these blocks individually from any other
drawing. If you insert the entire block library drawing file into the current drawing, all of its block definitions
are added automatically to the current drawing.
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Create Nested Blocks

Block references that are included in a block definition are called nested blocks. Using blocks within blocks
can simplify the organization of a complex block definition.

B=n

im&
H
E - |
| E =
assembly block nested blocks within assembly
o —» fomew |
fastener block nested blocks within fastener

=/ | Note: Blocks that try to reference themselves are called circular references and are not allowed.

Work with Commercial Blocks

With online access, you can download AutoCAD drawing files from the web sites of commercial vendors
and suppliers. This option can save you a significant amount of time creating the blocks yourself, but always
check to make sure that these drawings are drawn correctly and to scale.
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About the Blocks Palette

Use the Blocks palette to access blocks quickly from a ribbon gallery or from the Blocks palette.

You can insert your blocks using the Blocks palette, the Tool Palettes window, or DesignCenter depending
on which of these tools suit your needs the best.

When you click Insert from the Home tab, Block panel, you can click and place blocks from the displayed
ribbon gallery. The gallery displays all block definitions in the current drawing. Click and place these blocks.

B 2 e

e

Insert Edit Create  Define Manage Block Attach Clig
Attribute Block Attnbutes Attributes Editor

COMPUTER

Recent Blocks...
Favarite Blocks...

Blocks from Libraries...

. Note: Blocks associated with dimension and multileader styles are included automatically when
= you create dimensions and multileaders, so they're not displayed in the ribbon gallery or the
Blocks palette.

The other three options, Recent Blocks, Favorite Blocks, and Blocks from Libraries, open the Blocks palette
to the corresponding tab. The illustration below shows all four tabs.
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FC15X27A

The Current Drawing tab displays previews or a list of block definitions available in
the current drawing.

The Recent tab displays previews or a list of block definitions recently inserted or created in
the current and previous sessions. These blocks can come from various drawings.

The Favorites tab displays previews or a list of favorite block definitions that were copied
from the other tabs of the Blocks palette.

The Libraries tab displays previews or a list of block definitions from a single, specified
drawing or a folder. Inserting a drawing file as a block also imports all of its block definitions

into the current drawing. Click Browse Block Libraries (m) at the top of the palette to browse
to a different drawing file or folder.

Note: The name of an external file that's inserted as a block includes an asterisk (*) in the Blocks

palette.
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You can insert a block from one of these tabs with several methods:

e Click and place a block into the current drawing. This method applies the settings specified
under Options.

e Drag a block into the current drawing for fast placement. This method only uses the Scale
and Rotation values specified under Options.

e Right-click and choose an option.

4
e From any tab in the Blocks palette, click Insert DWG as Block (E%I:-). This method inserts a
drawing file as a block.

Notice the placement options at the bottom of the Blocks palette. These options can save you multiple steps
such as repeatedly placing a block.

Tip: To optimize your drawing area, dock the Blocks palette to either side of your application
window and turn on Auto-hide from its title bar. If you are exporting data from an external
database, you can export the entire record from the database or just the key fields. Because the
key field values are stored in the map, choosing the key field (listed under Link Templates) makes
the export faster.

About DesignCenter

DesignCenterOrganizes access to drawings, blocks, hatches, and other drawing content.
With DesignCenter, you can

e Browse for drawing content such as drawings or symbol libraries on your computer, on a
networked drive, and on a web page

e View definition tables for blocks and layers in any drawing file and then insert, attach, or copy
and paste the definitions into the current drawing

e Update (redefine) a block definition

e Create shortcuts to drawings, folders, and Internet locations that you access frequently
e Add content such as xrefs, blocks, and hatches to a drawing

e Open drawing files in a new window

e Drag drawings, blocks, and hatches to a tool palette for convenient access

e Copy and paste content, such as layer definitions, layouts, and text styles between open
drawings
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The DesignCenter Window

Use the tree view on the left to browse sources of content and to display content in the content area on the
right. From the content area, you can add items to a drawing or to a tool palette. A preview or description
is displayed for selected drawings, blocks, hatch patterns, or xrefs.

A= | [a E“:I}EEI E'

Folders  Open Drawings Histary

[ abder List o A — T
.$ k!. L- Detsbase Connectraty ..-\l E:J @ |-£| g L —_—

+ Hl en-us Blocks  DetailiewS.. Dimstyles Layers Layouts Linetypes
= Mechenical Sample
B s Ertacion and Mt L e i
" ==- Mechanical - Data Links.dws /{j L\:!"-"“ E A? Q &
o 5N Mechanical - Multilesdersd | bMultiflesder.. SectionVie... Tablestyles  Teststyles  Visualstyles Hrehs
# 5% Mechanical - Text and Table
3 tw Mechanical - Xrel dwg
o [ Sheet Sets
<l VBA
w [l VisualLIsP 1
B schema
5l Schernas
B SutehHTML
N | Support o
B Thernes o
* »
APregearm FlehAutodesklAute CAD 2020 Sample\Mechanical Semple' Dats Extraction snd Multileaders Sammple.dwg (12 lremds))

The DesignCenter toolbar controls navigation and display of information in the tree view and the content
area. The same navigation and display options are available on the shortcut menu. Right-click in the content
area to display the menu.

As with other dockable windows and palettes, you can resize, dock, and anchor DesignCenter. Many of
these options can be set selecting an option on the shortcut menu.

258 MDT Internal Use Only



User Guide Chapter 4 | Blocks

4.1.3 Dynamic Blocks

Dynamic blocks contain rules and restrictions that control the appearance and behavior of a block when it
is inserted into a drawing or when it's later modified.

You can add these rules and controls to any existing block as well as using them when you create new
blocks. The controls are limited to 2D operations only.
Examples of Using Dynamic Blocks
A variety of controls and behaviors are available for adding flexibility and efficiency of working with blocks.
Some examples of how you could use dynamic blocks include the following:

e Automatically align a block to the geometric objects that represent a wall or a pipe

e Create additional movement grips on a block

e Add multiple insertion points so you can cycle through them by pressing Ctrl when inserting a
block

e Choose whether a block is flipped or mirrored when inserted

e Control the size or shape of a block to standard increments such as the length of a fastener
or width of a door

o Display a family of parts or similar styles in a tabular format to choose different versions of
the same block

If you notice an action that you commonly repeat when you work with blocks, you may be able to reduce
the amount of trivial work and achieve substantial gains in efficiency.
The Block Editor
The Block Editor is a dedicated block authoring environment that lets you create and modify block geometry,
attributes, and parameters, actions, and constraints. It includes the following components:

e A drawing area with a gray background

e A contextual ribbon tab that contains operations such as saving and testing the block, and
exiting the editor

e The Block Authoring palette with several tabs that contain tools to add dynamic capabilities to
block definitions

e Atemporary area to test a dynamic block design

You can access the Block Editor by using the BEDIT command, which is available on the Home tab, Block
panel on the ribbon.

Note: The third tab on the Block Authoring palette set, Parameter Sets, simply contains
predefined parameters and actions that have already been combined for your convenience.

=

Applying Parameter Sets

With dynamic blocks you can insert a single block that can change its shape, size, or display instead of
inserting one of many static block definitions. For example, instead of creating multiple interior door blocks
of different sizes, you can create a single dynamic door block that can be resized to a doorway opening.
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In the previous illustration, there are several visible parameters that appear as specialized grips or controls,
each of which is associated with an action. The highlighted custom grip is a linear parameter that's
associated with a stretch action. Paired together, these are termed a parameter set.

o Tip: The order in which you specify key points when creating a parameter determines the
= location of a grip or control and may have additional significance.

Here's an example of a lookup list that provides a choice between several options.

|

v 3|:|IZI - 1
450 :
[iz==

o X,

In this case, the highlighted control is alookup parameter that's associated with a lookup action.
This parameter set was designed to display a list of options to control the displayed swing angle of the door.

Applying Constraints

The parametric drawing feature set, which includes geometric constraints, dimensional constraints,
and parametric formulas, is available for use in blocks.

The ability to define constraints is not available in AutoCAD LT, but blocks that are defined in another
AutoCAD-based product can be employed in AutoCAD LT without restriction.

Caution: It is possible to create constraints that conflict with the parameters and actions defined
AA in the same block.
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About Creating Dynamic Blocks

Creating dynamic blocks is an extension of creating static block definitions. You can make the process
easier and more likely to succeed with sufficient planning, incremental changes, and testing in the Block

Editor.

The following table provides an overview of the steps required to add dynamic behaviors and controls to a

block definition.

General Workflow

Plan the block -
content

Create the =
geometry

Add geometric and =
dimensional

constraints (not in
AutoCAD LT)

Add parameters »-

Add actions »-

Define parameter »-

properties

Test the block -

Save the block -

Plan how the block should change or move, and what objects will
depend on the other objects. For example, you might decide that the
block should be able to be resized in a specific direction, after which
additional geometry is displayed.

Create the geometric objects for the block in the Block Editor. If you
plan to use visibility states to control when geometry is displayed, you
might not want to include all the geometry at first.

It usually makes sense to add constraints to the geometry first, before
adding parameters and actions. Specify the dimensional constraints
from the Constraints tab on the Block Authoring palette.

Add parameters to specify which objects will be affected by an action.

Add actions to define what will happen to the geometry when it is
manipulated.

Add properties that determine how the block is displayed in the drawing
area. Parameter properties affect grips, labels, and preset values for
the block geometry. Consider how geometric objects might be affected
if actions are chained together.

On Block Editor contextual tab, Open/Save panel, click Test Block to
test the block before you save it. A good practice is to test the block
after each change to catch any errors early.

On the Block Editor contextual tab, Open/Save panel, click Save Block
or click in the Close panel, Close Block Editor and then click Save the
Changes.
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The following is an example of adding constraints followed by adding actions and parameters.

Add Constraints

In a block definition, constraints do the following:

e Associate objects with one another
e Restrict geometric relationships or dimensions
e May contain expressions representing formulas and equations
The following illustration shows a block reference with two types of dimensional constraints used in a

dynamic block.

e The gray dimensional constraint, d1, was specified using the Parametric tab on the ribbon.
It's applied to the block geometry, but it cannot be accessed or modified once the dynamic
block is inserted into a drawing.

e The blue dimensional constraint, d2, has 1 grip associated with it. This constraint was
specified from the Constraints tab of the Block Authoring palette as a Horizontal constraint
parameter. Constraint parameters combine a dimensional constraint with a parameter. This is
how you can display a custom grip associated with a dimensional constraint.

d2=5008

The number of accessible grips on a constraint parameter is specified in the Properties palette from within
the Block Editor.

After the block is inserted into the drawing, the constraints are maintained, but the value associated with
d1l can be changed with the Properties palette in a similar manner to how you would change object
properties.
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Add Actions and Parameters

In a block definition, actions and parameters provide rules for the behavior of a block once it is inserted into
the drawing.

In general, you first create a parameter and then you associate an action to that parameter. A parameter is
represented as a parameter point with one or more custom grips that display when the block is inserted
into the drawing and selected.

near parameter | : stretch action
l : I associated with
la—Distancel- .... - parameter point
: [+
Y\ parameter point
> : custom grip
‘ dragged here

b stretch frame

<[ | Note: When a yellow box with an exclamation point appears in the Block Editor, is usually
signifies that a parameter does not have an associated action yet.

When you insert the dynamic block in a drawing and manipulate one of its custom grips, the associated
action determines what will change in the dynamic block. Just as with parameters, actions can be changed
using the Properties palette from within the Block Editor.

Modifying Dynamic Block Definitions

Use the Block Editor to edit, correct, and save a block definition.
How To: Correct Errors in Action Parameters
A yellow alert icon (III ) is displayed when

e A parameter is not associated with an action

e An action is not associated with a parameter or selection set
To correct these errors, hover over the yellow alert icon until the tooltip displays a description of the problem.
Then double-click the constraint and follow the prompts.

Saving Dynamic Blocks

When you save a block definition, the current values of the geometry and parameters in the block become
the default values for the block reference. The default visibility state for the block reference is the visibility
state at the top of the list in the Manage Visibility States dialog box.

Note: If you click File menu * Save while you are in the Block Editor, you will save the drawing
S| | but not the block definition. You must specifically save the block definition while you are in the
Block Editor.

MDT Internal Use Only 263



101 — AutoCAD Fundamentals for Microstation Users User Guide

Exercises: Adding Multileaders to Drawings

In these exercises you use the Multileader tool to notes to drawings. You will also modify
several Multileader options.

You do the following:

e Create leaders to add notes to a drawing.

e Add and remove leaders from a multileader object.
e Create and modify Multileader styles.

e Align and collect leaders.

In this exercise you will create several leaders to add notes to a drawing. You will
also modify a multileader style.

PROPOSED
NEW SHED

PROPOSED /

Lo

EXSTING DECK

Bl
AEXISTNGPATO
a a

EXSTING HOUSE

N

PROPERTYLINE

1. Open drawing 12.3.1 Leaders 1.dwg.

You will begin by setting Nearest as a Running Object Snap. This will make it easier to
place the leaders on the appropriate objects.

2. Set Nearest as a Running Object Snap.

3. Set TEXT as the current layer.

4, Confirm that Standard is set as the current Multileader O [stendard -
Style, located at Ribbon: Annotate = Leaders = v P Te Add Leader
Multileader Style drop-down = Standard. MURIEASr @ o Remove Leader

Leaders N

Next you will add a leader to call out the property line.
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5. Select Ribbon: Annotate = Leaders = Multileader.

6. Select the right-side property line
(1), then click a point below and to
the left similar to the example (2).

The multiline

7. Type PROPERTY LINE, then close

text editor appears.

the text editor.

PROPOSED CONCRETE PAD.

1

I;"Q
¥

Multileader

tandard -
8| e Add Leader
/8 % Remove Leader

Leaders

B

PROPERTY LINE

PRGN EN
8. Repeat the process to add leaders to EXISTING FENCE, PROPOSED NEW SHED, and

N
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N
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[]/ FENCE

T
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1
[

T
/ Py =
PROPOSED ‘ '.'

L

Next you will modify the multileader style to allow more leader segments.
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9. Select Ribbon: Annotate = Leaders = O Standard

Multileader Style Manager. ¥ 3| %o Add Leader

Multileader
/8 e Remove Leader
Leaders ]
The Multileader Style Manager dialog box A Multileader Style Manager %
appears.
Current multileader style: Standard
) . Style=- Preview of - Standard
10. Confirm that the Standard style is Set Cument
selected, then click <<Modify...>>. .
EW...
Default Text {[_vesn_n |
List:
All Styles w
The Modify Multileader Style dialog box Leader Format  Leader Structure  Content
appears. j
[ Maximum leader points 2 =
11. Select the Leader Structure tab. [ First seqment angls 0
. . . [] Second segment angle 0
12. Disable the Maximum leader points

option.

This will allow you to create a leader with unlimited segments. Alternatively, you can
increase the maximum leader points to a number greater than 2.

13. Click <<OK>> to close the Modify Multileader Style dialog box.
14. Click <<Close>> to close the Multileader Style Manager dialog box.

Finally, you will add another leader to the REMOVE TREES multileader object.

|9 | ¥
\ |
| I
- mp -
REMOVE REMOVE
TREES TREES
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15. Select Ribbon: Annotate = Leaders = Add Leader. O

‘{( Standard -
72 * Add Lead
Multileader B EaCEr

o
Vi) /¢ Remove Lea

Leaders u

16. Select the REMOVE TREES multileader
object.

17. Click a point in space to the right of the
original leader (1), then click a point on the
edge of the second tree (2).

18. Press [Enter] at the keyboard to create the
leader and end the command.

19. The completed

drawing appears as ‘ FROPOSED S
shown: | I‘vEWSHED\ﬁ_:\‘:
| .
20. Save the drawing. A
PRGPGSED—I/"" L
CONCRETE =
I FAD
EXISTING
| [/FENCE
‘ TREES
(u]
| a a . .. N []l
| L . e EXISTING DECK
& L . R |
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In this exercise you will create a new leader style that uses a block for the content.
You will then use this new style to create balloons for an assembly drawing.

BILL OF MA TERIALS
PART # DESCRIPTION Qry
1 LINK 1
2 MOUMNTING BRACKET 1
3 BUSHING 1
4 @160 SHAFT 1
5 FLANGED BUSHING 1
2] @75 SHAFT 1
7 375 x 1 25HEX HD BOLT 4
k3 -375 WASHER 4
9 IT5S HEXNUT 4
1. Open drawing 12.3.2 Leaders 2.dwg.
2. Set Nearest as a Running Object Snap.
3. Set TEXT as the current layer.
You will begin by creating a new leader style.
4. Select Ribbon: Annotate = Leaders = Multileader AO  Standard -
Style Manager. »f/_ 73| o Add Leader
Multileader

/8 e Remove Leader

Leaders o]
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The Multileader Style Manager dialog box A Multileader Style Manager %
appears.
Current multieader style: Standard
) ) Styles: Preview of . Standand
5. Confirm that the Standard style is Set Current
selected, then click <<New...>>. =
oW ...
Default Text | Modiy._
List:
All Styles ~
6. Enter the name BOM Balloons. A Creste New Multileader Style %
) ) New style name:
7. CI'Ck <<C0nt|nue>>. |BO|'U'| Balloons | Iml
Start with: Cancsl
Standard ~
Help
[ Annotative

The Modify Multileader Style dialog box Leader Format  Leader Structure  Contert
appears' Multileader type: l Block - l
Block options
8. Select the Content tab. Souos block l O Horaoon "l
9. Set Multileader type to Block. Antachment: Center Bxents b
Color: M EyBlock v
10. Set Source block to Hexagon. Scale: floom B

11. Click <<OK>> to close the Modify Multileader Style dialog box.

12. Click <<Close>> to close the Multileader Style Manager dialog box.

13. Confirm that BOM Balloons is the current multileader O | somBalioons -

style (Ribbon: Annotate = Leaders). ¥ T e Add Lesder

Multileader *
8 e Remove Leader
Leaders N
Now you are ready to add balloons to the assembly drawing.

14. Select Ribbon: Annotate = Leaders = Multileader. O JpomBalloons -

M ‘.Irt'l d 72| *e Add Leader

ultileader

8 e Remove Leader
S

Leaders 3
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15. Select the part in the top view as shown (1),
then click a point above and to the left similar
to the example (2).
The Edit Attributes dialog box appears.

16. Type 1 in the Enter tag number field, then click
<<OK>>,

The first balloon is created.

17. Repeat the process to add balloons 2 through 9. Place the balloons similar to the example
shown.

Next you will collect balloons 7, 8, and 9 into one leader to reduce clutter.

18. Select Ribbon: Annotate = Leaders = Collect. A BOM Balloons -

/

) 73| o Add Leader
Multilead

Vi /2 Remove Leader

M,

%
o |eaders
L
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19. Select balloons 7, 8, and 9 in that order, then
press [Enter] at the keyboard.

The balloon are grouped together in the order they were
selected, and attached to one leader.

20. Click above and to the left to place the collected
balloons.

74
Finally, you will use the align tool to give the drawing a consistent look. You will start by
aligning balloons 5 and 6 horizontally to each other.
21. Select Ribbon: Annotate = Leaders = Align. O _BOM Balloons -
¥ o A eader
Multilead ﬁ' ¢ Add Lead
¢ e Remove Leader
Leaders N

22. Select balloons 5 and 6 in any order, then press [Enter] at the keyboard.

You are prompted to select the multileader to align to. While you can select either balloon, in this exercise
you will select balloon that is the furthest away from the drawing to ensure there is enough space.

23. Select balloon 6.

Balloon 6 remains stationary, but as you move the
crosshairs around balloon 5 moves.

24. Move the crosshairs horizontally to
the right of the original point along the
0 degree Polar Tracking angle.

Polar: 3.5728 < 0°

25. Select a point to align the two
balloons horizontally.

26. Repeat the process to horizontally align balloons 2, 7, 8, and 9.

»K%
o~ [T
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27. Repeat the process to vertically align balloons 3 and 4.

NN
‘.\'\\\ W
.\N\.\\\\\ )

A ‘;\t‘l}l‘\\i\:\“"'
RN &
OPZES

28. Save the drawing.

BILL OF MATERIALS
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Chapter 5 | External References

Section 1 | Working with External Reference Files

You can attach any drawing file as an external reference or xref in the current drawing.

Attached xrefs are links to the model space of a specified drawing file. Changes made to the referenced
drawing are automatically reflected in the current drawing when it's opened or if the xref is reloaded.
Attached xrefs do not significantly increase the size of your current drawing.

By using referenced drawings, you can:

e Coordinate your work with the work of others by referencing other drawings in your drawing to keep
up with the changes being made by other designers. You can also assemble a master drawing
from component drawings that will change as a project develops.

e Ensure that the most recent version of the referenced drawing is displayed. When you open your
drawing, each referenced drawing is automatically reloaded, so it reflects the latest state of the
referenced drawing file.

o Keep the names of layers, dimensioning styles, text styles, and other named elements in your
drawing separate from those in referenced drawings.

e Merge (bind) attached referenced drawings permanently with your current drawing when the project
is complete and ready to be archived.

Note: An external reference can be a drawing file, image, PDF, or one of several other file types.
An xref is an external reference that's specifically a DWG file.

Tools for Attaching Xrefs

You can use several methods to attach an xref:
e Click View tab » Palettes panel * External References Palette.
e Click Tools menu »* Palettes * Reference Manager.
e At the Command prompt, enter EXTERNALREFERENCES.
e At the Command prompt, enter XATTACH.

When using the External References palette, it is recommended that you turn on the Auto-hide feature or
anchor the palette. The palette will then hide automatically when you specify the insertion point of the
external reference.

You can also use DesignCenter ™ to attach xrefs to a drawing. Use DesignCenter for simple attachments,
previewing drawing references and their descriptions, and quick placement by dragging. You can attach an
xref by dragging it from DesignCenter or by clicking Attach as Xref on the shortcut menu.
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. Note: A drawing file can be attached as an xref to multiple drawings at the same time.
= Conversely, multiple drawings can be attached as referenced drawings to a single drawing. If an
xref contains any variable block attributes, they are ignored.

Managing Xref Paths

The saved path used to locate the xref can be a relative (partially specified) path, the full path, or no path.
The default path type is relative. Use the REFPATHTYPE system variable to change the default path type.
If the host drawing is not saved yet, the saved path column displays a full path with an asterisk prefix to
indicate that a change will take place after the host drawing is saved. Before the file is saved, a new read-
only property called pending relative path is added to the Details pane of the Xref palette. When the file is
saved, the pending relative path property is removed.

Receive Notification of Attached Xrefs

An xref icon is displayed in the status bar when xrefs are attached to the drawing.

FEIEEICE

When one or more xrefs are not found, an exclamation point is added to the Xref icon. If you click the Xref
icon, the External References palette is displayed.

Detaching Referenced Drawings

To completely remove an xref from your drawing, you need to detach it rather than erase it. Using the
Detach option removes the xrefs and all associated information such as layer definitions.

If you have nested xrefs in your host drawing, you have to open the xref that it's nested in and detach it
from there instead of trying to detach it from the host drawing. Use the Tree View control in the upper-right
side of the External References palette to see how xrefs are nested within each other.

Highlight External References in a Drawing

To find an external reference in a complex drawing, select an item in the External References palette to
highlight all visible instances in the drawing. Conversely, select an external reference in the drawing to
highlight its name in the External References palette.

) = Note: The ERHIGHLIGHT system variable controls whether referenced objects are highlighted.
You can turn highlighting off to improve performance.
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To find an external reference in a complex drawing, select an item in the Reference Manager palette to
highlight all visible instances in the drawing. Conversely, select an external reference in the drawing to

highlight its name in the Reference Manager palette.
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File References i 1 J
Reference .. a % .secmmewsd cemmmes e
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3
Reference o o ———— - . —— i —
! - 2
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|
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Type s ¥ . ,
Date Tt Roes

Found At

Seved Path  C:\Users\Administrator\De
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File References

Reference .. & Status
Opened 108KE

Reference ..
Status
Size

Type Attach
Date
Found At

Saved Path  C:\Users\Administrator\...
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Control the Properties of Referenced Layers

You can control the visibility, color, linetype, and other properties of an xref's layers and make these
changes temporary or permanent in your current drawing. If the VISRETAIN system variable is set to O,
these changes apply only to the current drawing session. They are discarded when you end the drawing
session, or when you reload or detach the xref.

You can also control the level of fading of the xref. The XDWGFADECTL system variable defines the fade
percentage for all xrefs in your drawing.

Current Layer Override

By default, all new objects are created on the current layer. For new xref objects, you can specify a default
layer that's different than the current layer by specifying the layer with the XREFLAYER system variable.
Freezing this layer turns off the visibility of all objects in the xref regardless of their xref layer settings.

Xref Clipping Boundaries

Drawings can include xrefs that are clipped. If you want to see the clipping boundary, you can turn on the
XCLIPFRAME system variable.
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5.1.1 Attaching External Reference Files (XREF’s)

How To: Attach an External Reference

;
1. Click Insert tab » Reference panel » Attach. £

2. Inthe Select Reference File dialog box, select one or more files you want to attach and then click
Open.

3. Inthe Attach External Reference dialog box, under Reference Type, select Attachment.

4. Specify the insertion point, scale, and rotation angle. Click Specify On-Screen to use the pointing
device.

5. Attachment includes all nested xrefs.
6. Click OK.

How To: Attach or Overlay an Xref Using DesignCenter

1. Click View tab » Palettes panel * DesignCenter. E

2. In the content area or in the Search dialog box, locate the DWG reference you want to attach or
overlay.

3. Right-click. Drag the DWG reference into the open drawing.
4. Release the right-pointing device button. Click Attach as Xref.
5. In the External Reference dialog box, under Reference Type, select Attachment or Overlay.

6. Enter values for Insertion Point, Scale, and Rotation, or select Specify On-Screen to use the
pointing device.

7. Click OK.
You can also attach an xref by dragging or by clicking Attach as Xref on the shortcut menu.
How To: Detaching Xrefs

1. Click View tab » Palettes panel * External References. ]

2. Inthe External Reference palette, select a DWG reference.

3. Right-click the selected DWG reference and select Detach from the shortcut menu.

How To: Adjust Xref Fading (Transparency)

@
1. Click Inserttab » Reference panel * Xref Fading. C
2. Drag the slider to adjust the fade display of the DWG xref.

The DWG xref fades as you drag the slider.
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How To: View Referenced Files by Type

1. Click Inserttab » Reference panel » Dialog box launcher. |*

2. Inthe External References palette, in the File References pane, click the List View button.
3. Click the Icon column.
The attached referenced files are sorted by type in the list view.
External References Palette
B-C-ik-@

File References

Reference ... &  Status Siz Type ) Saved Path

ﬁ Office floor_pla..  Opened Current

H‘.ﬂh 1st floor plan - ...  Loaded .7 K DWF /2010 7 WAl Drawings1st floor plan.dwf
'._:] Cubicle-Style_A Loaded 1K Attach d [l Drawings\Cubicle-Style_A.dwg
Eﬂ Cubicle-5tyle_B Loaded 4 (B Owverlay

el | Gallery_Exterior...  Loaded 8 BMP

5 Stair_Detail - M... Loaded 9.5 KB DGM

Details
Reference .. Cubicle-Style A
Status
Size
Type Attach
Date

Found At

The External References palette organizes, displays, and manages referenced files, such as DWG files
(xrefs), DWF, DWFx, PDF, or DGN underlays, raster images, point clouds (RCP and RCS files), and
coordination models (NWD and NWC files).

Only DWG, DWF, DWFx, PDF, and raster image files can be opened directly from the External References
palette.

Shortcut menus provide additional options for working with the files.
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List of Options

The following options are displayed.

External References Palette Toolbar
Attach

Attaches files to the current drawing. Select a format from the list to display the Select Reference
File dialog box.

Refresh

FE -
R

Refreshes the list display or reloads all references to display any changes that may have occurred
in the referenced files.

Change Path
i

Modifies the path of the selected files. You can set the path to be absolute or relative. If the
referenced file is stored in the same location as the current drawing, you can also remove the path.
You can also select a new path for a missing reference using the Select New Path option. The Find
and Replace option provides you a way to locate all references that use a specified path from all
the references that you selected and replaces all occurrences of that path with a new path that you
specify.

Help

7]

Opens the Help system.

File References
List and Tree View buttons

Click the buttons to switch between list and tree view.

List of Referenced Files

Displays a list of references in the current drawing, including information such as status, size, and
date of creation.

Double-click the file name to edit it. Double-click the cell under Type to change the path type (DWG
only).
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Details

Displays information or a preview image of a selected reference.

Detail Display and Thumbnail Preview buttons

@
2]

Click the buttons to switch from the detail display to a thumbnail preview.

Preview image

Shows a thumbnail image of the file selected under File References.

Detail Display

Provides information about the file selected under File References. You can modify some
information by clicking the right column.

5.1.2 External Reference Tools: XLIST

XLIST is an express tool that lists the type, block name, layer name, color and linetype of a nested object
in a block or an xref,

&

Command: XLIST

Select nested xref or block object to list: Use an object selection method

Example

Select an object as a nested block or xref file to display the Object and Block Name, Layer, Color, and
Linetype properties.

The pick box identifies the plant as the selected object:

(]

[l

D

oL
™)

Selecting the object opens the Xref/Block Nested Object List dialog box with the property information
shown:

#ref/Block Mested Object List >

Object:  LWPOLYLINE
Layer: 0

Color: Bylayer
Linetype: Bylayer
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5.1.3 External Reference Tools: NCOPY

NCOPY is an express tool that copies objects that are contained in an xref, block, or DGN underlay.

]

Instead of exploding or binding an xref, block, or DGN underlay to be able to copy objects nested within
them, you can copy the selected objects directly into the current drawing.

The following prompts are displayed.

Nested Objects to Copy

Specifies the component of an xref, block, or underlay that you want to copy.

Base point

Sets the point to be used as a base point for placing the copied objects.

Second point

In combination with the first point, specifies a vector that indicates how far, and in what direction,
the selected objects are moved.

If you press Enter to accept the Use first point as displacement default, the first point is interpreted
as a relative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter
at the next prompt, the objects move 2 units in the X direction and 3 units in the Y direction from
their current position.

Displacement

Specifies a relative distance and direction from the base point location.

Multiple

Controls whether multiple copies are created automatically as you specify additional locations.

Array

Arranges a specified number of copies in a linear array using the first and second copy as the spacing
distance.

Number of items to array
Specifies the number of sets of the selected objects in the array, including the original selection set.
e Second point (Number of items). Determines a distance and direction for the array

relative to the base point. The distance you specify determines the distance between
the base points of each object in the array.

Fit
Arranges a specified number of copies in a linear array using the first and last copy as the total spacing
distance.

e Second point (Fit). Positions the last copy in the array at the specified displacement
distance and direction. The other copies are evenly spaced in a linear array between
the first copy and the last copy.
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Settings

Controls whether named objects that are associated with the selected objects are added to the drawing.

Insert
Duplicates the selected objects to the current layer without regard to named objects. This option is
similar to the COPY command.

Bind

Includes named objects such as blocks, dimension styles, layers, linetypes, and text styles
associated with the copied objects into the drawing.
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Exercise: Working with External References

In this exercise you will attach a drawing as an external reference while working with

several settings.
You do the following:

e Open the External Reference palette.
e Attach a drawing file.

o Modify and update the reference file.
e Unload and reload the reference file.
e Detach the reference file.

In this exercise you will attach a drawing as an external reference. You will then edit and

update the referenced file.

—
———

(C10)
©@e

1. Open drawing 10.3.1 External References 1.dwg.
2. Set Furniture as the current layer.
You will begin by opening the External References palette.

3. Select Ribbon: Insert = Reference
= External References.

l@: | j ] B2 Underlay Layers
L_-:L L *Frames vary* -
Attach Clip Adjust B
1% Snap to Underlays ON -

Reference « u
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The External References palette appears. x
Currently, only one drawing, the host drawing, ; W--2-0
appears in the palette. File References =&
Reference Mame A Status Size
='= 10.3.1 External References 1 Opened 504 KB
£ >
Details CE ~

4. Select Attach DWG.

|:I EXTERNAL REFERENCES

The Select Reference File dialog box appears.

5. Browse to C:\A Practical Guide\AutoCAD 2022\Dining Table.dwg.

6. Click <<Open>>.

The Attach External Reference dialog box appears.

7. Inthe Scale section,
confirm that Specify
On-screen is
disabled, and the X, Y,
and Z scale values are
set to 1.00.

8. In the Rotation
section, confirm that
Specify On-screen is
disabled, and the
Angle value is set to
0.000.

9. In the Insertion point
section, confirm that
Specify On-screen is
enabled.

10. In the Reference Type
section, confirm that
Attachment is
selected.

11. Click <<OK>>,

B Attach External Reference

Name: Dining Table w

Scale

[] Specify On-screen

Preview

X100

TN Y: 100

m Z 100

[ Uniform Scale

Insertion point
Specify On-screen

Reference Type

(@) Attachment () Overlay

Locate using Geographic Data

Show Details

Browse...

Path type
Relative path w

Rlatation

[ Specify On-screen

Angle:  |0.000

Block Unit

Factor: |1.0000

Cancel Help
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12. Select a centralized point in the dining &} {
room to place the Dining Table.

The Dining Table drawing also appears in the File References =
External References palette. Reference Mame & Status Size Type
Eﬁ 10.3.1 External References 1% Opened 74.0 KB Current
T Dining Table Loaded  40.8KB  Attach
Next you will modify the Dining Table, and update the reference in the host drawing.
13. In the External References palette, right- x| _
. .. e ]
click on Dining Table, then select Open. W E-2-B-0Q
File References
Reference Mame & Status Size
£§ 103.1 External References 1* Opened  74.0KB
US Dining Table loodod A0 A KR
Open
Attach... %
Compare >
< Unload
The Dining Table drawing file is opened.
Next you will change the number of chairs at the table from 4 to 6.
14. Select one of the chairs.
The chairs are part of an associative array. £, ttems:
.. . . ;]O Between:
15. On the context sensitive Array Creation tab of the ribbon, set the =3 it

Ribbon: Array = Items = Items value to 6.

16. Save, then close the Dining Table drawing file.
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You are returned to the host drawing file. A message

. . . L. X ﬁ- External Reference File Has Changed x
IS dlsplayeq in the status bar Indlcatlng that a A reference file has changed and may need reloading:
reference file has changed. Reload Dining Table

17. Select Reload Dining Table. KA 8 ~4 P ‘%\EL g =

The external reference is updated, showing the new
version with six chairs.

Next you will use multiple methods to remove the referenced drawing.

18. In the External References palette, right- | x

click on Dining Table, then select W -0
Unload ) File References =B
.. . Reference Mame a  Status Size
The Dining Table is removed from the screen. B —— Opened 10 KB
However, the reference still exists, and the Dining 0% Dining Table Loaded 40.8 KB
Table can be reloaded. Open
Attach...
Compare ¥
Unload
Reload %
Detach
Bind...
19. In the External References palette, right- | x _
click on Dining Table, then select W E-R2-@2-0
Reload' * File References =B
.. . . . . Reference Mame a  Status Size
The Dining Table is once again displayed at its DR T e—— Opened 40KE
original location. 5 Dining Table 4+ Unlnaded
Open
Attach...
Compare
Unload
Reload
Detach k
Bind...

20. Select the Dining Table in the drawing window, then press [Delete] at the keyboard to erase
it.
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The Dining Table is removed from the drawing. File References

However, the reference still exists, and the status is Reference Name a  Status Size

disp|ayed as Unreferenced. S 10.3.1 External References 1* Opened 740 KB
'-5‘:!. Dining Table L Unreferenced 408 KB

To completely delete a referenced file, you will
detach it.

21. Select Quick Access Toolbar: Undo to once again display the referenced Dining Table.

22. In the External References palette, right- | x

click on Dining Table, then select v B-R-2-0
3%
Detach. File References =B
- . Reference Mame A Status Size
The Dining Table is completely removed, and no Y8 1031 Externl References 1* Opened aDKE

longer appears in the drawing window or the External Y i

o]
References palette. per

Attach...

Compare >
Unload
Reload

Detach
Bind... %

23. Select Quick Access Toolbar: Undo to once again display the referenced Dining Table.

24. Save the drawing.
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Chapter 6 | Working with GIS Data

Use AutoCAD Map 3D toolset to work with both CAD objects and geospatial features. You can combine
them in your map, edit either type of data, or move data from one format to the other.

In this chapter two main data types are discussed in Geospatial Features and Drawing Objects.

Geospatial Features

A feature is the spatial description of a real-world entity such as a road or a utility pole. Features are stored
in a spatial database or in file formats such as Oracle, ArcSDE, SDF, or SHP. The spatial database or file
is referred to as a feature source.

Using Open Source FDO Data Access Technology, AutoCAD Map 3D toolset natively accesses spatial
data. To work with features, connect to the database or file and then select the sets of features (feature
classes) to include in your map.

Drawing Objects
A drawing object is any object in a DWG file, such as a line, circle, or closed polyline.
Create and store drawing objects in the current map, or attach a DWG file to the current map and query in

its objects. AutoCAD Map 3D toolset remembers the original location of the objects and saves edited
objects back to their original file.

Section 1 | Importing and Exporting GIS Data

Basemap with parcels Pipes themed by type and size Symbols for values, hydrants,
and other point features

This map of a water distribution system is made up of features stored in a set of SDF files.
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The feature source could be a database (such as Oracle, ArcSDE, SQL Server, or MySQL), a file-based
feature source (such as SDF or SHP), a web server (such as WFS), or a table of feature geometry data
(such as Microsoft Access).

Once you connect to a feature source, you select the types of features to include in your map. Each type
of feature is called a feature class. AutoCAD Map 3D toolset displays all the features from the selected
features classes in your map, and each feature class becomes a layer in Display Manager. For example, a
feature class called Roads contains individual streets and appears on a layer called Roads in Display
Manager. You can apply a single style to this layer, and all the streets in the layer will use that style.

A schema is the definition of multiple feature classes and the relationships between them. It determines the
criteria an individual feature must meet to be a member of a particular feature class. For some feature
sources, you can add and edit a schema and its feature classes and properties.

For data stores that support multiple-geometry feature classes (Oracle, ArcSDE, WFS, SDF, PostGIS,
MySQL, SQL Server Spatial, SQLite, and SQL Server), you can specify which geometries to add to the
map for each feature class.

You use FDO to connect directly to a data source and work in its native format. Each data source type uses
its own FDO provider, and each provider has different capabilities.

For example, Oracle and ArcSDE support locking on the feature level. When you check out a feature, other
users cannot edit it, even though they can view your edits and edit other features in the feature source.
Oracle and ArcSDE also support persistent locking, so the object stays locked until you check it back in.

SHP feature sources, on the other hand, support locking on the file level. When you check out a feature,
its entire SHP file is locked. Other users cannot edit features from that file until you close the map, which
releases your lock (even if you still have features checked out at the time). Be careful to check in your
changes before you close the map.
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How To: Bring in Features from ArcGIS

1.

2.

10.

11.

In Display Manager, click Data > Connect To Data.

In the Data Connect window, select Add ArcGIS Connectionin the Data Connections By
Provider list.

Under Connection Name, type a name for this connection.
If you are connecting to a centralized Geodatabase, do the following:
e Click the ArcSDE Enterprise tab.

e Under Server Name, Instance Name, and Data Store, enter the information for your
database.

e Enter your Login Name and Password.
e Click Login.
e Optionally, select a version of the database.

e Toselect from alist of databases, click the down arrow. AutoCAD Map 3D toolset connects
to the specified server and instance and lists the available versions.

If you are connecting to a file-based or personal Geodatabase, click the File/Personal GDB tab
and, under Source File, specify the file.

Click Connect.
In the feature class list, select the feature classes to include in the map.

If this feature source contains only a single feature class, that feature class is selected
automatically. If it contains multiple feature classes, you can do either of the following:

¢ Right-click the schema entry and select Select All or Select None.
e Expand the schema entry and select the feature classes to add.

o |f afeature class contains multiple geometry types, and you select the feature class itself,
all geometries are added. To add a subset of geometries, hold your cursor over the feature
class name to see the Show Geometry button. Click Show Geometryto see each
geometry as a separate choice. Select the ones you want. Each selected geometry is
added to map as a separate Display Manager layer.

Verify that the coordinate systems are correct. You can change an incorrect coordinate system if
necessary.

If you retrieve a layer from ArcSDE and the coordinate system is not recognized, the layer may fall
to load. To load the layer, assign a coordinate system.

Click Add To Map.

To bring in a subset of the data, click the down arrow and select Add To Map With Query.
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6.1.2 Exporting GIS Data

AutoCAD Map 3D toolset acts as a hub for managing large amounts of spatial data.

Use Schema Editor to create new schemas.

Add and delete features and properties in existing schemas.

Use Data Connect to create a data store from within AutoCAD Map 3D toolset.
Export DWG data to Oracle format, ESRI ArcSDE format, or Autodesk SDF.
Export your entire map to DWG format.

Use Bulk Copy to copy data from one data store to another.

= TASK PANE

8L EX

Data Schema

=88 SDF1 | %8 Bulk Copy..

Sche View Metadata...

: - Roads

2 E-i SHP 1

j:j--i' Current Drawing [Drawing8.dwg]
: Drawings
Query Library

urrent Cuery

Use Bulk Copy to convert data from one geospatial format to another.

The Spatial Data File (SDF)

The spatial data file (SDF) format lets you store geometry and attribute information in a file-based geospatial

format.

SDF can hold more information and has faster performance than DWG. SDF supports rich geometry,
multiple tables, and spatial indexing.
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' .
The circle represents an SDF file with a single schema that defines three feature classes: valves, pipes,
and hydrants.

e Use Data Connect to connect directly to an SDF file. Any edits you make are made to the SDF file.

e |f you import data from SDF, the imported data becomes drawing objects in your map and the live
connection to the SDF file is broken. Importing is one way to convert the data from SDF to DWG.

e You can copy data to SDF format from other geospatial formats, and from SDF to those formats,
using Bulk Copy.

How To: Export Drawing Objects to SDF

SDF is a native Autodesk file-based geospatial format that is optimized for storing large, classified data
sets. SDF is like SHP format in that it contains both spatial data and attribute data. However, unlike SHP,
it stores both types of data in a single file rather than a set of files.

1. Inthe Planning And Analysis Workspace, click Output tab * Map Data Transfer panel * Map 3D
Export. 5

2. Inthe Export Location dialog box, select the Autodesk SDF file format and a location for the
exported files. Click OK.

3. Inthe Export dialog box, specify how to export objects. To use settings that you stored previously,
click Load and select the profile containing the settings.

4. On the Selection tab, specify the objects to export.

e To select a subset of objects, click Select manually and choose either Select
Objects or Quick Select.

e To filter the selection to export only objects on specific layers or in specific classes,
specify the layers and classes to include.

e To export polygons from a polygon topology, select the topology.
e To preview the objects that will be exported, click Preview Filtered Selection.

5. On the Feature Class tab, do the following:
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e To create multiple classes, select Create Multiple Classes Based On A Drawing Object.

e Click Select Attributes and select the data to export with the objects.

Tip: If you are exporting data from an external database, you can export the entire record from
the database or just the key fields. Because the key field values are stored in the map, choosing
the key field (listed under Link Templates) makes the export faster.

6. On the Options tab, select the options you want.
e To perform a coordinate conversion, you must have a coordinate system assigned to the
map.
e Check Treat closed polylines as polygons (if it is available) unless you want only polygon
objects to be exported as polygons.
7. Click OK to begin the export process.
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Section 2 | Importing and Exporting SHP File Objects
6.2.1 Importing SHP File Objects

You can access existing spatial and attribute data in ESRI SHP files, which store both geometry and
attributes (data) for features.

How To: Import Features from SHP

1. Inthe Task Pane Palette > Display Manager tab, click Data » Connect to Data...

i TASK PAME

Display Map: Default

Datal @ Connect to Data...

1 New Group
b <% New Text Layer...

= Load Layer...
£ Bulk Copy..

Add Drawing Data
Add Point Cloud Data

The Data Connect palette will appear on screen.

2. Inthe Data Connect window, select Add SHP Connection in the Data Connections By Provider list.

Data Connections by Provider

[,1 Add ArcGIS Connection
€3 Add ArcGIS Online Connection
[:l Add Enterprise Industry Model Connection

_:l Add PostgreS0L Connection

Eﬁdd Raster Image or Surface Connection
SRS St

15! Add SHP Connection
a5 Ei=5 Spatim=Lonnection

&3 Add WFS Cennection
€3 Add WMS Connection
€3 Add WMTS Connection

(' DATA COMNMECT

3. Under Connection Name, type a name for this connection.

4. Under Source File Or Folder, specify the location of the file. To include multiple files in a group,
specify a folder.
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Data Connections by Provider Data Connect hel
I;.'_ Add ArcGIS Connection D5Geo FDO Provider for SHP
@Add ArcGIS Online Connection Add a New Connection
l:?,"l' Add Enterprise Industry Model Connection Read/write access to spatial and attribute data in an ESRI
[554 Add MySOL Connection SHP file.
[, Add ODBC Connection
I;.'_ Add Oracle Connection Connection name:
I;.'_ Add PostgreSCL Connection SHP 1

F‘“ Add Raster Image or Surface Connection
5L Add SDF Connection

L. Add SHP Connection ]
I;'_ Add SCL Server Spatial Connection
[} Add 5OLite Connection

€3 Add WFS Connection

€3 Add WMS Connection

€3 Add WMTS Connection

Source file or folder:

Connect

P|

Click to browse to a file. Click = to browse to a folder.
Click Connect.
In the feature class list, select the feature classes to include in the map.

If this feature source contains only a single feature class, that feature class is selected
automatically. If it contains multiple feature classes, you can right-click any of them and
select Select All or Select None.

Verify that the coordinate systems are correct. You can change an incorrect coordinate system if
necessary.

10. Click Add To Map.

6.2.2 Exporting SHP File Objects

ESRI SHP files store both geometry and attributes (data) for features. A single shape can have as many
as five physical files with the same filename, but different file extensions.

How To Export Drawing Objects to SHP

1.

2.

At the command line, enter MAPEXPORT and press <ENTER>.

In the Export Location dialog box, select the ESRI Shapefile format and a location for the exported
files. Click OK.

In the Export dialog box, specify how to export objects. To use settings that you stored previously,
click Load and select the profile containing the settings.

On the Selection tab, specify the objects to export.

e To select a subset of objects, click Select manually and choose either Select
Objects or Quick Select.
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e To filter the selection to export only objects on specific layers or in specific classes, specify
the layers and classes to include.

e To export polygons from a polygon topology, select the topology.
e To preview the objects that will be exported, click Preview Filtered Selection.

5. On the Data tab, click Select Attributes and select the data to export with the objects.

O\% Note: If you are exporting data from an external database, you can export the entire record from
the database or just the key fields. Because the key field values are stored in the map, choosing
the key field (listed under Link Templates) makes the export faster.

Tip: If you are exporting data from an external database, you can export the entire record from
the database or just the key fields. Because the key field values are stored in the map, choosing
the key field (listed under Link Templates) makes the export faster.

6. On the Options tab, select the options you want.
e To perform a coordinate conversion, you must have a coordinate system assigned to the map.

e Check Treat closed polylines as polygons (if it is available) unless you want only polygon
objects to be exported as polygons.

e Click Driver Options to select Two Dimension Shape Files or Three Dimension Shape Files.

7. Click OK to begin the export process.
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Chapter 7 | Plotting

Printing vs Plotting

The terms printing and plotting can be used interchangeably for CAD output. Historically, printers would
generate text only, and plotters would generate vector graphics. As printers became more powerful and
could generate high-quality raster images of vector data, the distinction largely disappeared.

In addition to paper output, electronic delivery of multiple drawing sheets uses the encompassing
term, publishing. The process of generating physical models in plastic and metal is called 3D printing.

Plotter Manager

The Plotter Manager is a window that lists plotter configuration (PC3) files for every non-system printer that
you install. Plotter configuration files can also be created for Windows ® system printers if you want to use
default properties different from those used by Windows. Plotter configuration settings specify port
information, raster and vector graphics quality, paper sizes, and custom properties that depend on the
plotter type.

The Plotter Manager contains the Add-a-Plotter wizard, which is the primary tool for creating plotter
configurations. The Add-a-Plotter wizard prompts you for information about the plotter that you want to set

up.
Layouts

A layout represents a drawing sheet, and typically includes
e A drawing border and title block
e One or more layout viewports that display views of model space
e General notes, labels, and possibly dimensions
e Tables and schedules

Usually, a drawing file contains only one layout, but you can create as many layouts as you need. The first
time you display a layout, it is initialized, and a default page setup is assigned to it.

Once initialized, layouts can be modified, published, and added to sheet sets as sheets.

Page Setups

When you create a layout, you specify a plotter, and settings such as paper size and orientation. These
settings are saved in the drawing as a page setup. Each layout can be associated with a different page
setup.

You can control these settings for layouts and for model space using the Page Setup Manager. You can
name and save page setups for use with other layouts.

If you do not specify all the settings in the Page Setup dialog box when you create a layout, you can set up
the page just before you plot. Or you can override a page setup at plot time. You can use the new page
setup temporarily for the current plot, or you can save the new page setup.
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Plot Styles

A plot style is an optional method that controls how each object or layer is plotted. Assigning a plot style to
an object or a layer overrides properties such as color, lineweight, and linetype when plotting. Only the
appearance of plotted objects is affected by plot style.

Plot style tables collect groups of plot styles, and save them in a file that you can later apply when plotting.

The Plot Style Manager is a folder that contains all the available plot style tables, along with the Add-A-
Plot-Style wizard.

There are two plot style types: color-dependent and hamed. A drawing can use only one type of plot style
table. You can convert a plot style table from one type to the other.

For color-dependent plot style tables, an object's color determines how it is plotted. These plot style table
files have .ctb extensions. You cannot assign color-dependent plot styles directly to objects. Instead, to
control how an object is plotted, you change its color. For example, all objects assigned the color red in a
drawing are plotted the same way.

Named plot style tables use plot styles that are assigned directly to objects and layers. These plot style
table files have .stb extensions. Using them enables each object in a drawing to be plotted differently,
independent of its color.

Plot Stamps

A plot stamp is a line of text that is added to your plot. You can specify where this text is located on the plot
in the Plot Stamp dialog box. Turn this option on to add specified plot stamp information—including drawing
name, layout name, date and time, and so on—to a drawing that is plotted to any device. You can choose
to record the plot stamp information to a log file instead of plotting it, or in addition to plotting it.

Note: Drawings created with an Autodesk product labeled Student Version in the title bar of the application
window automatically use a plot stamp that reads, "PRODUCED BY AN AUTODESK STUDENT
VERSION". The STUDENTDRAWING system variable reports whether the current drawing was created
with an Autodesk Student Version product.

About Model Space and Paper Space

There are two distinct working environments, called "model space" and "paper space," in which you can
work with objects in a drawing.

e By default, you start working in a limitless 3D drawing area called model space. You begin by
deciding whether one unit represents one millimeter, one centimeter, one inch, one foot, or
whatever unit is most convenient. You then draw at 1:1 scale.

e To prepare your drawing for printing, switch to paper space. Here you can set up different
layouts with title blocks and notes; and on each layout, you create layout viewports that display
different views of model space. In the layout viewports, you scale the model space views
relative to paper space. One unit in paper space represents the actual distance on a sheet of
paper, either in millimeters or inches, depending on how you configure your page setup.
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Model space is accessible from the Model tab and paper space is accessible from the layout tabs.

Model  Layoutl papeR |, B~ + ~ B 3 - + 2o [ @ = =

About Switching Between the Model Tab and Layout Tabs

You can control how you change between the Model tab and one or more named layout tabs.

By default, a Model tab and several named layout tabs are displayed at the bottom-left corner of the drawing
area.
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Model Layout +

= Note: If the tabs are not visible, enter OPTIONS at the Command prompt, then check Display
Layout and Models Tabs on the Display tab.

Click the plus (+) icon to add more layout tabs.

When there are more than can be displayed at one time, click the double-down arrow to view the layout
tabs in a drop-down list.

N

-

v
v

e To get more space for displaying multiple layout tabs, you can right-click the Model or a Layout tab
and select Dock Above Status Bar. The Model and Layout tab are displayed in a separate line
above the status bar.

e To optimize space in the drawing area, right-click the Model or a Layout tab and select Dock Inline
With Status Bar. The Model and Layout tab are displayed inline with the status bar.

Note: Access to the complete set of shortcut menu options is available from the tabs only.

To Switch Between Paper Space and Model Space on a Layout

e When you're in paper space, you can double-click within a layout viewport to access model space.

e Ifyou are in model space and want to switch to another layout viewport, double-click within another
layout viewport, or press Ctrl+R to cycle through the existing layout viewports.

e To return to paper space, double-click anywhere outside the layout viewport.

%= | Note: To prevent changes to scaling, lock the layout viewport display before you access model
space. When the display is locked, you cannot use ZOOM while you work in model space.
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Section 1 | Working with Layouts

A layout is a 2D working environment for creating drawing sheets.

The area within a layout is called paper space, where you can add a title block, display scaled views of
model space within layout viewports, and create tables, schedules, notes, and dimensions for your drawing.

You can access one or more layouts from the tabs located at the bottom-left corner of the drawing area to
the right of the Model tab. You can use multiple layout tabs to display details of the various components of
your model at several scales and on different sheet sizes.

_+_

_+_

Model tab model space layout tab title block

PapPET SPace =—

layout viewports

There are several ways in which you can add new layouts or copy existing layouts.
e Use the LAYOUT command
e Right-click a layout tab
e Step through the Create Layout wizard
e Use DesignCenter

Each layout stores its own page setup which controls the appearance and format for displaying and printing
each layout. For example, you would use the page setup to specify the sheet size and orientation. The
Page Setup Manager is accessible from the PAGESETUP command, the Application menu, and the ribbon.
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In this exercise you plot drawings from model space.

You do the following:

e Start the Plot command.

e Specify the printer.

e Specify the paper size.

e Specify what to plot.

e Specify the plot scale.

e Apply a plot style table.

e Output to an electronic file.

1.1.2 Plotting from Model Space

In this exercise you will explore multiple ways to print from model space.

BILLOF MATERIALS
[ oewcwenon | @i |

1. Open drawing 11.1.1 Plotting 1.dwg.

You will begin by printing the entire drawing on 8.5 x 11 inch paper.
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2. Select Quick Access Toolbar: Plot.

You may be prompted to learn more about
Batch Plot. This is a feature that allows you
to print several sheets at once.

3. If the prompt does not appear,
move on to the next step.
Otherwise, select Continue to
plot a single sheet.

Enable the Do not show me this again
checkbox if you do not want to see this
message the next time you print.

The Plot dialog box appears.

4. Set the Printer/plotter Name to

AutoCAD PDF (High Quality Print).

This plotter outputs to a digital file rather than a
paper plotter.

EEELETE: El

N

Batch Plot x
We noticed that you have multiple drawings/layouts open.
Batch Plot (Publish) is available for plotting multiple sheets at
once. What do you want to do?

—> Learn more about Batch Plot (Publish)

—> Try Batch Plot (Publish)

To plot multiple sheets from cne or multiple drawings

—> Continue to plot a single sheet

[ De not shew me this again

5. Set the Paper size to ANSI A (8.50 x 11.00 Inches). Eapegs=

6. Under Plot area, select Extents.

Just as performing a zoom extents will zoom to show everything
drawn in model space, plotting to extents will plot everything that

is drawn in model space.

Printer fplotter

Name: ﬁ AutoCAD PDF {High Quality Print).pc3 w Properties

Plotter: DWG To PDF - PDF ePlot - by Autodesk k—asr

Where: File T

Description: E
PDF Options... \|J

ANSI A (8,50 x 11,00 Inches) ~
Plot area

What to plot:

7. Under Plot scale, disable the Fit to paper option. otscae

8. Click the Scale drop-down list, then select 1:2.

|:| Fit to paper

inches

Scale lineweights

9. Under Plot offset, enable the Center the plot option. PR e DR LR )

¥: | 0.990934

y: | 1351863
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10. Under Plot style table, select monochrome from the
drop-down list.

11. Click <<No>> to only apply the plot style table to the
current layout.

Plot style table (pen assignments)

monochrome. cth

v %

Question

o Assign this plot style table to all layouts?

The monochrome plot style table will force every object to print black, regardless of the
on-screen colors. This results in a uniform drawing. If this change is not made, lines
printed in light colors such as yellow will print very lightly on paper and would be difficult

to see.
Click <<Preview...>> in the lower-left corner of the dialog box.

If any changes need to be made, you would click the Close
Preview button on the toolbar to return to the Plot dialog box. If
everything is previewing correctly, you can plot.

12. Click Plot on the toolbar.

=% ald

()

The drawing would print out if you were printing to a physical printer. Since you are

printing to a digital file, the Browse for Plot File dialog box appears.

13. Browse to: C:\A Practical Guide\AutoCAD 2022\.

14. Accept the default name and click <<Save>>.

The PDF file is created. You can open Windows Explorer, browse to C:\A Practical
Guide\AutoCAD 2022\, locate the file, then double-click on it to open and view the file.
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Next you will create a window plot of only the front
section view.

15. Select Quick Access Toolbar: Plot. EECEE B

16. If the prompted to learn about Batch Plotting, select Continue to plot a single sheet.
Otherwise, move on to the next step.

The Plot dialog box appears.
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17. Set the Printer/plotter Name to Xl il
AutoCAD PDF (High Quality Print). Name: 7B AutoCAD POF (High Quality Print).pc3 v Properties
Flotter: DWG To FOF - PDF ePlot - by Autodesk ka5 —y

Where:

Description:

File

— 0T —

PDF Options...

18. Set the Paper size to ANSI A (8.50 x
11.00 Inches).

19. Under Plot area, select Window.

Paper size

ANSI A (8.50 x 11.00 Inches)

Plot area

What to plot:

The Plot dialog box temporarily disappears, and
you are taken back to the drawing window.

20. Pick two diagonal endpoints to create a
rectangle around the front view. i

After selecting the second point, you are returned
to the Plot dialog box.

21. Under Plot scale, disable the Fit to paper option.

22. Click the Scale drop-down list, then select 1:1.

23. Under Plot offset, enable the Center the plot option.

24. Under Plot style table, select monochrome from the
drop-down list.

Plot scale

|:| Fit to paper

<

inches ~| =

Scale lineweights

Plot offset (origin set to printable area)
¥ | 0.130587 e’

y. | 1540943

Plot style table (pen assignments)

monochrome. cth w E
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25. Click <<No>> to only apply the plot style table to the Question
current layout.

o Assign this plot style table to all layouts?

Yes Mo
26. Click <<Preview...>> in the lower-left corner of the dialog box.
27. If prompted that the annotation scale is Plot - Plot Scale Confirm w
not equal to the plot scale, click
<<Continue>>. Otherwise, move on to | Theannotation scale is not equal to the plot scale. Do you
the next step. ** want to continue?

Enable the Always continue under these
conditions checkbox if you do not want to see this

O Always continue under these conditions Cancel

message the next time you print.

28. Click Plot on the toolbar. aleocno o

29. Browse to: C:\A Practical Guide\AutoCAD 2022\.
30. Edit the file name to 11.1.1 Plotting 1-Front View.
31. Click <<Save>>.

The PDF file is created. You can open Windows Explorer, browse to C:\A Practical
Guide\AutoCAD 2022\, locate the file, then double-click on it to open and view the file.

32. Save the drawing.
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In this exercise you plot drawings from paper space.

You do the following:

Modify a paper space layout.

Specify the printer.
Specify the paper size.
Specify what to plot.
Specify the plot scale.
Apply a plot style table.

Create and modify viewports.

Scale and lock viewports.
Copy and rename a layout.
Freeze layers in a viewport.
Start the Plot command.
Output to an electronic file.
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1.1.1 Plotting from Paper Space

In this exercise you will prepare a drawing to be printed. You will use Paper Space
layouts and viewports to scale the drawing properly.

e f—

1. Open drawing 11.2.1 Plotting 3.dwg.
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2. Select the Layoutl tab.

The default layout tab is not set up properly. You will
begin by modifying the Page Setup.

3. Right-click the Layoutl tab, then select

Page Setup Manager... from the
context menu.

The Page Setup Manager dialog box appears.

4. Click <<Modify...>>.

The Page Setup dialog box for Layoutl appears.

5. Set the Printer/plotter Name to
AutoCAD PDF (High Quality Print).

This plotter outputs to a digital file rather than a
paper plotter.

6. Setthe Paper size to
ARCH C (18.00 x 24.00 Inches).

Model Layout1 +
N
"

Page Setup Manager...
Plot...

Drafting Standard Setup...

Import Layout as Sheet...

Export Layout to Model...

22 BElv Type a «

Dock above Status Bar

Model Layout1 +

Page setups
Current page setup: <Mone>
Hayoutl® Set Current
New...
Modify...
Impart...
Printerplotter
Name: T8 AutoCAD PDF {High Quality Print).pc3 v Properties
Plotter: DWG To PDF - PDF ePlot - by Autodesk k—asr
Where: File T
Description: 5
PDF Options... \L
Paper size
ARCH € {18.00 x 24.00 Inches) v
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7. Confirm that Plot area is set to Layout, | Patares Plot scale
and that Plot scale is setto 1:1. Wihat to plot: Fit to paper
i > Scale: | 1:1 s

When working with Paper Space layouts, the Plot —

g . p p y Flot offset {origin set to printable area) inches =~ | =
area should typically be set to Layout, and the Plot N o I
scale should be set to 1:1. The actual scaling of the B Unit

drawing will be done through viewports.

8. Under Plot style table, select
monochrome from the drop-down list.

ys | 0.000000 | inch

[ 5cale lineweights

monochreme. cth

Plot style table {pen assignments)

V| %

Monochrome will print every object black, regardless of the on-screen colors. This results
in a uniform drawing. If this change is not made, lines printed in light colors such as
yellow will print very lightly on paper and would be difficult to see. Additional plot style
tables can be set up to print different lineweights and lineypes for more detailed printing.

9. Click <<OK>> to close the Page Setup dialog box.

10. Click <<Close>> to close the Page Setup Manager dialog box.

The 18" X 24" sheet is now visible on-screen, as
well as a dashed rectangle and a solid rectangle.

The dashed rectangle represents the printable
area. This is based upon the allowable margins of
the selected printer as well as the orientation of the
paper. Choosing a different printer or orientation
could result in a change to the printable area.

The solid rectangle is a viewport. A viewport is
essentially a window to Model Space, allowing you
to view and scale the geometry that was created
there.

Next you will insert a title block and border.

11. Set BORDER as the current layer

Printable Area -

Viewport
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12. Select Ribbon: Home = Block = Insert.

Create

< Edit

") Edit Attributes -
Block =

13. Select C-Size ARCHITECTURAL from the

® % [7 o [l BORDER - '_]

drOp'dOWn list. “% £ G, < £ Make Current [
nse
E= g//. £ T &5 Match Layer T

C-Size ARCHIT... ree - deciducus plan

Recent Blocks...

Blocks from Other Drawings...

14. At the Command line type @0,0 then press [Enter] at the keyboard to locate the title block at
the origin.

The title block and border have been placed. Note e T
that it fits within the printable area.

The viewport needs to be adjusted to better fill the s - =
printable area.

15. Select the viewport.

Grips appear at each corner of the viewport.

16. Select the upper-right corner grip, then
stretch to the upper-right corner of the 1
drawing area.

ny f

17. With the viewport still selected, change its layer to VIEWPORTS.
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The VIEWPORTS layer has been created as a non-printing |g\\,.,EWPCRTS 7 % B

& oo |

layer.
18. Press [Esc] at the keyboard to deselect the viewport.
19. Double-click inside the viewport to activate floating model space.

Be sure to double-click inside the viewport, not on the viewport.

20. Double-click the scroll wheel button on the mouse to perform a Zoom Extents.

The view of the viewport adjusts to display the drawing.

Next you will adjust the viewport scale.

21. Select Status Bar: Viewport Scale = 1:8 to set
the scale.

gxa]e-pF#-+ma=]

22. Select Status Bar: Viewport Lock to lock the
scale.

This will prevent any accidental changes to the scale.

The drawing appears as shown:

23. Double-click anywhere outside of the viewport to return to paper space.

Next you will rename the layout to a more meaningful name.
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24. Right-click on the Layout1 tab, then select
Rename.

25. Type Site Plan, then press [Enter] at the
keyboard.

Next you will create a copy of the Site Plan layout.

Mew Layout
From Template...

Delete

Rename
Move or Copy... %

Select All Layouts

Activate Previous Layout

Activate Model Tab

Page Setup Manager...
Plot...

Drafting Standard Setup...

Import Layout as Sheet...
Export Layout to Model...

Dock above Status Bar

Model

Layout1 F

26. Right-click on the Site Plan tab, then select Move or Copy...

The Move or Copy dialog box appears.
27. Under Before layout: select (move to end).
28. Enable the Create a copy option.

29. Click <<OK>>.

A new tab appears with the name Site Plan (2).

30. Select the Site Plan (2) tab.

A Move or Copy

Mave or copy selected layouts

Before layout:

(move to end)

Create a copy

0

Copying an existing layout saves time because you do not have to modify the page setup

or insert the title block.

31. Right-click on the Site Plan (2) tab, then select Rename.

32. Type Shed Layout, then press [Enter] at the keyboard.

This layout will have two viewports. While it is possible to modify the existing viewport, it

is often more efficient to delete it, then draw new viewports.

33. Select the existing viewport, then press [Delete] at the keyboard to erase it.

314
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34. Select Ribbon: Layout = Layout Viewports = Rectangular. [ ID Rectangular -

Ll ., Clip
Insert View -
L4 Lock -

Layout Viewports 8

35. Click two diagonal points to create a
viewport that fills the left half of the
drawing area.

36. Repeat the process to create a second
rectangular view as shown.

37. Select both viewports, then change
their layer to VIEWPORTS.

38. Press [Esc] at the keyboard to
deselect the viewports.

Next you will adjust the viewport scales.

39. Double-click inside the larger viewport to the left.

40. Select Status Bar: Viewport Scale = 1:10 to set
the scale.

;f;éa’ud-::--+%o=%|z|z|

41. Select Status Bar: Viewport Lock to lock the
scale.

xqal vo- o8-+ % so=|

42. Click in the smaller viewport.

43. Select Status Bar: Viewport Scale = 1:4 to set
the scale.

KRG ofa-E 8-+ P ®i0=
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44. Pan the view to show the proposed Fam—
shed and concrete pad.

Because the viewport scale has already been set,
be carefully not to zoom in or out, as doing so will
override the 1:4 scale. If this occurs, simply set the
1:4 scale in the status bar again.

45, Select Status Bar: Viewport Lock to lock the
scale.
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46. Select Ribbon: Home = Layers =
Layer Control drop-down.

47. Select the Freeze or thaw in current
viewport icon for the HATCHING and
TEXT layers to Freeze them only in this
viewport.

2T W HATCHING

48. Click anywhere in the drawing window to close the Layer Control drop-down list.
The hatching and text layers are hidden from the viewport, but are still visible in all other views.
49. Double-click anywhere outside of the two viewports to return to Paper Space.

Finally, you will print to a PDF file.

50. Select Quick Access Toolbar: Plot. | CoHELR Al - - =|

51. You may be prompted to learn more about batch plotting. If so, select Continue to plot a
single sheet.

The Plot dialog box appears. Since you already adjusted the settings when the layout
was created, you should not need to change anything. However, it is always a good idea
to preview before printing.

52. Click <<Preview...>> in the lower-left corner of the dialog box.

If any changes need to be made, you would click the Close Preview button on alvecna ® |
the toolbar to return to the Plot dialog box. If everything is previewing correctly —
click plot.

53. Click Plot on the toolbar.

The drawing would print out if you were printing to a physical printer. Since you are
printing to a digital file, the Browse for Plot File dialog box appears.

54, Browse to: C:\A Practical Guide\AutoCAD 2022\.
55. Accept the default name and click <<Save>>.

The PDF file is created. You can open Windows Explorer, browse to C:\A Practical
Guide\AutoCAD 2022\, locate the file, then double-click on it to open and view the file.

56. Save the drawing.
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Chapter 8 | Migrate Legacy Data into Civil3D

Section 1 | Working with Bentley MicroStation Files

8.1.1 DGN Import
You can import data from V7 DGN and V8 DGN files into AutoCAD and save the data to DWG files.

The import process translates basic DGN data into the corresponding DWG file data and specialized data
as a best fit. There are several translation options to determine how certain data such as text elements
and external references are handled. You can manipulate text elements and external references and
select the conversion units based on DGN unit settings.

Note: You can import all DGN files, even those that don't have a .dgn extension.

Understand the Limitations

The import process handles DGN objects and properties that have a direct correlation to DWG objects and
properties without any issues. For example, levels in MicroStation translate directly to AutoCAD layers.
However, DGN objects and properties that have no direct correlation to DWG objects and properties may
not translate completely. The following are known limitations resulting from this issue.

Data with built-in features or variations are visually approximated. For example, text and dimensions with
specialized formatting, and color definitions might be customized.

Entities in the DGN file that have a color property set for a symbol lose the symbol color when imported as
a block.

Linetypes associated with multilines do not display.

Entities with DGN line styles in nonuniformly scaled blocks may look different to how they appear in
MicroStation.

Line style modifier settings of an element in the DGN file are lost when exporting them from AutoCAD back
to MicroStation.

The Closed property of a DGN polygon or closed polyline changes to No during import.

See the DGNIMPORT Conversion Table for specific details about the scope of importing MicroStation
objects and other data.

See the DGNIMPORT Unit Mapping Table for specific details about unit conversions when importing
MicroStation objects.
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Recommendations

To optimize the data transfer from the MicroStation® DGN file format, request that the creator of the
MicroStation drawings consider the following recommendations:

e Create a separate DGN file for each design model.

e Do not reference sheet models from design models.

¢ Minimize the use of custom objects and other data unique to MicroStation.

e Use ByLevel for color, line style, and weight properties.

e Use simple patterns and pattern styles.

e Use TrueType text fonts rather than SHX text fonts.

e Use defined styles for dimensions and text rather than a “none” style.

e Use simple dimension styles if possible.

e Use shared cells as opposed to normal (library) cells.

e  Work primarily in one format, DWG or DGN, rather than switching back and forth.

Conversion Units

When importing a DGN file, ensure that the DWG file's drawing units match either the master units or sub
units of the DGN file. For example, assume that you are importing a DGN file with master units set to
meters, and sub units set to millimeters. You can set the DWG file's drawing units to meters. When importing
the DGN file, in the Import DGN Settings dialog box, specify master units as the conversion unit.

Import Custom Line Style Definitions

If a DGN file does not contain linetype definitions, and these definitions do not exist in any *.rsc files in the
support path, all linetypes in the DGN file are displayed as a continuous linetype in AutoCAD. To ensure
that custom linetypes are displayed, copy the corresponding *.rsc files to the support path. Alternatively,
you can add the RSC file path to the search path in AutoCAD in the Options dialog box (Files tab, Support
File Search Path).

Import Referenced DGN Files

While importing a DGN file, the program displays the Import DGN Settings dialog box. To convert
referenced DGN files to block references, select the Import into Current Drawing option and the Translate
References to Blocks or Xrefs option. To convert the referenced DGN files to DWG external references,
ensure that both these options are cleared.

Microstation Standard Line Styles

Do not use the MicroStation standard line styles 1 to 7. The scaling for these line styles is based on output
device coordinates. For best results, use custom line styles.
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Manage Translation Mapping Setups

Translation mappings define how DGN properties translate to DWG properties. You can use the DGN
Mapping Setups dialog box to create, modify, rename, or delete mapping translations based on your
company’s CAD standards. For example:

e Change DGN level names to appropriate DWG layer names
e Remap unsupported DGN linestyles to DWG linetypes
e Remap lineweights and adjust color mapping

The DGN Mapping Setups dialog box displays when you click Mapping Setups in the Import DGN Settings
and Export DGN Settings dialog boxes. You can also use the DGNMAPPING command to display this
dialog box.

Working with DGN Mapping Setups

You can create, modify, rename, or delete mapping translations to control how properties are translated
between DGN and DWG files.

How To: Create a DGN Mapping Setup
1. Atthe Command prompt, enter DGNMAPPING. The DGN Mapping Setups dialog box displays.
2. Click New. The New Mapping Setup dialog box is displayed.
3. Under New DGN mapping setup name, enter a mapping setup name.
4. Under Based On, select an existing mapping setup.
5. Select a mapping type.
6. Click Continue. The Modify DGN Mapping Setup dialog box displays.
7. Select each tab, inspect the property mappings, and edit them if necessary.

How To: Modify a DGN Mapping Setup

1. Atthe Command prompt, enter DGNMAPPING.

2. Inthe DGN Mapping Setups dialog box, select the mapping setup to modify.
Note: You cannot modify the Standard mapping setup.

3. Click Modify. The Modify DGN Mapping Setup dialog box is displayed.

4. Select the tab containing the property mapping to change.

5. Locate the row corresponding to the property mapping and make the required change.
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How To: Delete a DGN Mapping Setup

1. Atthe Command prompt, enter DGNMAPPING.

2. Inthe DGN Mapping Setups dialog box, select the mapping setup to delete.

= Note: You cannot modify the Standard mapping setup.

3. Click Delete.
4. When the Delete Mapping Setup prompt is displayed, click Yes.
How To: Rename a DGN Mapping Setup
1. Atthe Command prompt, enter DGNMAPPING.
2. In the DGN Mapping Setups dialog box, select the mapping setup to rename.
Note: You cannot modify the Standard mapping setup.
3. Click Rename.
4. Enter new mapping setup name.
5. Click anywhere outside the text box.
How To: Add Properties from a DWG File
1. Atthe Command prompt, enter DGNMAPPING.
2. Inthe DGN Mapping Setups dialog box, select the mapping setup to modify.
Note: You cannot modify the Standard mapping setup.

3. In the Modify DGN Mapping Setup dialog box, click Add Properties from Drawing File. The Add
Properties from Drawing File dialog box is displayed.

4. Select a drawing file and click Open.
5. The unique properties of the file are added to the bottom of the DWG column for each tab.

How To: Add Properties from a DGN File

1. Atthe Command prompt, enter DGNMAPPING.

2. Inthe DGN Mapping Setups dialog box, select the mapping setup to modify.

= Note: You cannot modify the Standard mapping setup.

3. In the Modify DGN Mapping Setup dialog box, click Add Properties from DGN File button.
4. The Add Properties from DGN File dialog box is displayed. Select a DGN file and click Open.

5. The unique properties of the file are added to the bottom of the DGN column for each tab.
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DGNIMPORT Conversion Table

The following table lists the DGN objects and features that are supported for import, and notes on the scope

of the translation.

DGN to DWG Conversion Table

MicroStation Autodesk Product
Geometric Elements Geometric Objects
Levels Layers

Colors Colors

Line Styles Linetypes

Cells Blocks

Notes

The following DGN elements are translated into DWG
objects: line, SmartLine, LineString, multiline, shape,
complex chain, complex shape, arc, ellipse, curve, B-
spline curve, and pattern. Pattern elements are limited
to simple pattern styles. Bitonal gradient properties are
also supported.

DGN levels are mapped automatically into the
equivalent DWG layers. Invalid DGN characters in
level names are converted to spaces.

All colors are translated using RGB values either to the
ACI (AutoCAD Color Index) or TrueColor index as
appropriate.

For the correct display of linetypes, the MicroStation
.rsc (resource file) that is referenced by the DGN file
must be available on your computer in a valid
AutoCAD Support File search path when you import or
attach the DGN file.

Dynamically scaled line styles (Standard DGN Line

Styles 1-7) are converted into fixed-scale linetypes.

The resulting linetypes take into account the current
zoom factor in a view in the DGN file when they are
imported or attached as a DGN file into AutoCAD.

Note:

To import standard V7 line styles correctly, you must
“Fit View” and “Save Settings” in MicroStation first.

Cells are converted into blocks. Tags that are
associated with cells are converted into constant-mode
block attributes.
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DGN to DWG Conversion Table

MicroStation Autodesk Product Notes

Text Elements, Text Single-line Text Missing SHX text fonts are converted into the

Styles Objects, Multiline AutoCAD text font specified in the FONTALT system
Text Objects, Text variable. The acad.fmp file (AutoCAD) or aclt.fmp file
Styles (AutoCAD LT) can be used to map SHX text fonts to

DGN text fonts.

TrueType fonts and SHX fonts in AutoCAD are
exported to MicroStation V7 as Engineering. This can
result in many visual differences.

Tables Tables Cells that represent tables in DGN are imported as
blocks.

Dimensions, Dimension Dimensions, The size, spacing, style, and shape of dimensions may

Styles Dimension Styles vary slightly. Dimension associativity is maintained

whenever possible, and the correct dimension values
are always maintained.

Fields Fields In general, fields are translated as static text. The
exceptions are fields that behave identically in both
products. This includes the Date
fields CreateDate, SaveDate, and PlotDate, and the
Document property fields Author, Filename,
and Filesize.

Fields are converted to text when “Explode Text Nodes
to Text Elements” is checked in the Import DGN
Settings dialog box.

Raster Images Raster Images These image file types: .bmp, .cal, .tif, .png, .tga, .jpg,
.pcx, .gif, .rlc, .bil, and .pct are supported. All other
image file types are not.

DGN References DWG References .dwg and .dgn file types are supported. Other non-
DGN file types such as .cel, .h, .s, .d, .rdl, and .cgm
are also supported.
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DGN to DWG Conversion Table

MicroStation Autodesk Product Notes

DGN Design Model DWG Model The selected design model in a DGN file is converted
into a DWG file.

DGN Sheet Model DWG Layout Only the sheet models that reference the primary design

model are imported. DGN sheet models are translated
as layouts in a DWG file.
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DGNIMPORT Unit Mapping Table

The following table lists the linear units used in the resulting DWG file as determined by the master units,
sub-units, and unit precision of the DGN file being imported.

DGN to DWG Unit Mapping Table

DGN Master Units DGN Sub Units

Feet

Feet

Inches

Inches

Inches

Inches

Inches

Inches

Inches

Any Other Unit

Inches

Inches

Inches

Inches

Any Other Unit

Any Other Unit

Any Other Unit

Any Other Unit

Any Other Unit

Any Other Unit

DGN Precision DWG Units Notes

Decimal

Fractional

Decimal

Fractional

Decimal

Decimal

Fractional

Fractional

Decimal

Fractional

Engineering

Architectural

Engineering

Architectural

Engineering  Master Units selected in the
Import DGN Settings dialog box.

Decimal Sub Units selected in the Import
DGN Settings dialog box.

Architectural Master Units selected in the
Import DGN Settings dialog box

Fractional Sub Units selected in the Import
DGN Settings dialog box

Decimal

Fractional
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For import of a V7 file, Master unit label will be read and will use the following table to set the Master units
based on the unit translation table. The Resolution value will be used to set the Sub units.

%I Note: Unknown labels will be treated as “meters” and “decimeters.”

V7 DGN Unit Translation Table

DGN Label

km

dc

cm

um

How To: Import a MicroStation DGN Drawing

Name

kilometers

meters

decimeters

centimeters

millimeters

microns

DGN Label

mi

yd

ft

tn

ti

ui

- L
Click Application menu * Open » DGN. iEEEi

Name

miles

yard

feet

inches

1/10 feet

1/10 inches

micro inches

feet

inches

feet

In the Import DGN File dialog box, find and select the DGN file you want to import, or enter
the name of the DGN file in the File Name box.

Click Open.

In the Import DGN Settings dialog box, select a design model from the list and specify the

desired import options.
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8.1.2 Exporting MicroStation DGN Files

You can export DWG files to the V7 DGN and V8 DGN drawing file formats.

The expo
dataasa

rt process translates basic DWG file data into the corresponding DGN file data, and specialized
best fit. There are several translation options to determine how data is translated during the export

process. For example:

How external references are handled

How the dynamic range of the DGN file as controlled by the master and subunits are
specified

Whether the DGN file should accept data with nonzero Z coordinates

The export process uses a standard mapping translation by default, which maps DWG-format layers,

linetypes,

lineweights, and colors to DGN-format levels, linestyles, lineweights, and colors. If necessary,

you can change the mappings to match your company CAD standards. You can edit the mappings with the
DGNMAPPING command.

Underst
AutoCAD

and the Limitations

objects and properties that have a direct correlation to DGN objects and properties are exported

without any issues. For example, AutoCAD layers are translated directly to MicroStation levels. However,

AutoCAD

objects and properties that have no direct correlation to DGN objects and properties will not

translate with full fidelity. The following are known limitations that result.

Data with built-in features or variations are visually approximated. For example, text and
dimensions with specialized formatting and customized color definitions.

Some AutoCAD-specific data cannot be translated completely. For example, features such
as dynamic blocks, can be represented visually but not behaviorally.

Nested references are not merged into the host DGN file when exporting to V7 DGN. The
nested reference is not displayed in the host DGN file but the reference chain still exists.

AEC objects are not exported to DGN. Use the EXPORTTOAUTOCAD command to convert
the AEC objects to base AutoCAD objects before exporting to DGN.

AutoCAD does not export linetype definitions to DGN files. If the exported DGN file contains
references to linetype definitions, the linetypes might not display correctly in MicroStation.

See the DGNEXPORT Conversion Table for specific details about the scope of exporting DWG objects
and other data to DGN files.

= Note: Do not export drawings that include V8 DGN underlays to a V7 DGN format file. V8 DGN
references cannot display in a V7 DGN file. The V8 DGN file format is not a valid design file for
the resulting V7 DGN file.
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Recommendations

To optimize the data transfer to the MicroStation DGN file format, consider the following recommendations:

e Minimize the use of custom objects and other data unique to AutoCAD-based products.

e Use simple linetypes as much as possible.

e Use simple hatches and hatch styles.

e Use simple gradients and gradient styles.

e Use simple dimension styles if possible.

e Use TrueType text fonts rather than SHX text fonts.

e Work primarily in one format, DWG or DGN, rather than switching back and forth
Conversion Units

When exporting, match the DWG file's drawing units either to the master units or to the sub units of the
DGN seed file. A DGN seed file is similar to a drawing template (DWT) file in AutoCAD. It contains default
settings and attributes such as working units, for the DGN file.

For example, assume that you are exporting a DWG file that was created in inches. The DGN seed file you
selected has its master units set to feet and sub units set to inches. While exporting, in the Export Settings
dialog box, select sub units in the Specify Seed File section. This matches the inches used in the DWG file
with the inches specified in the DGN seed file.

Note: Some programs that work with DGN files do not support extended characters for file names. As
such, do not use accented or Asian characters in file names when using DGNEXPORT.
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Export DGN Settings Dialog Box

Controls how objects are processed when exporting them to a DGN file.

b
DGNEXPORT (Command) Eﬂ

B Export DGN Settings >
[ g

Export to: C:\Users\Administrator \Documents'test.dgn

External DWG references Translate DWG properties to DGM properties
(®)iTranslate all WG references to DGM files: Select mapping setup: Mapping preview for setup: Standard
Prompt to overwrite g Layer Linetype Lineweight Color
DG DG
() gind all DWG references into one DGN file
0 1]

() Ignore DWG references

External DGM references

Export DGM underlays as DGM references
Setup description:

Specify seed file Standard mapping setup.
\enu'Template\Ve-Imperial-5eed2D.dat ~
@ Master units Feet

() 5ub units Inches -
Mapping Setups...

i Select a mapping setup to
. change the mapping preview
for the file you selected.

Cancel Help

List of Options

The following options are displayed.

External DWG References
Controls how xrefs are processed.

Translate All DWG References to DGN Files

All referenced DWG files, including nested DWG references, are converted into DGN files. The
resulting DGN files use the same file name as the DWG files but use a .dgn file extension.

With the following set of options, you can choose whether to overwrite DGN reference files

e  Prompt to Overwrite
e  Overwrite without Prompting

e Do Not Overwrite
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Bind All DWG References into One DGN file
The parent DWG file and all referenced DWG files are combined into a single DGN file. The
referenced DWG files are converted to cells as part of the primary DGN file.

Ignore DWG References

Referenced DWG files are not included in the resulting DGN file.

External DGN References

Controls whether DGN underlays in the DWG file are exported as DGN references of the resulting DGN
file.
Export DGN Underlays as DGN References

When checked, any DGN underlays are exported as DGN references along with the base drawing.
When cleared, DGN underlays are not exported.

= Note: Do not export drawings that include V8 DGN underlays to a V7 DGN format file. The V8
DGN references cannot display in a V7 DGN file because the V8 DGN file format is not a valid
design file for the resulting V7 DGN file.

Specify Seed File

A seed file for a DGN file is similar to a drawing template (DWT) file that contains default settings and
attributes, such as working units. Selecting the appropriate DGN seed file (imperial, metric, or user-defined),
and conversion units is critical to the translation from DWG to DGN. In addition, the seed file contains
settings that are not present in a DWG file, and therefore inherited in the exported DGN.

These settings include working units and resolution as well as whether the file is 2D or 3D.

Conversion Units

Select the appropriate conversion units for the translation. The DGN seed file contains working units
(imperial or metric) called master units and sub-units. One DWG unit is converted to either one master unit
or one sub-unit.

Master Units

Specifies that one DWG drawing unit will convert to one master unit of the specified DGN seed file.

Sub Units

Specifies that one DWG drawing unit will convert to one sub-unit of the specified DGN seed file.

Note: The master units and the sub-units of the selected DGN seed file are displayed next to the
buttons for reference.

Filename drop-down list

Specify the name of the DGN seed file. Several sample seed files are provided upon installation.
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Browse button
Displays the Select Seed File dialog box (a Standard File Selection Dialog Boxes), in which you
can select the DGN seed file.

See the DGNEXPORT Conversion Table specific details about the scope of exporting DWG objects
and other data to DGN files.

Sample DGN Seed Files

The following table lists the default DGN seed files and their settings. You may need to edit these settings
or obtain the appropriate seed file to suit your conversion requirements.

DGN Seed File Name Master Unit (label)  Sub Unit (label) Resolution
V7-Imperial-Arch01- Feet () Inches (%) 12”/1’ and 8000 POS
Seed2D.dgn

V7-Imperial-Arch01- Feet () Inches () 12”/1’ and 8000 POS
Seed3D.dgn

V7-Imperial-Arch02- Feet () Inches (%) 12”/1" and 1000 POS
Seed2D.dgn

V7-Imperial-Arch02- Feet () Inches () 12”/1” and 1000 POS
Seed3D.dgn

V7-Imperial-Civil01- Feet () Tenths (tn) 10tn/1’ and 100 POS
Seed2D.dgn

V7-Imperial-Civil01- Feet () Tenths (tn) 10tn/1’ and 100 POS
Seed3D.dgn

V7-Imperial-Civil02- Feet () Tenths (tn) 10tn/1’ and 1000 POS
Seed2D.dgn

V7-Imperial-Civil02- Feet () Tenths (tn) 10tn/1’ and 1000 POS
Seed3D.dgn

V7-Metric-Seed2D.dgn Meters (m) Millimeters (mm) 1000mm/1m and 1 POS
V7-Metric-Seed3D.dgn Meters (m) Millimeters (mm) 1000mm/1m and 1 POS

332 MDT Internal Use Only



User Guide

Chapter 8 | Migrate Legacy Data into Civil3D

DGN Seed File Name

V8-Imperial-Seed2D.dgn

V8-Imperial-Seed3D.dgn

V8-Metric-Seed2D.dgn

V8-Metric-Seed3D.dgn

Master Unit (label)

Feet ()

Feet ()

Meters (m)

Meters (m)

Translate DWG Properties to DGN Properties

Sub Unit (label)

Inches (%)

Inches (%)

Millimeters (mm)

Millimeters (mm)

Selects and manages the mapping setup used on the current DGN export.

Select Mapping Setup

Displays the currently defined mapping setups.

Resolution

304800 per foot

304800 per foot

1000mm per millimeter

1000mm per millimeter

Standard is the default mapping setup which extracts data from the drawing being exported and
applies an automatic mapping to DGN layers, linetypes, lineweights, and colors, as shown in the

mapping preview.

Setup Description

Displays the description of the selected mapping setup.

Mapping Setups

Opens the DGN Mapping Setups dialog box where new mapping setups can be created and
existing mapping setups can be renamed, modified, or deleted (DGNMAPPING).

Mapping Preview for Setup

Lists all properties of both the exported DWG file in the DWG column and the selected mapping

setup in the DGN column.

=| | Note: The reference properties are not listed in the preview, but any properties that apply to
those references that are shown in the mapping preview are applied to the references as well.
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The following table lists the DGN objects and features that are supported for export, and notes on the scope
of the translation.

DWG to DGN Conversion Table

Notes
AutoCAD MicroStation

Geometric Objects Geometric Elements The following DWG objects are translated into DGN
elements: line, xline, ray, polyline, arc, circle, spline
(NURBS), ellipse, elliptical arc, point, donut, mline,
hatch (including gradient fills), and wipeout. Variable
width polylines maintain only their starting width when
translated into SmartLines.

Layers Levels Invalid DWG characters in layer names are converted
to spaces.
I I I |
Colors Colors Colors are matched as closely as possible. Colors set

with the ACI (AutoCAD Color Index) are translated
directly to the DGN color index. If TrueColor is used
and a direct match of RGB values is available in the
DGN color index, the colors are also mapped directly.
If a TrueColor match is not available, an RGB value is
added to the DGN color index.

Linetypes Line Styles Custom linetypes are unsupported and could produce
unexpected results.

Blocks Cells Blocks are exported as shared cells. Dynamic blocks
are also exported as cells and lose their dynamic
behavior. Invisible, Constant, Verify, and Preset
attributes are all converted into tags.

Single-line Text Text, Text Nodes, Text The visual integrity of multiline text is maintained.
Objects, Multiline Styles However, if exported multiline text objects are edited in
Text Objects, Text MicroStation, the formatting is lost.

Styles TrueType and SHX fonts in AutoCAD are exported to

MicroStation V7 as Engineering. This can result in
many visual differences.

Tables Tables Table objects are exported as cell elements composed
of lines and text.
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DWG to DGN Conversion Table

AutoCAD

MicroStation

Notes

Fields

Fields

In general, fields are translated as static text. The
exceptions are fields that behave identically in both
products. This includes the Date

fields CreateDate, SaveDate, and PlotDate, and the
Document property fields Author, Filename,

and Filesize.

Note:

Use the MicroStation Key-in utility to update text
containing fields (field update all).

Dimensions,
Dimension Styles

Dimensions, Dimension

Styles

The size, spacing, style, and shape of dimensions may
vary slightly. Dimension associativity is maintained
whenever possible, and the correct dimension values
are always maintained.

Raster Images

Raster Images

These image file types are supported: .bmp, .cal, .tif,
.png, .tga, .jpg, .gif, .rlc, .bil, and .pcx. All other image
file types are discarded.

DWG References

DGN References

Depending on the export option specified, all
referenced DWG files, including nested DWG
references, are either converted into DGN files,
combined into a single DGN file as cells, or discarded.
Note:

MicroStation V7 does not support nested references to
references that are merged into the host file.

DWG Model

DGN Design Model

The model in a DWG file is converted into a DGN file.

DWG Layout

DGN Sheet Model

When exporting to V8, any initialized layouts are
converted into sheet models in the DGN file.

V7 only supports one model. For V7, several DGN files
can be exported: one for the model and the other DGN
files for any initialized layouts in the DWG file. The
layout names get appended to the exported DGN file
<filename> - Layoutl.dgn.

AEC Objects

AEC objects are not supported. Use the
EXPORTTOAUTOCAD command to convert AEC
objects to basic AutoCAD objects before exporting to
DGN.
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Section 2 | Translating Project Data

8.2.1 Civil Engineering Data Translator

About the Autodesk Civil Engineering Data Translator

You can use the Autodesk® Civil Engineering Data Translator 2015 extension to translate AutoCAD® Civil
3D® files to files that can be used in Bentley® GEOPAK® and Bentley® InRoads®, and to translate
GEOPAK and InRoads files to files that can be used in AutoCAD Civil 3D.

The commands for the Autodesk Civil Engineering Data Translator are available in the AutoCAD Civil
3D Toolbox.

The Autodesk Civil Engineering Data Translator requires an Autodesk® 360 account and an Internet
connection. If you do not have an Autodesk 360 account, you can create one when the Autodesk 360 log
in dialog box is displayed when you run a translation command, or you can Qo
to www.autodesk.com/launch-a360 to create an account.

Monitoring Progress and Downloading Translation Results

After running a translation command, you can use the Job Monitor dialog box to monitor the progress of
the translation and to download the files when the translation process is complete. A report file with an .xIsx
file extension is created for each translation job. The report file lists what was converted and lists any
differences between the source objects and the converted objects.

How To: Translate Bentley GEOPAK and Bentley InRoads Files to Files that Can Be Used
in AutoCAD Civil 3D

You can use the Autodesk® Civil Engineering Data Translator to translate Bentley® GEOPAK® and
Bentley® InRoads® files to file formats that can be used in AutoCAD® Civil 3D®.

1. In Toolspace, on the Toolbox tab, expand Subscription Extension
Manager *> Autodesk® Civil Engineering Data Translator

2. Double-click one of the following commands:

o Import Bentley GEOPAK Project Data: Use this command to translate TIN and
GPK files to files that can be used in AutoCAD Civil 3D.

Note: Each file must be selected separately, so to translate both a TIN file and a
GPK file, the command must be run twice. Each time you run the command; a
separate AutoCAD Civil 3D drawing is created. You can use data shortcuts to link
the data in the resulting drawings together.

o Import Bentley InRoads Project Data: Use this command to translate DTM and
ALG files to files that can be used in AutoCAD Civil 3D.

Note: Each file must be selected separately, so to translate both a DTM file and an
ALG file, the command must be run twice. Each time you run the command; a
separate AutoCAD Civil 3D drawing is created. You can use data shortcuts to link
the data in the resulting drawings together.

3. If you are not currently logged in to Autodesk 360, the Autodesk 360 Login dialog box is
displayed. Use the Login dialog box to sign in or click Need an Autodesk ID? to create an
account.

The Open dialog box is displayed.
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10.

In the Open dialog box, select the file to translate and click Open.

Note: In order for GPK files to be translated successfully, they must be named job***.gpk,
where *** can be numbers or letters (for example, job001.gpk or jobabc.gpk). The "j" in "job"
or any other letters used in the file name can be lower case or capitalized. The file name

cannot include special characters such as #.
At the Command line, enter the unit type of the source file.

If you selected a TIN or DTM file to translate, the Surface Import Settings dialog box is
displayed. Specify the surface elements to import and whether to create a surface snapshot
after import.

Note: Selecting the Triangles option in the Surface Import Settings dialog box improves the
surface accuracy but reduces the speed of the translation process. When you select
the Triangles option, the other options, except Contours, are selected automatically.

Click OK.

A dialog box is displayed to inform you that the data is being transferred to the cloud.

In Toolspace, on the Toolbox tab, expand Subscription Extension
Manager > Autodesk® Civil Engineering Data Translator 2015. Double-click Open Job
Monitor.

The status of the translation job is displayed in the Job Monitor dialog box.

If you selected a GEOPAK GPK file that contains alignments and profiles, (Stage 1/2) will be
displayed as part of the information in the Status column. When stage 1 is complete, you can
initiate stage 2 of the conversion by clicking Configure Mapping in the Result column. When
you click Configure Mapping, the Profile to Alignment Mapping dialog box is displayed. Use
the Profile to Alignment Mapping dialog box to associate the profiles with the alignments and
click OK.

When the job has completed, click Download in the Result column to download the files.

Note: You can specify a default location for the downloaded files by changing the Job Monitor
Configuration settings. For more information, see Job Monitor Dialog Box.

Depending on the type of job performed, and the data available in the source file, different file
types are created during the data translation process, as shown in the following table.

Note: You can specify a default location for the downloaded files by changing the Job Monitor
Configuration settings. For more information, see Job Monitor Dialog Box.

Depending on the type of job performed, and the data available in the source file, different file
types are created during the data translation process, as shown in the following table.
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Command Source File Resulting File Types Object Translation Notes
Type Selected Created During Translation
for Translation

Import .gpk <GPK name>.dwg Alignment chains are converted as
Bentley alignments.
GEOPAK <GPK name>-gpk.xIsx
Project Data Profiles that you assign to
<GPK name>-gpk.xml alignments using the Profile to

Alignment Mapping dialog box are
converted as profiles and are
associated with the designated
alignment. Any unassigned profiles
are not converted.

Parcels are converted as parcels.

Survey chains are converted as 3D

polylines.
Import in <TIN name>.dwg Selecting the Triangles option in
Bentley _ the Surface Import Settings dialog
GEOPAK <TIN name>-tin.xlsx box improves the surface accuracy

Project Data but reduces the speed of the

<TIN name>-tin.xml .
translation process.

An XML file is generated for each
TIN file that you import. After you
download the translated files, you
can optionally point the surface in
the AutoCAD Civil 3D drawing to the
corresponding XML file by modifying
the surface properties.

Import .alg <ALG name>.dwg Points are converted as points.
Bentley
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InRoads
Project Data

Import .dtm
Bentley

InRoads

Project Data

<ALG name>-alg.xIsx

<ALG name>-alg.xml

<DTM name>.dwg
<DTM name>-dtm.xIsx

<DTM name>-dtm.xml

Alignments are converted as
alignments. If an alignment has
disconnected segments, the
segments are converted as part of
the same alignment, and gaps are
removed. For example, if the source
alignment contains two
disconnected lines, during the
conversion process the start point of
the second line will be adjusted so
that it links to the end point of the
first line, and the report file will list
the difference in the alignment
length.

Profiles are converted as profiles
and are associated with their related
alignments.

Selecting the Triangles option in
the Surface Import Settings dialog
box improves the surface accuracy
but reduces the speed of the
translation process.

An XML file is generated for each
DTM file that you import. After you
download the translated files, you
can optionally point the surface in
the AutoCAD Civil 3D drawing to the
corresponding XML file by modifying
the surface properties.
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